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Гленн Киркпатрик
Урожденному злодею Гленну Киркпатрику (Glenn Kirkpatrick) 1964 года рожде�
ния не понадобилось много времени, чтобы обнаружить в окружающем мире
серьезные проблемы. Презирая общество за неустанную погоню за банальнос�
тью и компромиссами, он начинает долгую кампанию визуального террора,
которая неизбежно приводит его к этой книге.

1982: Он оттачивает свои зубы на телевидении в эпоху анимационных войн
по субботним утрам конца XX века, работая в Австралии и Японии на такие
компании, как Hanna�Barbera и Walt Disney.

1990: Вступает в ряды крупных американских корпораций в качестве режис�
сера специального назначения для осуществления миссий в самом сердце Азии.
Руководя планированием и надзором за анимацией, он выпускает около 150 по�
лучасовых мультфильмов для детей и взрослых, наподобие таких высококаче�
ственных сериалов, как «Rugrats» и «King of the Hill».

1999: Возвращается в Австралию, устав быть верхним звеном в корпорации.
Он обращается к своему внутреннему миру.

2000: Учит Flash и создает первые мультфильмы «Spawn of Satan» («Отродье
Сатаны»). Попробует пристроить их в Интернет, но терпит неудачу. Похоже,
до людей не доходит, что он хочет им сказать.

2001: Проводит операцию www.funnyazhell.com с привлечением местного
контингента в лице Кевина Пити; добивается большого успеха.

2002: Основывает первую в Австралии студию Flash�анимации, Funnyazhell
Animation, выпускающую в настоящее время превосходную Flash�анимацию для
сети и телевидения.

Когда�нибудь его война закончится…

Кевин Пити
Кевин Пити (Kevin Peaty) работал в индустрии мультипликации 25 лет, в том
числе и на таких грандов, как Hanna�Barbera и Walt Disney. Ему доводилось вы�
полнять функции аниматора персонажей, старшего аниматора, режиссера и
директора съемочной группы по телевизионным проектам, видео� и художе�
ственным фильмам.

В его биографии есть фильмы, которыми он может гордиться, и фильмы, о
которых ему хотелось бы забыть… но все, что нас не убивает, делает нас силь�
нее, и вместо того, чтобы озлобиться (или вместе с тем, чтобы озлобиться), он
решил направить свой неординарный талант и навыки на мир сетевой анима�
ции. Давний друг и коллега Кевина, Гленн Киркпатрик, убедил его, что поми�
мо почти абсолютной свободы высказывания в эфире своих мерзких и испор�
ченных взглядов, Flash гарантирует Пити огромную славу и богатство.
Киркпатрик при помощи форума своего подрывного сайта сомнительных мо�
ральных свойств www.funnyazhell.com заманил Пити в темный подземный мир,
настолько же больной и пафосный, как и те отвергнутые 2D�аниматоры, кото�
рые его строят.

А остальное, как говорится, история.
Пити продолжает работать в индустрии анимации и выпускать странные

Flash�фильмы. Он живет со своей женой Лиэнн, сыном Джеймсом и двумя кош�
ками в Куги, в Австралии, где местные племена поклоняются ему, как Богу.

Об авторах
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15Введение

Введение

Разные бывали времена – и хорошие, и плохие. Новые технологии открыли для
мультипликационной индустрии замечательные возможности реализации та�
ких идей, о которых раньше и не помышляли. Влияние этих технологий про�
явилось и в том, что студиям пришлось перестраиваться и адаптироваться к
меняющимся условиям рынка. Требования все более пресыщенной и разбор�
чивой публики и ответы студий, пытающихся поспевать за этими требования�
ми, означали, что художникам, вовлеченным в этот бизнес, нужно учиться и
перестраиваться, чтобы не оказаться на обочине. Студии приходили и уходи�
ли. Некоторые рынки засохли совсем, но появились новые.

Компьютерная анимация многое переняла у двумерной мультипликации,
этой золотой середины. Чем сильнее все меняется, тем меньше изменений.
Мультики по�прежнему рисуют художники�аниматоры, хороший сценарий ос�
тается хорошим сценарием, выдающийся фильм – замечательным развлечени�
ем, а компьютер на самом деле просто еще один карандаш, только очень ост�
рый!

Из робких начинаний столетней давности мультипликация выросла в огром�
ную бизнес�индустрию с ежегодным оборотом в миллионы долларов. Крупные
студии инвестируют гигантские суммы и привлекают сотни художников и ты�
сячи исполнителей для одного мультипликационного фильма, как правило,
получая в итоге впечатляющие кассовые сборы.

От поцарапанных немых черно�белых короткометражек с появлением цве�
та и звука анимация доросла до последних технологий, производя фильмы по�
трясающей виртуозности и размаха. Телевизионные и художественные филь�
мы, 3D: анимация охватила множество разнообразных областей.

Этот жанр киноискусства, похоже, стал зависеть от размеров бюджета, ко�
манды, числа исполнителей, и возможность для одинокого художника предста�
вить свой собственный взгляд, видимо, пропала совсем – если она вообще ког�
да�либо существовала. Законы больших бюджетов и еще более крупных
инвесторов исключают мнение художника.

Существует ли какая�нибудь платформа для инакомыслящего аниматора, не
стесненного инвесторами, фокус�группами, экспертами по маркетингу и день�
гами? По иронии судьбы, выход нашелся в упомянутых новых технологиях: им
стал Flash!

Flash�анимация и эта книга
Flash – программа, изначально написанная для Web�дизайнеров и уже потом
освоенная несколькими умелыми традиционными 2D�аниматорами, которые
быстро осознали его потенциал. Ограничения этой простой программы толь�
ко подпитывали творчество и изобретательность. Во Flash один художник мо�
жет сделать все… не потратив почти ничего!

Мультипликация во Flash принесет вам радость свободного творчества, не�
зависимо от того, являетесь ли вы опытным 2D�аниматором, который ищет
возможности выразить свой внутренний потенциал, или абсолютным нович�
ком, надеющимся найти непредвзятую публику для оценки своих художествен�
ных притязаний. Flash предоставляет вам такую возможность, почти или со�
всем не требуя ни денег, ни компромиссов со своим художественным вкусом.

!!! Кроме того, Flash дает шанс представить свой фильм обширной и разнообразной
аудитории с помощью Интернета.

В этой книге мы расскажем вам, как сделать фильм. Мы проведем вас по
всем стадиям этого процесса, от исходной идеи до законченной работы. Мы
исследуем его шаг за шагом.

Даже если вы никогда не пробовали заниматься анимацией, мы научим вас
и этому: сначала – основам анимации, а потом – их применению непосредствен�
но во Flash. Мы ставили себе задачу как можно лучшее разъяснить вам принци�
пы анимации и мультипликации, а также поделиться своим видениием их адап�
тации для этой программы.

Вашему вниманию будет предложена экскурсия по процессу создания филь�
ма с детальным объяснением каждого шага от начала до конца. Прочитав эту
книгу, вы приобретете необходимые навыки в мультипликации, создании филь�
мов и использовании Flash для того, чтобы уверенно взяться за любую идею и
воплотить ее согласно собственному вкусу и замыслам.

На литературном рынке сейчас можно найти множество книг об использова�
нии программы Flash. Но лишь немногие из них направлены на раскрытие воз�
можностей Flash как мультипликационного приложения. Мы хотим максималь�
но использовать гибкость и простоту Flash как платформы, которая позволяет
личности реализовать весь свой творческий потенциал в кинопроизводстве.

У нас обоих есть большой опыт работы художниками�мультипликаторами,
создателями персонажей и режиссерами в крупных студиях традиционной
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двумерной анимации. Когда мы открыли для себя Flash, то немедленно пере�
ключились на него. Он усиливает индивидуальные способности и предоставля�
ет полную автономность, уникальную для киноиндустрии.

Эта книга последовательно расскажет вам о процессе кинопроизводства.
Мы покажем, как сделать мультипликационный Flash�фильм на конкретном
примере фильма «Мальчик, который кричал: «Волк!», так что вы сможете уви�
деть, как принципы анимации и создания фильмов действуют в реальном мире.

Мы построим фильм «Мальчик, который кричал: «Волк!» так, как должен
строиться любой мультипликационный фильм, чтобы сделать этот процесс
понятным и легко адаптируемым к вашему собственному проекту. Давайте
взглянем на этапы производственного процесса от начала и до конца:

Загрузка файлов

Читая книгу, вы можете воспользоваться множеством FLA�файлов, файлов с
графикой и звуком. Прибегать к ним не обязательно, поскольку все, что пред�
ставлено в книге, может быть создано «с нуля», – решать вам. Но если вам захо�
чется посмотреть, что же именно сделали авторы, или построить собственную
версию их фильма, то знайте, что все дополнительные файлы организованы
по главам и представлены на сайте www.friendsofED.com.

Оформление

Нам хотелось сделать излагаемый материал как можно яснее и проще в пони�
мании, поэтому мы ввели несколько стилей оформления, которыми будем поль�
зоваться на протяжении всей книги.

Мы пользуемся разными стилями, чтобы выделить элементы интерфейса,
клавиши и команды, а также Web�адреса.

Если мы вводим новый важный термин, то
выделяем его курсивом.

!!! Если мы хотим, чтобы вы ни в коем случае не
пропустили какую;то вещь, то выделим ее вот
так! Будьте внимательны, если увидите такой
шрифт!

Если нам нужно, чтобы вы открыли меню и
выбрали из раскрывающегося подменю какой�
то пункт, то отметим это так: File ➤ Import
(Файл ➤ Импортировать).

Если вам что�то нужно будет ввести, мы вы�
делим это кавычками.

1. Если мы предлагаем вам выполнить прак�
тическое упражнение, то его этапы будут
пронумерованы.

2. Выполните их, сверяясь с подсказками
на рисунках и диаграммах.

3. Дойдя до конца, можете остановиться.

Введение

Это – порядок этапов производства Flash�фильма, который мы будем соблю�
дать в нашей книге.

Если вы являетесь Web�дизайнером, который хотел бы расширить свои по�
знания в анимации, чтобы работать во Flash, или будущим мультипликатором,
которому недостает знаний или опыта для воплощения своих идей, или пользо�
вателем Flash, обладающим некоторыми навыками, но не знающим, как их при�
менить, – эта книга для вас.

Следуйте урокам и примерам, изложенным в нашей книге, и мы гарантиру�
ем, что вы сможете делать мультипликационные Flash�фильмы на профессио�
нальном уровне, которые будут выгодно отличаться от большинства современ�
ных фильмов, создаваемых этим способом. Все, что от вас потребуется, это
придумать идею!

От редакторов: как пользоваться книгой
Мы очень гордимся этой книгой – так же, как Гленн и Кевин – и надеемся, что
ее чтение доставит вам удовольствие и вы многому научитесь у этих двух весь�
ма уважаемых аниматоров. Но прежде чем окунуться в упоительный процесс
обучения анимации, прочтите и этот раздел, поскольку он позволит вам макси�
мально использовать возможности книги.

Сценарий

Определение
стиля

прорисовки Раскадровка Проект
Анимация

и фоны

Редакти-
рование

и обработка
Опубли-
кование
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Поддержка – всегда рады помочь

Все книги, издаваемые «friends of ED», мы пытаемся сделать доступными для
понимания и свободными от ошибок. Однако, если вы столкнулись с пробле�
мой, не стесняйтесь вступить с нами в контакт – с максимальной доброжела�
тельностью мы быстро и бесплатно окажем вам помощь.

С нами можно связаться, написав по адресу support@friendsofED.com и ука�
зав в теме письма четыре последних цифры индекса ISBN (это 0985). Даже если
наша специальная команда поддержки не сможет решить вашу проблему немед�
ленно, ваш запрос будет передан для решения тем, кто готовил эту книгу – ре�
дакторам и авторам.

Гленн и Кевин, так же как и все наши авторы, обязательно помогут вам сове�
том, отправив ответ по e�mail лично вам или (что случается чаще) редактору,
который вам его и передаст.

Нам хотелось бы получить от вас письмо, пусть это будет лишь запрос о сле�
дующих книгах, вопросы о «friends of ED» или несколько строк о том, как вам
понравилась эта книга.

Кстати, почему бы вам заодно не заполнить специальную карточку, чтобы немно�
го рассказать о себе и прокомментировать материал, прочитанный в книге? Вы так�
же можете зарегистрироваться по сети на www.friendsofED.com/replycard.asp.

Если ваш вопрос не касается непосредственно содержания книги, то луч�
шим местом для него станет наш форум: www.friendsofED.com/forums. Здесь вы
познакомитесь со множеством дизайнеров, охотно рассказывающих о своей
деятельности. Они смогут дать вам совет, подсказать идею, решить ваши про�
блемы или вдохновить на создание чего�то нового.

!!! Новости, другие книги, примеры глав, загрузочные файлы, интервью с авторами,
наш новый PDF магазин и многое другое вы можете найти, набрав в адресной стро;
ке www.friendsofED.com.

Первый шаг на пути к созданию собственного фильма – это идея. К сча�
стью, найти идею для фильма достаточно легко – для сценария можно
адаптировать практически все что угодно. К несчастью, найти хоро�

шую идею, которая бы воплотилась в интересный фильм, уже немного слож�
нее. Эта глава позволит вам четче определить основной замысел, представить
его в виде нескольких сцен и создать версию, которую будет несложно довести
до раскадровки и разработки.

Нет ничего, что ценилось бы так же высоко, как оригинальная идея, – и не
было бы настолько же редким. Поэтому, как только она забрезжит на горизон�
те, не дайте ей пропасть. Поскорее зафиксируйте ее как�нибудь и дайте волю
своему воображению. Приложите все усилия, чтобы превратить ее в фильм,
который, по крайней мере, не уступал бы вашему первоначальному замыслу.

С другой стороны, не надо забывать обо всем на свете, гоняясь за эфемер�
ной оригинальной идеей. Оригинальность ценится высоко, но ее одной для
интересного фильма мало. Например (и в особенности) Голливуд никогда не
страдал от переизбытка оригинальных мыслей!

Думая о том, что бы вы хотели сказать своим фильмом, не забывайте, что в
этой области вы новичок. Вам нужно сконцентрироваться на создании корот�
кого, очень простого, но невероятно интересного Flash�фильма. Так что пусть
ваш замысел будет как можно проще. Вы же хотите донести свои идеи до ауди�
тории как можно быстрее и легче, не так ли?

Наш совет: не пытайтесь сделать что�нибудь чересчур сложное, пока не освои�
тесь в роли Flash�аниматора и мультипликатора. Позже, само собой, вы сможете
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донести свое глубокое исследование людской бесчеловечности до зрителя, ко�
торого втайне долгие годы считали своим. Но пока – будьте проще!

!!! Простая концепция дает вам больше свободы в оттачивании деталей своего филь;
ма и придании ему большей визуальной привлекательности.

В этой главе мы разберем, как найти сюжет, записать его в виде наброска
или плана, а затем превратить в сценарий. Однако прежде всего нам нужно
придумать идею, так что сейчас мы остановимся на некоторых вопросах, кото�
рые вам, возможно, придется обдумать.

Идея
Идея, или концепция, на основе которой вы решили выстроить фильм, цели�
ком остается на ваше усмотрение. Нет никакого «списка сюжетных идей» для
новичков, хотя в процессе чтения книги вам, скорее всего, встретится хотя бы
одна.

Если вы ищете идею, то лучший совет – не ищите, она придет к вам сама:
кто�нибудь расскажет анекдот или пошутит, или же вы вспомните интересное
событие из собственной жизни.

Какой бы ваша идея ни оказалась, вы не сможете придумать ее «специаль�
но». Книги, фильмы, телепрограммы, музыка – прекрасные стартовые площад�
ки, от которых вы можете оттолкнуться в процессе размышления над тем, ка�
кой сюжет может сработать, – в общем, смотрите больше видео!

Если ваша мысль совсем застопорилась, то всегда можно обратиться к тра�
диционным историям и сказкам и добавить собственный поворот сюжета; на�
пример, Уолта Диснея этот трюк выручал не раз!

Для демонстрации процесса создания мультипликационного фильма во
Flash мы выбрали историю, которую уж точно знают все. Помимо того что из�
вестность этой истории значительно упрощает ее использование в качестве
обучающего примера, она дает нам возможность сократить ее и поэксперимен�
тировать с сюжетной линией. Мы исходим из того, что наша аудитория знако�
ма с общей канвой «Мальчика, который кричал: «Волк!». Но при этом история,
разумеется, должна быть понятна и тем, кто не знаком с ней. Мы собираемся
продемонстрировать, как такую довольно избитую идею можно сделать весьма
интересной и забавной.

Над чем стоит подумать

О чем бы вы ни думали, всегда стоит держать в уме следующие важные моменты:

Какой фильм вы пытаетесь сделать?

Страшный, смешной, драматический – неважно: посмотрите как можно боль�
ше фильмов в этом жанре (и немножко за его пределами), отмечайте все. Вы
даже не заметите, насколько сильно это повлияет на ваше творчество. Выбрав
анимационный формат, вы наверняка хотите (или вынуждены) сделать все по
возможности быстрее, но просмотр больших анимационных (и не только)
фильмов наилучшим образом подскажет вам, что можно сделать.

Кто ваша аудитория?

Тема и содержание фильма должны быть адресованы вашей целевой аудито�
рии. Способ повествования будет зависеть от того, кого вы ожидаете увидеть в
числе зрителей. Если вы намерены представить свою работу в Интернете, то в
выборе средств можно быть чуть посвободнее.

Возможно, вы собираетесь представить свой фильм на фестивале – тогда
приготовьтесь пойти на некоторый компромисс, или, по крайней мере, не�
сколько изменить язык и тему фильма. В конечном итоге решать все равно вам.
Авторы этой книги никогда такого не посоветуют и не поймут. Хотите идти на
компромиссы – идите работать в студию!

Найдут ли это смешным?

Юмор – забавная вещь. Что люди находят смешным – ужасно субъективно.
Французы как нация считают смешным Джерри Льюиса – а мы определенно
нет. Мораль: не пытайтесь шутить перед французами. Разумеется, если только
вы не француз или не смеетесь над Джерри Льюисом.

Понравятся ли вашей аудитории грубые шутки или они – фанаты Вуди Алле�
на? Если ваш фильм основан на шутке, то предварительно убедитесь, что он
действительно забавен!

Посчитают ли это скучным или претенциозным?

Нет более страшного греха, чем заставить публику скучать. Смущайте ее, раз�
дражайте, оскорбляйте или ставьте в тупик – но не давайте ей скучать! Претен�
циозность же может только оттолкнуть людей. А без восприимчивой аудито�
рии вся работа может пойти насмарку.

!!! Шокируйте свою аудиторию всеми доступными способами – но прежде удосто;
верьтесь, что это производит нужный эффект!

Будьте самокритичны

Как и на любой другой стадии кинопроизводства, будьте самокритичны. Запи�
шите свою идею и перечитывайте ее как можно чаще. Но не торопитесь гладить
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себя по головке. Одно из самых больших преимуществ Flash состоит в том, что
он дает право голоса самостоятельному мультипликатору. Нам не нужно под�
страиваться под корпоративные ожидания или «наименьший общий знамена�
тель». Если существует сцена для свободного самовыражения в эксцентричных
фильмах – Flash и есть эта сцена. «Эксцентрично» не означает «плохо». Вы
хотите получить доступ к публике и донести свою мысль. Но создание даже
самого странного фильма в мире требует своей структуры.

Просмотрите свой фильм или перечитайте сценарий, отмечая недоработ�
ки в нем – что вам кажется слабым местом. Может, это и негативный образ
мыслей, но если к нему не прибегнете вы, то им обязательно воспользуются
другие. Вы еще успеете погреться в лучах славы попозже.

Сюжет
В рамках короткого анимационного ролика у вас будет меньше свободного про�
странства для реализации сложного, нелинейного (наподобие «Криминально�
го чтива») сюжета. Но, как и в любой творческой области, здесь нет четко очер�
ченных границ и жестких правил: перенесите свою идею на бумагу – и можете
дорабатывать ее, сколько душе угодно.

Лучше всего держаться в рамках классической структуры из трех актов: на�
чала, середины и концовки. Порядок следования не обязательно должен быть
именно таким, но все элементы должны присутствовать.

Начало

Здесь вы обрисовываете общую ситуацию и представляете главный персонаж. Вам
нужно привлечь внимание аудитории и вовлечь ее в сюжет. В идеале у главного ге�
роя должна быть какая�то основная мотивация, которая повлечет за собой дальней�
шие действия. Например, в нашем случае мальчик скучает и хочет поразвлечься.

Середина

Основное действие развернется здесь – напряжение создается с помощью по�
следовательности событий, которые, в конце концов, приводят к развязке.
При создании длинного фильма пришлось бы тщательнее проработать героев
и сюжет, но для большинства анимационных короткометражек сам сюжет важ�
нее, чем глубокий анализ персонажей.

Концовка

Заключение должно отражать предыдущие две сцены. Если вы делаете коме�
дию, то нужна хорошая, мощная развязка. Если вы рисуете страшную историю

с привидениями, то подойдет или леденящая кровь концовка, или счастливый
финал в стиле Скуби Ду: «И все это время злодеем был уборщик?!» Наш рассказ
оканчивается моралью. Сильная концовка даст гарантию, что люди обязатель�
но еще не раз посмотрят ваш фильм, а серенькое завершение приведет к тому,
что о вашей работе мгновенно забудут.

Тон

Если вы думаете, что Flash�анимация лучше всего подходит к легким сюжетам и
сногсшибательным шуткам, то это вполне оправданно. Однако такое утвержде�
ние верно только отчасти, так как существует множество ярких исключений из
этого правила.

Загляните на Whitehouse Animation Inc (www.whitehouseanimationinc.com),
где вы найдете фильм «Kunstbar», который не только демонстрирует невероят�
ное количество различных стилей рисования, но также прекрасно анимирован
(рис. 1.1–1.3).

СюжетГЛАВА 1 ▼ Сюжетная линия и сценарий

Рис. 1.3

Рис. 1.1 Рис. 1.2
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На том же сайте (а именно на www.whitehouseanimationinc.com/cub.htm) вы
найдете «Cub» Стива Уайтхауса – по нашему мнению, лучший Flash�фильм всех
времен (рис. 1.4 и 1.5).

Это сокращенная версия, но общую идею вы поняли. Теперь все, что нам
нужно сделать, – это определить самую суть сюжета и адаптировать ее так, что�
бы мы смогли написать сценарий.

План
Нам нужно поскорее начать оперировать категориями визуальной выразитель�
ности, нежели словесной. В художественных фильмах сценарии часто адапти�
руются из романов. Для этого требуется понимать, что нужно перенести на
экран, что сработает визуально и что можно донести при помощи образов, не
прибегая к прямому объяснению.

Что бы вы ни предполагали, но всегда потребуется больше времени, чем
представляется изначально, чтобы воспроизвести что�либо с печатной страни�
цы. Представьте себе, насколько нужно урезать роман, чтобы сделать из него
сценарий. Правильный выход, всегда угнетавший сценаристов, заключается в
том, чтобы, значительно уменьшая произведение, не исказить замысел перво�
источника. План сюжета также даст вам четкое представление о действиях
главных героев и о том, кто они такие.

Суть

У большинства историй есть мораль – или суть (пара предложений или даже
несколько слов – чтобы продать идею), которая придает смысл всему повество�
ванию. Это помогает четко осознать, что вы должны сказать обязательно, что
для сюжета не столь важно, а что можно вообще вырезать.

Посмотрим на наш рассказ и попробуем сжать его, не упуская основную
мысль:

Если ты врун, то тебе не поверят, даже если ты скажешь правду.

…Очень полезно держать в уме эту идею, пытаясь выкристаллизовать исто�
рию в последовательность действий или важных событий, которые развивают
сюжет.

Рассказ о «Мальчике, который кричал «Волк!» можно свести к следующим
основным пунктам:

Скучающий мальчик, присматривающий за овцами.
Он кричит: «Волк!»
Крестьяне реагируют.
Он снова кричит: «Волк!»

ПланГЛАВА 1 ▼ Сюжетная линия и сценарий

Рис. 1.4 Рис. 1.5

Удобно ли вы устроились?

Пришло время взглянуть на наш сюжет.

Мальчик, который кричал: «Волк!»

Давным-давно жил маленький пастух, которому ежедневно приходилось сле-
дить за своими овцами, чтобы быть уверенным, что с ними все в порядке. Как-
то раз сидел он, смотрел на своих овец, и стало ему невыносимо скучно. Ради
шутки он решил закричать: «Волк! Волк!»

На помощь примчались крестьяне. Но никакого волка не было, и крестьяне
страшно рассердились. Они сказали: «Не надо кричать «Волк!», когда поблизос-
ти его нет!» А он только озорно ухмыльнулся.

На следующий день, присматривая за овцами, он снова заскучал. И опять он
решил закричать: «Волк! Волк!»

И крестьяне снова прибежали. И опять не было никакого волка. Разумеется,
они рассердились еще сильнее. Они заорали на мальчика: «Почему бы тебе не
прекратить кричать о волке? Его здесь нет!»

На следующий день, когда мальчик пас своих овец, он внезапно увидел боль-
шого и страшного волка. Мальчик очень испугался и начал кричать: «Волк!
Волк! Волк!!!»

Но крестьяне подумали, что он снова шутит, и на этот раз никто не пришел
ему на помощь. Когда мальчик, наконец, вернулся в деревню, он был очень рас-
строен. Волк загрыз всех его овец.

А крестьяне сказали ему: «Мы думали, ты шутишь – никто не верит лжецу,
даже когда он говорит правду».

Конец.
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Крестьяне снова реагируют. На этот раз с меньшим энтузиазмом.
Он опять кричит: «Волк!» На этот раз – взаправду.
Никто не реагирует.
Катастрофа!

Теперь у нас есть основа для сценария, описывающая словами то, из чего
мы будем делать фильм, сцену за сценой.

Сценарий
В сценарии мы разбиваем фильм на сцены. Не путайте сцену с определенным
кадром или способом постановки камеры – в ней их может быть сколько угод�
но. Сцена – один из разделов нашего рассказа, обычно ограниченный местом и
временем, – хотя и здесь правила могут меняться.

Для начала научимся мыслить образно. Как и в пьесе, в сценарии фильма
должна содержаться вся информация, которая в конце концов будет донесена
до зрителя, – и словесная, и визуальная. В общем случае здесь будут содержать�
ся и специальные требования к костюмам и внешности, и важные сведения о
постановке сцены (место, освещение, время – что угодно), и конкретные дви�
жения камеры, необходимые для точной передачи сюжета.

Сценарий мультипликационного фильма часто содержит больше специаль�
ной информации о постановке сцены, чем «живое» кино. Все из�за дополни�
тельной работы, которую требуется проделать с каждым кадром. Например,
режиссер кино мог бы с легкостью снять несколько кадров нашего «мальчика»
под разными углами, тогда как от художника�аниматора каждый кадр потребу�
ет немалого труда. Чем раньше будут приняты решения по установке камеры в
анимационном фильме, тем меньше лишней работы придется выполнить. По�
пробуйте проиграть фильм в уме и запишите, как камера будет доносить его до
аудитории.

В процессе проработки сцен будет проще, если вы представите состояние
дел в начале и в конце каждого действия. Потом можно будет разобрать, что
конкретно произойдет и что нужно сказать зрителю, чтобы провести его из
одной сцены в другую. В нашем фильме все это, возможно, выглядит слишком
упрощенно, но чем сложнее станут ваши мультфильмы, тем больше пользы бу�
дет приносить работа на этой стадии.

Кадры и сцены должны донести до зрителя массу информации: он дол�
жен понять мотивацию персонажей, физику и законы природы созданного
вами мира – и вся ответственность за это лежит на вас, как художнике�анима�
торе.

Мальчик, который кричал: «Волк!»

Это – сценарий, который мы разработали для нашего фильма; мы включили в
него столько разных углов обзора камеры, сколько сочли нужным применить
на этой стадии:

Сцена 1

Экран светлеет.
Дальний план. День на природе.
На холме пасутся овцы. Солнечный, мирный пейзаж.
Заглавие (поверх кадра):
«Мальчик, который кричал: «Волк!»
Заглавие пропадает.
Камера медленно переходит от овец к дереву.
Под деревом сидит мальчик.
На дальнем плане видна деревня.
Камера приближается к мальчику.

Эта первая сцена носит вводный характер, показывая аудитории, где будет
происходить действие, дает панораму пейзажа, а потом «наезжает» на мальчи�
ка, заставляя зрителя смотреть туда, куда нужно. Эта панорама и «наезд» в на�
чале – стандартное введение, обычно используемое в анимации на телевиде�
нии.

Сцена 2

Крупный план мальчика.
Тревога. Он кричит: «Волк!»

Сцена 3

Крестьяне в панике.
Кричат и вопят!
Дальний план, приближение или панорама.

Здесь может быть дальний план, панорама или «наезд». Этот вопрос можно
решить на стадии раскадровки.

Сцена 4

Средний план мальчика.
Довольный. «Просто пошутил».

Нам не нужен такой же крупный план, как в сцене 2, мы не акцентируем этот
кадр.

СценарийГЛАВА 1 ▼ Сюжетная линия и сценарий
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Сцена 5

Крестьяне. Средний план.
Растеряны. «Что?»
Экран затемняется.

Затемнение означает, что проходит какое�то время.

Сцена 6

Крупный план мальчика.
«Волк!!»

Чуть крупнее, чем в сцене 2, это придаст драматизма.

Сцена 7

Крестьяне.
Скептически. «В самом деле?»

Немножко дальше, чем в сцене 3, поскольку этот кадр не так акцентирован.

Сцена 8

Мальчик, как и в сцене 4.
Все такой же довольный. «Нет!»

Сцена 9

Крупный план мальчика.
Кричит. «Волк!!!»

Еще ближе, чем в сцене 6, больше драматизма.

Сцена 10

Крестьяне.
Уже злятся. «Заткнись!!»

Может быть, чуть более крупный план крестьян, поскольку они злятся. Этот
кадр должен быть немного выразительнее предыдущего. И эту проблему мож�
но решить, когда будем рисовать раскадровку.

Сцена 11

Очень крупный план мальчика, бегущего в панике.
«О нет!!!»

Отъезд камеры, чтобы показать волка, который за ним гонится.

Сцена 12

Могильная плита.
«Покойся с миром, мальчик, который кричал: «Волк!»
Конец.

Мы очень вольно переделали исходный сюжет. Более того, мы оставили в
стороне множество деталей. То, что эта история хорошо известна, дает нам
большую свободу при ее сокращении.

Мы убили мальчика в конце фильма. Зачем? Закончить сценарий было про�
ще и быстрее именно таким способом. К тому же в такой концовке больше
юмора (черного). Идея старейшины деревни, который читает мальчику лек�
цию о правде и лжи, звучит ужасно нудно и затянуто. Не нужно усыплять ни
зрителя, ни себя! Общий смысл все равно остается тем же, и мы надеемся, дой�
дет до аудитории не хуже.

Доработка сценария

В традиционных анимационных студиях художник�мультипликатор приносит
свою работу режиссеру, чтобы свериться, работает ли он в том направлении,
которое себе представляет режиссер. Художник прикрепляет свои рисунки на
стену и последовательно обсуждает их с режиссером.

Очень редко требуемая раскадровка получается с первого раза. Мы еще не
раз повторим это в нашей книге: фильм – это ваше творение. Когда мы адапти�
руем этот сценарий к кадрам, мы будем лучше представлять себе, как они долж�
ны выглядеть. По ходу процесса мы сможем подкорректировать фильм.

Внимание – не пропускайте сценарий!

Чтобы довести свой фильм до этой стадии, возможно, вам не понадобится уг�
лубляться в такие детали, как нам. У вас есть идея Flash�фильма, и вы полагае�
те, что можете приступать прямо к раскадровке. Это вполне возможно, и бо�
лее того, наверняка многие Flash�аниматоры так и работают, особенно
поначалу, когда фильмы весьма несложны, – но в таком случае могут возникнуть
проблемы.

Человеческая натура есть человеческая натура, и мы, творческие личности,
импульсивны и недисциплинированны, поэтому большинство мультипликато�
ров сразу принимают то, что они думают, за лучшую идею, и бегут реализовы�
вать ее. Потом, на полпути, они понимают, что у них нет концовки или сделан�
ная концовка никуда не годится. В больших художественных фильмах часто
встречается ситуация, когда у сценария нет концовки, – и это у высоких (или,
по крайней мере, у высокооплачиваемых) профессионалов!

СценарийГЛАВА 1 ▼ Сюжетная линия и сценарий
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Если вы написали сценарий на основе своей оригинальной идеи и чувствуе�
те, что из него получится интересный фильм, то подойдете к этапу раскадров�
ки с гораздо большей уверенностью, чем тот, кто надеется справиться с про�
блемами по мере их поступления. К тому же и саму раскадровку тогда будет
сделать намного проще и быстрее.

Лучше пройти по всем стадиям. Чем более опытным художником и создате�
лем фильмов вы будете становиться, тем более амбициозными будут ваши про�
екты. Тогда на свой страх и риск вы сможете пропустить эти ранние этапы. Но
однажды утром вы проснетесь и обнаружите, что потратили шесть месяцев на
абсолютно невнятный фильм… без концовки! Это случалось и с куда более луч�
шими аниматорами, чем мы.

Что касается вас
Что вам нужно знать:

Обдумайте идею своего мультфильма и убедитесь, что она подходит предпо�
лагаемой аудитории. Вдохновение можно черпать из народных сказок, легенд,
шуток, фильмов и страшилок, которые рассказывают у костра в лагере.

Напишите основную версию сценария, изложив в ней сюжет. Есть ли у ва�
шей истории начало, середина и концовка? Если вы делаете смешной фильм,
то уверены ли вы, что в нем есть сильные, выразительные эпи�
зоды?

Набросайте фильм в виде серии действий, которые ста�
нут основой для каждой из сцен. На этом этапе вы можете
обнаружить, что ваша история чересчур усложнена, так
что приготовьтесь ее редактировать или подумайте, как бы
ее творчески упростить.

При помощи наброска напишите сценарий, как
можно детальнее описывая конечный вариант.
Продумывая диалоги, не забывайте о поста�
новке камеры и спецэффектах.

Теперь, когда у вас должно возникнуть
четкое представление о том, как будет стро�
иться ваш фильм, в следующей главе мы
рассмотрим, каким образом вы можете
применить Flash в качестве профессио�
нального художественного приложения
для реализации своих замыслов.

ГЛАВА 1 ▼ Сюжетная линия и сценарий

При помощи платформы Flash аниматор может добиться практически
всего, что может обычная двумерная анимация, а также некоторых
вещей, о которых традиционный мультипликатор мог только мечтать.

Хотя инструменты рисования, доступные во Flash, и не были специально раз�
работаны для рисования персонажей, они замечательно подходят для этой за�
дачи. Вы уже наверняка решили, что за история будет рассказана вами в филь�
ме, а эта глава даст вам навыки рисования героев и фонов во Flash.

Что аниматоры твердо усвоили, так это то, что эта простая, но удивительно
гибкая программа непременно таит в себе какой�то неисследованный потенци�
ал. Использование ее инструментов для достижения конечного результата тре�
бует изобретательности и хитрости. К счастью, ее потенциал в анимации уже
достаточно изучен, и мы можем представить его здесь. С другой стороны, этим
отнюдь не исчерпывается арсенал возможных методов в создании различной
анимации. Когда вы освоитесь в среде Flash, то, несомненно, откроете новые
способы комбинирования и приспособления инструментов программы для
получения оригинальных и интересных результатов.

Познакомившись с инструментами и функциями, которые мы здесь обсудим,
вы выработаете собственную методику работы с ними во Flash – так что откры�
вайте программу и, по мере чтения книги, применяйте их на практике. Когда у
вас разовьется свой стиль рисования и анимации, то, возможно, к каким�то ин�
струментам вы будете прибегать чаще, чем к другим, а возможно, будете рабо�
тать совсем не так, как мы предлагаем, – выбор за вами.

Рисование

во Flash2Глава
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!!! Если у вас уже есть опыт рисования во Flash, то некоторые части этой главы не от;
кроют вам ничего нового, так что можете спокойно их пропустить – а можете и про;
честь, чтобы освежить в памяти накопленные знания.

Панель для рисования
Напомним, что для получения наилучшего резуль�
тата вам нужно достать панель для рисования. Это
часть оборудования, подключаемая к компьютеру,
которая станет вашим карандашом и бумагой. Су�
ществует несколько доступных брендов панелей
разных размеров. Выбирайте по вкусу. Мы исполь�
зуем панель размером 6×8 дюймов, поскольку она
достаточно велика, чтобы на ней удобно было ри�
совать, и при этом не очень громоздка и недорога.

В принципе, можно рисовать во Flash и при помо�
щи мыши, но стоит вам приобрести панель, как вы
начнете удивляться, что вам вообще это удавалось.

Панель инструментов
Посмотрим на инструменты, доступные во Flash.
Большинство из них можно выбрать, просто щелк�
нув по панели инструментов, которую вы увидите
сразу, как только откроете программу. Рассмотрим
основные инструменты для рисования.

Буквы в скобках – это горячие клавиши для выбо�
ра того или иного инструмента. Например, E служит
для выбора инструмента Eraser (Резинка) (рис. 2.1).

Brush
Большинство новичков во Flash совершают распространенную ошибку, игно�
рируя инструмент Brush (Кисть) и вместо него начиная работать с Pencil (Ка�
рандашом). Поскольку название предполагает, что его можно использовать в
качестве карандаша, то он кажется подходящим выбором для начала. И хотя
его вполне можно использовать для рисования, линия получается куда тоньше
и невыразительней, чем линия, нарисованная кистью, особенно если вы при�
меняете панель, чувствительную к силе нажатия.

После выбора инструмента вы увидите, что окно Options (На�
стройки) внизу панели инструментов изменилось и для инстру�
мента, который вы выбрали, стали доступны различные установ�
ки. Для кисти это будет набор, показанный на рис. 2.2.

Поскольку это один из наиболее часто используемых инстру�
ментов, лучше поэкспериментировать со всеми его разнообраз�
ными параметрами и подобрать те, которые придутся вам по
душе, а мы детально опишем только наиболее востребованные.

Установите Brush Mode (Режим кисти) в положение Paint
Normal (Рисовать нормально) (рис. 2.3).

Следующий значок – таблица Pressure (Нажатие) (рис. 2.4).

Рис. 2.1

Рис. 2.2

Рис. 2.3 Рис. 2.4

Эту опцию лучше использовать в сочетании с панелью для рисования, что�
бы получить красивую линию, нарисованную кистью. Вы обнаружите, что в
зависимости от того, давите ли вы на панель карандашом сильно или нажима�
ете мягко, толщина линии будет меняться (рис. 2.5).

Попробуйте нарисовать тонкие и толстые линии, кривые, утолщающиеся и т.д.
Экспериментирование здесь – ключ ко всему. Если постоянно сосредотачиваться

Рис. 2.5

Линия, нарисованная
без чувствительности к нажатию

Линия, нарисованная с учетом
чувствительности к нажатию
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на самом инструменте, то это будет отвлекать вас от
работы! Это всего лишь рабочий инструмент и
пользоваться им нужно так же легко и непринужден�
но, как и обычным карандашом.

Другие параметры:
Brush size (Размер кисти) – определяет толщину

мазка. Подберите размер кисти, подходящий для ва�
шего рисунка (рис. 2.6).

Параметр Brush shape (Форма кисти) действует,
как каллиграфический. Мы зададим круглую форму
(рис. 2.7).

Цвет линии инструмента Brush

Поскольку Flash воспринимает кисть скорее как ин�
струмент закрашивания, чем рисования, то цвет ли�
нии при рисовании кистью связывается с парамет�
ром Fill color (Цвет заливки). Таким образом, чтобы
поменять цвет линии, вам нужно выбрать Fill color

в палитре на панели инструментов и поменять цвет кисти (рис. 2.8).

Инструмент Paint Bucket

Инструмент Paint Bucket (Заливка) используется для заливки фигур цветом.
Мы будем пользоваться им для раскрашивания всех наших рисунков. Посколь�
ку инструмент Brush связан с цветом заливки, мы сможем менять цвет наших
линий даже после завершения рисунка.

Для этого инструмента существует не так уж много параметров, но и те, ко�
торые есть, позволят нам сэкономить уйму времени, если умело ими пользо�
ваться.

Главная опция, относящаяся к инструменту заливки,
это размер разрывов. Он будет определять способ закра�
шивания фигур. Если на вашем рисунке замкнуты не все
линии и это будет встречаться часто по мере прорисов�
ки анимации, особенно при оптимизации кривых (об
этом позже), то параметр нужно привести в соответ�
ствие с разрывами между линиями. Если Flash обнаружит
между линиями разрыв, то не станет заливать цветом
область, пока вы не зададите нужную установку (рис. 2.9).

На примере вы можете видеть, что круг справа име�
ет небольшой разрыв между линиями, поэтому если вы
попытаетесь залить эту область при значении параметра Don’t Close Gaps (Не
замыкать разрывы), то инструмент не сработает. А если вы установите размер
разрывов в положение Close Large Gaps (Замыкать большие разрывы), то
Flash посчитает эту линию замкнутой и заполнит круг цветом. Разумеется, ве�
личина разрывов тоже имеет свои пределы, так что иногда вам придется под�
править линии, чтобы закрыть разрывы.

По мере пользования программой вы все лучше будете понимать, когда ка�
кой параметр следует применить, и сможете интуитивно определить, что мож�
но заполнить, а где нужно будет замкнуть линии (рис. 2.10).

BrushГЛАВА 2 ▼ Рисование во Flash

Рис. 2.6 Рис. 2.7

Рис. 2.8

Рис. 2.9

Рис. 2.10
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Если задать установку на замыкание больших
разрывов, то Flash может не закрасить более мел�
ких частей вашего рисунка. Это особенно заметно
на примере острых углов (рис. 2.11).

Пока вы хорошенько не разберетесь с этим ин�
струментом, попробуйте для начала Close Small
Gaps (Замыкать маленькие разрывы). Тогда Flash
заполнит цветом большинство областей, где между
линиями есть незначительный разрыв или в самом
рисунке есть небольшие незакрашенные области.

Инструмент Eraser

Инструмент Eraser (Резинка) работает по тому же
принципу, что и кисть, за исключением того, что она стирает, а не закрашивает.
Опции этого инструмента также весьма схожи с опциями кисти. Мы всегда ста�
вим их в одно положение, иначе очень легко запутаться. Поэтому режим стира�
ния мы установим в положение Erase Normal (Стирать нормально) (рис. 2.12).

Параметр формы точно такой же, как и у кисти, так что просто выберите
подходящий для вашего рисунка (рис. 2.13).

Параметр Faucet (Вентиль) при выборе удаляет все цветные заливки или
все отрезки линии. Вы можете включить или выключить его одним щелчком

по нему. Попробуйте, как он действует, на одном из ваших ри�
сунков (рис. 2.14).

Хотя инструмент Eraser очень удобен, при рисовании во
Flash чаще используют функцию Undo (Отменить).

Использование команды Undo в качестве резинки

Эта команда удалит из вашего рисунка линию, заливку и все, что
вы только что сделали. Она действует не только на рисунки, но и
на любые операции, выполняемые в программе.

!!! Функцией Undo можно воспользоваться, выбрав Edit ➤ Undo (Правка ➤ Отменить),
но лучше завести привычку пользоваться горячими клавишами Ctrl/ +Z, которые
соответствуют этой операции.

Поработав во Flash достаточно долго, вы обнаружите, что одна ваша рука по�
стоянно держит мышь или карандаш, а другая находится над клавишами Ctrl/ +Z.

Есть еще и функция Redo (Вернуть), которая действует точно так же, толь�
ко наоборот – возвращает все, что вы только что отменили: Edit ➤ Redo (Прав�
ка ➤ Вернуть) или Ctrl/ +Y.

Инструмент Line

В отличие от кисти, которую Flash считает инструментом закрашивания, Line
(Линия) – это средство рисования, вроде карандаша. Мы рисуем в основном
кистью, но это не значит, что с инструментами Line и Pencil что�то не так, – в
каких�то случаях они дают лучшие результаты. С их помощью можно достичь
очень высокого уровня точности, которого трудно добиться кистью.

ГЛАВА 2 ▼ Рисование во Flash

Рис. 2.11

Рис. 2.12 Рис. 2.13

Рис. 2.14

Рис. 2.15

Инструмент Line Инструмент Brush

Brush
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Главная разница между ними заключается во внешнем виде полученных ри�
сунков и хорошо видна на рис. 2.15.

Разница очевидна; оба рисунка по�своему хороши, и какой стиль предпочте�
те вы, будет зависеть от вашего вкуса и типа создаваемого фильма.

Однако инструмент Line гораздо сложнее в применении, особенно при со�
здании рисунков для анимации. Он работает совсем по другому принципу, не�
жели кисть, так что вы не сможете пользоваться им, как карандашом. Рисуя
линию, вы сначала щелкаете в какой�то конкретной точке экрана, потом пере�
мещаете курсор на другое место и отпускаете кнопку мыши, при этом между
двумя точками проводится прямая линия. Затем вы должны нарисовать еще
одну линию, которая будет соединяться с первой, и так далее. Затем подправи�
те линии инструментом Arrow (Указатель) для получения желаемого рисунка.

Преимущества линии заключаются в том, что файлы рисунков, создавае�
мые с его помощью, всегда меньше по размерам. К тому же в любом рисунке
содержится масса прямых линий, которые не придется анимировать, напри�
мер изображение салона автомобиля, и иногда их лучше рисовать именно
таким способом.

При помощи Line вполне возможно, но не без некоторых усилий, создавать
рисунки, похожие на рисунок кистью. Мы думаем, лучше всего начать с грубо�
го рисунка кистью, а потом подправить его линиями.

Применение инструмента Line
1. Нарисуйте или импортируйте «кистевую» версию рисунка. Если хотите

воспользоваться нашей, откройте файл LineToolPractice.fla, который
можно скачать с www.friendsofED.com.

2. Выделите рисунок, сделанный кистью, целиком и смените его цвет на
светло�серый, чтобы легче было видеть черные штрихи. Нажав Ctrl/

+A, вы выделите весь рисунок и сможете воспользоваться раскрываю�
щимся меню Fill Color в Инспекторе свойств (рис. 2.16).

3. Чтобы убедиться, что все линии будут соединены друг с другом, вам нуж�
но включить функцию привязки. Зайдите в меню Edit ➤ Snap to Objects
(Правка ➤ Привязка к объектам), это даст вам еще и гарантию того, что
области внутри рисунка можно будет легко залить.

4. Выбрав инструмент Line, установите толщину линии в Инспекторе
свойств, который находится внизу экрана (этот параметр известен во
Flash как Stroke height (Высота штриха)).

Здесь также можно задать цвет и тип линии (во Flash – Stroke style (Стиль
штриха) – пунктирный, волосяная линия и т.п.) (рис. 2.17).

Применение инструмента LineГЛАВА 2 ▼ Рисование во Flash

Рис. 2.16

Рис. 2.17

5. Мы воспользуемся Solid Stroke (Сплош�
ная линия) черного цвета с толщиной,
равной 2.

6. Вам придется создать новый слой поверх
грубого рисунка, чтобы можно было ри�
совать линиями. Щелкните по значку In�
sert Layer (Вставить слой), внизу слева от
временной шкалы (рис. 2.18).

7. Переименуйте его в «Рисование линией»,
щелкнув по названию, чтобы ввести но�
вое имя (рис. 2.19). Рис. 2.18
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8. Заблокируйте слой с кистевым рисунком, щелкнув по точке под значком
замка. Это предотвратит изменения в рисунке, находящемся на этом слое.

Теперь мы собираемся на новом слое провести линии из всех основных то�
чек нашего грубого наброска.

9. Выберите инструмент Line, щелкните кистью по какому�нибудь из уг�
лов рисунка и протащите курсор до конца этой конкретной кривой
(рис. 2.20).

12.Потом нажмите кнопку мыши и перетащите курсор, чтобы изогнуть ли�
нию в соответствии с рисунком на заднем плане. Эту операцию нужно
проделать со всеми нарисованными линиями.

13.Некоторые линии могут быть изогнуты дважды. Чтобы разбить линию
на отрезки, сначала приведите линию в соответствие с первым изгибом
(рис. 2.23).

ГЛАВА 2 ▼ Рисование во Flash

Рис. 2.19

Рис. 2.20

10.Повторите эту операцию со всеми кривыми на рисунке. В нашем случае
мы просто обвели прическу нашего молодого человека (рис. 2.21).

Вы еще не раз убедитесь, что анимацию проще создать, если разделить сво�
их персонажей на части и, соответственно, анимировать их по частям. Эта тех�
ника известна как ограниченная анимация, но об этом позже, намного позже.

11. Затем выберите инструмент Arrow, наведите курсор на середину линии и
увидите, что под ним появилась кривая линия (рис. 2.22).

Рис. 2.21

Рис. 2.22

Применение инструмента Line
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14.Затем, удерживая клавишу Alt, щелкните по изгибу первой кривой – обра�
тите внимание, что на конце стрелки курсора появился кружок (рис. 2.24).

Лучше всего пользоваться этим методом в сочетании с инструментами ри�
сования прямоугольников и кругов, а также с карандашом. На приведенном
выше примере голову и глаза можно нарисовать при помощи инструмента
Circle (Круг). Так можно упростить довольно сложный процесс.

Как видите, рисование линиями может быть долго и утомительно, но и у
него есть свои области применения.

Удаление наложения

Рисуя таким способом, вы можете накладывать линии друг на друга и затем уда�
лять отдельные отрезки, выделяя их при помощи Arrow и нажимая Delete/
Clear (Удалить). Эта опция недоступна при пользовании кистью, где все эле�
менты одного цвета объединяются в один цельный объект.

Пример с кругом и квадратом показан на рис. 2.27.

Рис. 2.23

ГЛАВА 2 ▼ Рисование во Flash

Рис. 2.24

15.Переместите курсор на место кривой, где будет второй изгиб (рис. 2.25).

Рис. 2.25

16.Затем, как и раньше, подкорректируйте две уже отдельные кривые.
17.Вы можете продолжать подправлять линии, искривляя их в центре или

перемещая угловые точки, чтобы добиться наиболее точного совпадения
с рисунком.

Рис. 2.26

Рис. 2.27

Заметьте, как кривая под курсором изменится на прямой угол, по мере пере�
движения указателя ближе к концу отрезка (рис. 2.26).

Применение инструмента Line
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Цвет линий

Все инструменты линий считаются во Flash инструментами рисования, поэто�
му их цвет привязывается к цвету штриха и должен устанавливаться на палит�
ре, показанной на рис. 2.28.

Чтобы добиться подобного результата, выберите инструмент Ink Bottle,
установите толщину линии, а затем щелкните по контуру вашего рисунка, и
чернильница добавит линию к внешнему контуру.

Это отдельная линия, она не является частью линии, нарисованной кистью,
так что все изменения цвета, которые вы хотите применить к этой линии, нуж�
но будет производить при помощи инструмента Ink Bottle, а не Paint Bucket.

!!! Если вы собираетесь прибегнуть к такому способу, вначале убедитесь, что вы со;
хранили все свои рисунки как символы, особенно если вы намерены пользоваться
ими неоднократно и в разных размерах. Иначе возникнут проблемы с линией за;
ливки, утончающейся или утолщающейся.

Инструмент Eyedropper

Он служит для выбора цвета или линий на уже законченных изображениях и
может сэкономить вам немало времени при подборе цвета для рисунков. Он
действует на все основные инструменты линии и кисти, а также привязан и к
цвету заливки, и к цвету штриха.

Если выбран инструмент Eyedropper (Пипетка), в любом из активных окон
выбора цвета будет установлен цвет любого элемента, по которому вы щелкне�
те. В итоге вы можете назначить любой цвет, чтобы пользоваться им в инстру�
ментах рисования.

У вас будет много рисунков одного и того же персонажа, и раскрашивать их
вам придется одинаково. При помощи пипетки вы сможете взять один рисунок,

ГЛАВА 2 ▼ Рисование во Flash

Рис. 2.28

Инструмент Ink Bottle (Чернильница) закрашивает нарисованное при по�
мощи Line, Pencil и Shape (Фигура) точно так же, как Paint Bucket (Заливка)
закрашивает кисть. С его помощью вы можете задать любой цвет своим ли�
ниям.

Регулирование толщины линий

Можно регулировать толщину линий уже законченного рисунка, установив
различные параметры линий в Инспекторе свойств внизу экрана.

Одной из наиболее полезных функций этого инструмента является утолще�
ние линий, нарисованных при помощи кисти (рис. 2.29).

Вы можете увидеть, что это все тот же рисунок, но с утолщенным контуром –
такой стиль стал очень популярен в наши дни среди аниматоров (рис. 2.30).

Рис. 2.29 Рис. 2.30

Применение инструмента Line
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выбрать на нем любой цвет, а потом назначить его другому рисунку, даже не
заглядывая в палитру.

Инструмент Arrow

Все инструменты, которые мы успели обсудить, в основе своей являются каран�
дашами, ручками и красками. Хотя указатель и нельзя считать инструментом
рисования или закрашивания, он, несомненно, станет для вас одним из наибо�
лее востребованных. С его помощью мы выделяем объекты на рабочем поле,
перемещаем и редактируем их. Кроме того, именно посредством указателя мы
выполняем всю работу на временной шкале и выделяем все функции во Flash.

!!! Чтобы быстро переключиться на указатель, используя другой инструмент, нажмите
Ctrl/ , и пока вы удерживаете клавишу нажатой, ваш курсор будет выполнять фун;
кции указателя, а как только вы отпустите Ctrl/ , он снова вернется к тому инстру;
менту, которым вы пользовались. В процессе работы вы обнаружите, что такой при;
ем здорово экономит время.

Выбор объектов
Во Flash есть два основных типа объектов: те, что были созданы или преобра�
зованы в символы, и те, что ими не являются. Тип объекта определяет, как
наши инструменты – и в особенности указатель – будут влиять на него при вы�
боре объекта на рабочем поле.

Символы

Любой объект, преобразованный в символ,
уже нельзя редактировать на рабочем поле
непосредственно. Поэтому, стоит вам щелк�
нуть на символе указателем, вокруг всего
изображения появится синяя рамка. Выде�
лив изображение, вы сможете перемещать
его по экрану с помощью мыши или клавиш
со стрелками.

Этот рисунок был преобразован в символ,
и при выделении указателем вокруг него по�
является синее обрамление. Теперь его легко
можно переместить (рис. 2.31).

Изображения, не являющиеся символами

Если вы выделите изображения, которые не были преобразованы в символы,
то заметите, что произойдет нечто совершенно иное.

На примере того же самого изображения, которое теперь не преобразовано
в символ, при выделении указателем будет подсвечиваться только выделенная
часть рисунка – в нашем случае это волосы и весь контур персонажа (рис. 2.32).

Если мы попробуем теперь передвинуть выбранное таким способом изобра�
жение, Flash переместит только ту часть рисунка, которая была выделена. Чер�
ты лица и цвет джемпера останутся на месте (рис. 2.33).

Выбор объектовГЛАВА 2 ▼ Рисование во Flash

Рис. 2.31

Рис. 2.32 Рис. 2.33

Чтобы выделить все изображение целиком, вам придется выбрать его на
временной шкале или обвести рамкой указателя – нажмите кнопку мыши и

Рис. 2.34
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тащите курсор от одного угла рисунка до другого по диагонали, помещая его в
замкнутый прямоугольник (рис. 2.34).

Как только вы отпустите кнопку мыши, выделится все изображение. Пока
оно выделено, вы можете перемещать его точно так же, как символ.

!!! Удерживая клавишу Shift при выделенной области и выделяя другие области при
помощи инструмента Arrow, вы можете выделять и дополнительные части рисунка
для перемещения и редактирования.

Инструмент Lasso
Lasso (Лассо), как и указатель, используется для выделения изображений и, что
более важно, их частей, и очень полезно при создании рисунков.

Например, скажем, мы только что закончили рисовать и захотели поменять
положение руки, опустив ее пониже, но вместо того, чтобы отменять весь рису�
нок, нам нужно всего лишь выделить руку, обведя ее при помощи Lasso, и поме�
стить отдельно от всего остального рисунка (рис. 2.35).

С помощью Lasso вы можете выделять любые области, щелчками мышки
рисуя вокруг них линию (рис. 2.36).

Выбор объектовГЛАВА 2 ▼ Рисование во Flash

Рис. 2.35 Рис. 2.3

Flash подсветит выделенные области, чтобы вы убедились в том, что обвели
нужные детали (рис. 2.37).

Выделив руку, мы удаляем ее из рисунка и помещаем в буфер обмена, нажав
Edit ➤ Cut (Правка ➤ Вырезать) или Ctrl/ +X.

Создайте на временной шкале новый слой над уже существующим и помес�
тите туда руку, нажав Ctrl/ +Shift+V.

Теперь можете передвигать ее в новое положение. Затем скопируйте слой с
туловищем, вставьте его выше слоя с рукой в новый слой, удалите старый слой
с туловищем, и у вас получится новый измененный рисунок.

Эта техника требует некоторой сноровки, но владение ею сэкономит вам не�
мало времени (рис. 2.38).

Рис. 2.37 Рис. 2.38

Опции инструмента Lasso

В разделе опций панели инструментов находятся три кнопки, при помощи ко�
торых можно регулировать способ действия инструмента Lasso. Опция Magic
Wand (Волшебная палочка) дает возможность выделять отдельные области
одного цвета, тогда как Polygon Mode (Режим многоугольника) меняет кон�
тур лассо при выделении. Выбрав этот режим, вы можете нарисовать много�
угольник вокруг области, которую собираетесь
выделить, – Flash нарисует контур выделения в
виде замкнутой серии прямых линий, построен�
ных последовательно нажатиями клавиши мыши
(рис. 2.39).

На панели инструментов есть несколько дру�
гих опций, хотя мы затронули только те, которые
понадобятся нам для рисования во Flash. Некото�
рые инструменты мы разберем чуть позже в этой
же главе, по мере того как начнем применять их
для нашей анимации. Рис. 2.39
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Символы
Символы, несомненно, являются наиболее важным элементом при создании
анимации во Flash. Все изображения в фильме, в конце концов, станут симво�
лами, а большинство этих символов превратятся в ключевые позиции (ключевые
точки анимации), как только мы доберемся до обсуждения этой темы в главе о
принципах анимации.

Так что же такое символ? В большинстве книг о Flash символы описывают�
ся как изображения, которые хранятся в библиотеке Flash и могут использо�
ваться снова и снова без необходимости перезагрузки, что уменьшает размер
файла готового фильма.

Однако помимо того, что они уменьшают размер файла нашего фильма и
повышают производительность, для аниматоров (в отличие от Web�дизайнеров)
гораздо важнее, что символы становятся базой для всех действий, которые про�
исходят в нашем фильме. Для тех рисунков, которые после прорисовки преоб�
разуются в символы, можно применять операцию построения промежуточных
изображений при движении, а ведь это и составляет суть анимации.

Во Flash существует три основных типа символов: графические, символы�
клипы и кнопки. Рассмотрим различия между ними.

Графические символы

Графические символы являются для анимации (в отличие от Web�дизайна) наи�
более важными и востребуемыми. Графическим символом называется изобра�
жение, которое хранится в библиотеке Flash и может использоваться, когда и
где потребуется. Еще важнее то, что при помощи этого типа символов мы мо�
жем создавать движение посредством анимации движений.

Графические символы не обязательно одиночны и статичны, мы можем созда�
вать и группировать в графический символ любое количество изображений и
пользоваться ими для циклического или разового движения. Можно возразить,
что для этих целей больше подойдет символ�клип, и в некоторых случаях это дей�
ствительно так. Проблема символов�клипов в том, что во время создания анима�
ции на временной шкале за ними сложнее следить, так что, исходя из этих сообра�
жений, мы будем строить всю анимацию в виде графических символов.

Символы�клипы

В основном символы�клипы используют для создания фильма внутри фильма и
применяют в интерактивных Flash�проектах. Это не значит, что ими нельзя
пользоваться при создании Flash�фильмов, но для анимации персонажей луч�
ше подойдут все�таки графические символы.

Кнопки

Кнопка – тоже интерактивный элемент. Нужно отметить, что в большинство
фильмов, созданных для публикации в Интернете, вы можете захотеть встро�
ить кнопку как в начале фильма, чтобы воспроизвести его после завершения
загрузки, так и в конце, чтобы посмотреть его еще раз. Мы подробнее остано�
вимся на этом, когда будем изучать процесс публикации фильма в последней
главе.

Преобразование изображения в символ

Рассмотрим поближе, что происходит с такими изображениями во Flash.
В нашем примере мы видим персонаж, тело которого разделено на части,

размещенные на разных слоях. На временной шкале выделен слой с рукой, и
все содержимое этого слоя подсвечивается на рабочем поле (рис. 2.40).

СимволыГЛАВА 2 ▼ Рисование во Flash

Рис. 2.40

Чтобы преобразовать изображение в символ, выберите Insert ➤ Convert to
Symbol (Вставка ➤ Преобразовать в символ) или нажмите F8.

Затем дайте символу имя – в нашем случае это sc01 arm, определите его как
графический символ, и щелкните по ОК (рис. 2.41).
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Теперь Flash преобразовал наш рисунок в символ и поместил его в библио�
теку.

Библиотека
Когда мы преобразуем изображение в символ,
Flash сохраняет его в библиотеке, поэтому символ
становится доступен для последующего использо�
вания. Познакомимся с библиотекой поближе и
разберем, что же она собой представляет и как
действует.

Чтобы открыть библиотеку во Flash, выберите
в меню Window ➤ Library (Окно ➤ Библиотека).

Вы должны увидеть новое окно со списком всех
созданных нами символов в алфавитном порядке.
В нашем случае для каждой части персонажа суще�
ствует свой символ: для руки, туловища, глаз и рта
(рис. 2.42).

Выбрав любой из элементов библиотеки, вы
увидите его в окне предпросмотра.

Организация своей библиотеки

Во Flash�анимации очень важно давать своим сим�
волам четкие названия. Лучше всего называть их
просто и понятно, а иногда неплохо еще и добав�

лять номер сцены, в которой этот символ используется, что позволит вам со�
держать элементы библиотеки в порядке.

Разумеется, организовать библиотеку можно множеством различных спосо�
бов, и выбор метода будет зависеть только от вас. В нашем примере элементы

БиблиотекаГЛАВА 2 ▼ Рисование во Flash

Рис. 2.41

в библиотеке организованы в соответствии со сценами. Этим мы хотим вам по�
казать, как можно упорядочить элементы, поэтому вам вовсе не обязательно
строго придерживаться нашей системы. Чем больше рисунков вы создадите,
тем большую головную боль у вас будет вызывать вопрос их упорядочивания и
наименования. Позаботившись об этом в самом начале, вы, возможно, сбере�
жете массу времени, и организация вашей библиотеки будет целиком зависеть
от вас.

Лично мы находим очень полезным создание в библиотеке новых папок для
каждой из сцен или персонажей, в которые вы могли бы поместить все симво�
лы. Это и в самом деле по мере расширения библиотеки поможет вам быстро
находить нужные элементы в ней.

Чтобы создать в библиотеке новую папку, щелкните по значку маленькой
таблички в верхнем правом углу окна, а затем выберите New Folder (Новая
папка) (рис. 2.43).

Рис. 2.42

Рис. 2.43

Теперь Flash разместил в библиотеке новую папку. Чтобы дать ей название,
щелкните дважды по текущему имени и введите новое – мы назвали ее scene 01.

Рис. 2.44
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Чтобы поместить туда символы, выделите их (можно выбрать несколько,
удерживая Shift) и перетащите в папку.

Теперь у вас должна быть папка для сцены 01, в которую помещены все со�
ответствующие символы (рис. 2.44).

Это важно, поскольку к концу фильма у вас могут накопиться сотни символов.

Размещение символов из библиотеки на рабочем поле
Чтобы вставить символ из библиотеки на рабочее поле, сначала выберите на
временной шкале слой, а затем и кадр, на который вы хотите поместить сим�
вол. Выделите символ в библиотеке, и, удерживая кнопку мыши нажатой, пере�
тащите его на рабочее поле. Теперь символ должен появиться и на рабочем
поле, и в выбранном вами кадре на временной шкале.

Редактирование символов
Как уже говорилось, вы не можете редактировать символ на рабочем поле, как
и любое другое изображение, не преобразованное в символ. Чтобы отредакти�
ровать символ (другими словами, чтобы внести изменения в рисунок, преобра�
зованный в символ), вам нужно отредактировать символ в библиотеке. Важно
помнить, что любые изменения, внесенные в символ в библиотеке, приведут к
тому, что все экземпляры данного символа (там, где вы использовали его в
фильме) также подвергнутся изменениям.

Чтобы отредактировать символ, сначала выберите его в библиотеке, потом
щелкните по значку таблички в правом верхнем углу окна символов и выбери�
те Edit (Редактировать). Также можно просто два раза щелкнуть по символу
(рис. 2.45).

Далее Flash откроет предполагаемую новую сцену. Это особая временная шка�
ла для символа, и именно здесь вы можете вносить в символ любые изменения.

Другим способом правки символов является нажатие правой кнопки мыши
на символе, расположенном на рабочем поле (Ctrl�щелчок для Mac), после
чего появится контекстное меню, в котором можно выбрать пункт Edit Symbol
(Редактировать символ).

В этом же меню можно выбрать Edit in Place (Редактировать по месту). Эта
опция позволяет редактировать символ прямо на рабочем поле (рис. 2.46).

БиблиотекаГЛАВА 2 ▼ Рисование во Flash

Рис. 2.45

Рис. 2.46

Ниже мы решили редактировать символ, представляющий собой туловище.
Flash открыл для этого символа новую временную шкалу, и теперь мы можем
внести в рисунок любые правки.

Помните, что сделанные вами изменения повлияют на все экземпляры это�
го символа в фильме (рис. 2.47).

Если вы взгляните чуть ниже левой части временной шкалы, то заметите,
что следом за Scene 1 (сценой, в которой мы работали, когда перешли в режим
редактирования символа), располагается название символа, который мы пра�
вим, в нашем случае это sc01 body. Чтобы выйти из режима редактирования
символа и вернуться к сцене, щелкните по надписи Scene 1.
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Теперь вы можете видеть, что экземпляр символа на рабочем поле изменил�
ся в соответствии с теми правками, которые вы внесли.

У каждого символа есть своя временная шкала. Можно создать символ, в
котором будет более одного рисунка и более одного уровня. Ниже мы обсудим
этот вопрос более детально и в данной главе, и далее в книге, когда начнем
создавать циклы.

Разбиение символов

Только что мы узнали, как редактировать символы. Теперь предположим, что у
нас есть символ, который мы использовали в предыдущей сцене, и мы хотим
использовать его и в новой сцене, однако на этот раз нам нужно слегка его из�
менить, не повлияв на предыдущий экземпляр этого символа.

Наш персонаж жестикулирует одной рукой, а в символе туловища его ле�
вая рука пририсована к телу, но в новой сцене мы хотим, чтобы он жестику�
лировал обеими руками. Вместо того чтобы перерисовывать все туловище,
мы можем разбить символ на рабочем поле, внести изменения и сохранить

его как новый символ, так что это никак не повлияет на предыдущий экзем�
пляр.

Продемонстрируем сказанное на примере, изображенном на рис. 2.48.
Здесь создана новая сцена (Scene 2), в которую скопированы и вставлены

все символы и слои из sc01. Теперь нам нужно выбрать символ туловища на вре�
менной шкале или на рабочем поле, чтобы стал виден синий квадрат вокруг
него.

Чтобы разбить символ на части (то есть преобразовать обратно в обычный
рисунок), нажмите Modify ➤ Break Apart (Изменить ➤ Разбить на части) или
Ctrl/ +B (весьма полезно ради экономии времени запомнить и приучиться
использовать горячие клавиши для функций вроде этой).

Flash должен преобразовать символ обратно в обычный рисунок на рабочем
поле и выделить его. Теперь в рисунок можно вносить изменения. Сделав их,
выделите рисунок на временной шкале и преобразуйте новое изображение ту�
ловища в символ для этой новой сцены. Исходный символ (sc01 body) останет�
ся в библиотеке нетронутым (рис. 2.49).

Другим способом добиться того же результата является использование фун�
кции дублирования символов, которую мы рассмотрим в этой главе чуть ниже.

Рис. 2.47

БиблиотекаГЛАВА 2 ▼ Рисование во Flash

Рис. 2.48
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Символы в символах

Так как у каждого символа своя временная шкала, в одном символе может со�
держаться более одного рисунка. Это может быть также и серия различных
уровней, составляющих одно изображение, или серия последовательных ри�
сунков – например, цикл (в разделе данной главы, посвященном циклам, мы
остановимся на этом подробнее).

Также мы можем размещать символы внутри других символов. Перейдем к
нашему персонажу в Scene 2: мы хотим, чтобы он простоял в растерянности в
одной точке всю сцену. Чтобы сэкономить слои, мы можем совместить все сим�
волы, которые его составляют, и создать один символ, который станет общим
изображением.

Добиться этого можно несколькими путями, но так как нам требуется, что�
бы он оставался неподвижно в том же месте, то мы скопируем персонаж и вста�
вим его в один новый слой.

Сначала выделим все уровни, затем скопируем их: Edit ➤ Copy (Правка ➤ Ско�
пировать) или Ctrl/ +C. Затем создадим новый слой и вставим все туда: Edit ➤
Paste in Place (Правка ➤ Вставить по месту) или Ctrl/ +Shift+V. После того как
вы это проделаете, можете удалить все старые слои, оставив только новый.

Вы видите, что Flash поместил все символы в один слой. Выбрав содержи�
мое этого нового кадра на временной шкале, вы можете преобразовать его в
символ точно так же, как и отдельные рисунки (рис. 2.50).

Flash совместил все символы, составляющие человека, и сгруппировал их в
один новый символ (рис. 2.51).

БиблиотекаГЛАВА 2 ▼ Рисование во Flash

Рис. 2.49
Рис. 2.50

Рис. 2.51
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Если посмотреть на этот символ в режиме редактирования символов, то
видно, что на временной шкале произошло то же самое, что и в сцене: все сим�
волы объединены на одном слое (рис. 2.52).

Оптимизация рисунковГЛАВА 2 ▼ Рисование во Flash

Рис. 2.52

Иногда у нас возникает необходимость создать на временной шкале симво�
ла более одного слоя, особенно при создании циклов. Чтобы сделать точно
такой же символ, каждый элемент которого, однако, будет располагаться на от�
дельном слое, нам потребуется выполнить уже другие действия.

Сначала выделите все слои на сцене, как раньше, но, в отличие от про�
шлого раза, скопируйте их не методом Edit ➤ Copy (Правка ➤ Скопиро�
вать), а с помощью Edit ➤ Copy Frames (Правка ➤ Скопировать кадры) или
Ctrl/ +Shift+C, благодаря чему кадры будут скопированы точно так же, как
они расположены на отдельных слоях в сцене. Затем нажмите Insert ➤ New
symbol (Вставка ➤ Новый символ) или Ctrl/ +F8.

Дайте вашему символу название и нажмите ОК, после чего откроется новая
временная шкала символа. Выделите первый кадр на слое и вставьте все кадры
туда. Edit ➤ Paste Frames (Правка ➤ Вставить кадры) или Ctrl/ +Alt+V –

Рис. 2.53

теперь все слои должны расположиться на временной шкале символа, а в биб�
лиотеке появится новый символ (рис. 2.53).

Чтобы вставить этот новый символ на рабочее поле, перейдите обратно к
Scene 2 и создайте новый слой поверх всех остальных. Выделите символ в биб�
лиотеке и перетащите его поверх существующего изображения (рис. 2.54).

Рис. 2.54

Чтобы вставить его точно на то же место, вам, возможно, придется немно�
го подвигать его туда�сюда. Как только добьетесь правильного расположения
символа, удалите все остальные слои.

Теперь у вас есть тот же самый символ, только с отдельными слоями на сво�
ей временной шкале. Такие символы очень нам пригодятся, когда мы начнем
работать с циклами.

Оптимизация рисунков
Мы немного поговорим об эффектах оптимизации линий в следующей главе, а
в начале этой мы уже рассматривали основы применения инструмента Brush
для рисования изображений. Разберем теперь поподробнее, как оптимизиро�
вать линии и придать нашим рисункам симпатичный мультяшный вид.
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При оптимизации изображения во Flash (особенно когда речь идет о рисун�
ках, сделанных кистью) программа, по сути, уменьшает количество линий и
кривых в рисунке. Каждый мазок кистью, строго говоря, не является прямой
линией. Рисунки кистью воспринимаются Flash не как линии, а как фигуры, и
поэтому одна прямая линия, сделанная кистью, может включать в себя несколь�
ко отдельных линий.

Этот простой треугольник, нарисованный кистью, по идее состоит из трех
линий, но, как вы можете видеть, в нем содержится куда больше линий и кри�
вых, чем можно было бы подумать. После оптимизации фигуры она выглядит
почти так же, но на самом деле действительный размер изображения (в компью�
терных терминах) был уменьшен на 75% (рис. 2.55).

Оптимизация рисунковГЛАВА 2 ▼ Рисование во Flash

Рис. 2.55

У вас может не получиться так же основательно обработать более сложные
изображения, но все равно оптимизация будет значительной.

Так что помимо придания нашим рисункам более приятного внешнего вида,
оптимизация линий эффективно уменьшает размеры наших изображений и,
соответственно, всего фильма.

Оптимизация линий

В этом примере у нас есть рисунок, выполненный кистью. Мы сознательно сде�
лали его чуть грубоватым, чтобы контраст между ним и обработанным изобра�
жением был более разительным (рис. 2.56).

Для оптимизации линий используются несколько опций, но мы будем при�
менять в основном команду Optimize (Оптимизация).

Выделите на временной шкале рисунок, который хотите обработать, и
нажмите Modify ➤ Optimize (Преобразование ➤ Оптимизация) или Ctrl/

+Alt+Shift+C.

Рис. 2.56

Откроется новое окно с ползунком Smoothing (Сглаживание). Этот переклю�
чатель будет определять степень оптимизации линий рисунка во Flash (рис. 2.57).

Рис. 2.57

В положении None (Отсутствует) оптимизация будет минимальна, а в поло�
жении Maximum (Максимально) она заметно возрастет (рис. 2.58).

Рис. 2.58

Практически никакой оптимизации Максимальная оптимизация
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Как видно из рисунков, уровень примененного вами сглаживания может
очень сильно повлиять на окончательный результат. На глаза, например, сгла�
живание подействовало совсем по�разному.

Неоднократное повторение этого процесса также повысит уровень оптими�
зации рисунка во Flash.

Нет никаких четких правил насчет того, насколько сильно нужно сглажи�
вать рисунок, чтобы добиться желаемого вида, но вам обязательно потребует�
ся несколько попыток. Часто бывает, что после оптимизации линий вам при�
ходится взять кисть и резинку и внести кое�где незначительные правки, чтобы
рисунок получился таким, как вам хотелось. Все познается методом проб и
ошибок. Чем больше будете практиковаться, тем более естественный рисунок
будет у вас получаться.

Несколько советов по оптимизации линий

Изменение масштаба рабочего поля до оптимизации линий повлияет на окон�
чательный внешний вид обработанного рисунка. Ниже приведен пример изоб�
ражения, оптимизированного по максимуму, но на первом рисунке масштаб ра�
бочего поля был увеличен до 400%, а на втором – уменьшен до 25% (рис. 2.59).

Рис. 2.59

Максимальная оптимизация при масштабе 400% Максимальная оптимизация при масштабе 25%

Полезные советы по оптимизации изображений

Можно выделять разные части рисунка и оптимизировать их по отдельности.
Выбрав при помощи Arrow только туловище, мы можем оптимизировать

его отдельно от глаз, носа и рта. Вы можете оптимизировать эти элементы
отдельно, если потребуется более или менее сильное сглаживание.

Выделение элементов рисунка при помощи Lasso даст тот же эффект и по�
зволит вам еще точнее выбирать части изображения, которые вы хотите опти�
мизировать.

В нашем случае было оптимизировано только туловище (рис. 2.60).

Рис. 2.60

Выпрямление кривых

Другим методом оптимизации линий является опция Straighten Lines (Вы�
прямление линий). Этот прием более эффективен, если оптимизировать изоб�
ражения, состоящие из прямых линий, наподобие зданий на заднем плане или
мебели и т.п. (рис. 2.61).

Рис. 2.61
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Это пример простенького домика, нарисованного кистью, который выгля�
дит очень грубо и топорно, но после обработки функцией выпрямления при�
обретает совершенно новый вид (рис. 2.62).

Чтобы спрямить линии, выберите на временной шкале нужное изображе�
ние и нажмите Modify ➤ Straighten (Преобразовать ➤ Выпрямить).

При спрямлении линий выбрать степень обработки нельзя. Иногда необхо�
димо немного подрегулировать линии до или после обработки. Привычка
пользоваться отменой последнего действия (Ctrl/ +Z) ускорит этот процесс.

Сглаживание линий

Существует также опция для сглаживания линий – Modify ➤ Smooth (Преоб�
разовать ➤ Сгладить). Ею пользуются в основном для обработки изображений,
выполненных инструментом Line, в противоположность кисти.

Оптимизация линий и рисунков во Flash – наиболее простой и эффектив�
ный способ придать вашему произведению искусства профессиональный вид.
Оптимизация не только мгновенно придает вашему рисунку классический
мультяшный вид, но и уменьшает размер итогового файла. Неудивительно,
что Flash�аниматоры так высоко ценят этот инструмент!

Степень оптимизации рисунков целиком зависит от вашего выбора, как ани�
матора. Попробуйте и убедитесь. С помощью функции отмены (лучшего друга
аниматоров!) экспериментирование становится простым и веселым. Дойдите
до крайности, а потом вернитесь к истокам.

Важно подобрать фильму особенный стиль, так что понаблюдайте, как оп�
тимизация влияет на внешний вид рисунков, и решите, подходит ли этот вид к
общему стилю вашего фильма.

Что касается васГЛАВА 2 ▼ Рисование во Flash

Рис. 2.62

Развивайте собственный стиль
Инструменты рисования и закрашивания во Flash – это всего лишь инструмен�
ты. В процессе всех наших экспериментов у вас должно выработаться правиль�
ное представление о рисовании персонажей и фонов, но создание анимацион�
ных фильмов – это нечто большее.

С самого начала вам придется принимать сложные решения, каким должен
быть стиль вашего фильма и как он должен восприниматься. Мы, основываясь
на собственном опыте, по мере возможности постараемся подковать вас в этом
отношении. Однако, в конце концов, выбор всегда будет за вами.

Что касается вас
Теперь вам нужно как можно больше практиковаться во Flash, пока вы не осво�
итесь с его интерфейсом и инструментами. Для начала можно попробовать
следующее:

Попробуйте составить из простых фигур персонаж, которого не будет в ва�
шем окончательном фильме, чтобы не пришлось волноваться по поводу его
реалистичности и стиля. Потратьте какое�то время, экспериментируя с различ�
ными линиями и цветами, и помните – четких правил тут не существует.

Для создания изображений воспользуйтесь инструментом Brush, и не забы�
вайте размещать различные части персонажа – руки, ноги и т.д. – на разных
слоях, чтобы впоследствии их удобно было анимировать.

Если у вас есть панель для рисования – пользуйтесь ею как
можно чаще. Возможно, на то, чтобы привыкнуть к ней, уй�
дет какое�то время, но вскоре вы начнете удивляться, как во�
обще обходились одной только мышкой. Если же панели у вас
нет – подумайте о том, чтобы на нее потратиться!

Попрактикуйтесь в корректировке изображений при по�
мощи инструмента Line, делая их четкими и ясными.

Наконец, сделайте во Flash несколько грубых набросков
персонажей – и опять можете не беспокоиться об их каче�
стве: будете улучшать его в процессе работы над фильмом.

В следующей главе мы задумаемся о стиле и художествен�
ных эффектах. А пока просто наслаждайтесь вашим новым
альбомом для рисования – Flash.
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Художественное

оформление3Глава

Если вы уже выбрали хороший сюжет для своего фильма, пришла пора по�
думать о его стиле и визуальной привлекательности. В этой главе мы обо�
снуем важность ключевых художественных решений – от подбора цвета

до общего настроения – для создания простых в анимации персонажей. Мы
также рассмотрим процесс создания образцов моделей, сопоставления разме�
ров и фонов и повсюду будем придерживаться правила сохранения четкости
при хорошей прорисовке линий. Дайте волю воображению, а затем подумай�
те, как реализовать свои идеи на практике.

Визуальные элементы, составляющие внешнюю сторону вашего фильма,
будут влиять на то, как аудитория отреагирует на увиденное, будет ли она захва�
чена сюжетом. Художественная режиссура сможет наравне с диалогами, дей�
ствием, музыкой и постановкой донести настроение и тон фильма. Мы попы�
таемся разобраться, как выразить визуально общий тон сюжета и как донести
настроение отдельных частей и сцен. Например, чтобы выразить мрачное на�
строение, мы можем воспользоваться приглушенными тонами, а чувство близ�
кой опасности можно вызвать при помощи зловещих теней.

Теперь настало время поставить несколько важных вопросов:

➤ Какого визуального стиля мы придерживаемся?
➤ Как сделать визуально цельную обстановку, гармоничные фоны и элемен�

ты персонажей, чтобы они казались частью одного пространства?
➤ Как представить фильм, учитывая ограниченность наших аниматорских

возможностей?

Художественное решение определяет общий вид фильма. На этом важней�
шем этапе вы можете дать разгуляться своему воображению. Пересмотрите
свои любимые фильмы и возьмите от них все, что можно. Не ограничивайте
себя рамками жанра. Преимущество японских мультфильмов (по крайней мере,
лучших) состоит в том, что их авторы не чувствуют скованности только из�за
того, что делают именно анимационный фильм. У них больше общего с Ридли
Скоттом и Уолтом Диснеем.

Одним из наиболее неординарных американских фильмов является «The
Iron Giant». Это не просто хороший анимационный фильм, он по праву может
считаться замечательным во всех смыслах. За идеями также можно обратиться
и к «живым» фильмам, и к работам таких мастеров, как Чак Джонс и Брэд Берд
(«The Iron Giant», «The Simpsons»).

Как сделать фильм при помощи Flash? Ну, сначала нужно перекроить сюжет
под требования и ограничения программы. Также нужно постоянно помнить о
размере файла и скорости его показа в Интернете. Это не значит, что нам при�
дется забыть о более амбициозных идеях. Это значит, что нам нужно проявить
смекалку и изобретательность! Немного подумав и все спланировав, можно
сфабриковать во Flash пару очень впечатляющих кадров, движений камеры и
эффектов, которые, тем не менее, будут гладко воспроизводиться.

!!! Художественное оформление – в особенности цветовое решение и дизайн фонов –
единственная область, в которой мы можем сделать Flash;фильм, не уступающий
другим форматам, поскольку большинство решений на этом этапе практически не
повлияют на размер файла.

Какие элементы используются для достижения цельности визуального об�
раза? Для наших целей можно разделить их на линейную прорисовку, цвет/тон
и дизайн. С учетом этого мы будем создавать всех наших персонажей и фоны.

Линейная прорисовка
В отличие от «живых» фильмов, линия является неотъемлемой частью общего
визуального стиля. Мультфильмы изначально были предварительными наброс�
ками художников к картинам и фрескам. Это были простые рисунки линиями,
без всякого цвета и практически без теней. В классических мультипликацион�
ных фильмах, например «Bugs Bunny» или «The Flintstones», линейная прори�
совка уже определяла весь внешний вид не только персонажей, но и фонов.

С момента выхода на экраны «Ren and Stimpy» в откровенном ретро�стиле,
линейная прорисовка вновь стала доминирующим элементом дизайна. Это ретро
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с жирными линиями стало преобладающим стилем анимации на протяжении
последних десяти лет, когда многие мультфильмы пытались повторить и ком�
мерческий, и артистический успех «Ren and Stimpy». Анимационные фильмы,
демонстрирующие такой сильный визуальный стиль, являются ярким приме�
ром того, как умелая художественная постановка может поднять на более высо�
кий развлекательный уровень то, что иначе было бы весьма средней картиной.
А когда такое художественное оформление сочетается с хорошим сюжетом и
запоминающимися персонажами, наподобие «Ren and Stimpy» Джона Крикфа�
луши, то получается классика анимационного жанра. «Space Madness», напри�
мер, близок к совершенству, насколько это вообще возможно.

Черная линия

Рассмотрите изображения одного и того же персонажа, выполненного разны�
ми линиями.

Вот этот нарисован ровными, незаметными черными линиями. На общее
восприятие рисунка такие линии оказывают незначительный эффект. Это не
обязательно плохо. Может, вам не хочется, чтобы линейная прорисовка про�
изводила сильное визуальное воздействие. Линия не обязательно должна доми�
нировать в рисунке (рис. 3.1).

и становятся более важной частью общего стиля. Этот тип прорисовки линия�
ми разной толщины всегда был очень популярен в анимации, особенно в утрен�
них субботних телепрограммах. Кроме того, именно такой тип линий всегда
предпочитали мультипликаторы и художники по комиксам (рис. 3.2).

Линейная прорисовка

Рис. 3.1

В следующем изображении линии имеют куда более «мультяшный» вид.
Толщина линий здесь варьируется, и персонаж выглядит намного живее, чем
предыдущий. Также эти линии производят большее визуальное впечатление

Рис. 3.2

Еще один пример линейной прорисовки как важнейшего элемента дизайна.
Здесь внешний контур намного мощнее внутренних линий. Такой подход вер�
нул себе популярность в последние несколько лет. Во всех этих примерах обыч�
но применяются черные линии (рис. 3.3).

Рис. 3.3
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Цветная линия

Альтернативой черной линии, напоминающей старые линии ксерокса, когда
анимационные изображения копировались на кель до того, как раскрашива�
лись, является расцвечивание линий таким образом, чтобы они сочетались с
цветом кожи, волос, одежды персонажа и т.п. Например, линия, применяемая
для области кожи, может быть чуть темнее, чем используемый цвет кожи.

На этом рисунке вы видите, что контур свитера светлее, чем цвет заливки.
Разумеется, подобрать цвет темнее черного нельзя, так что для выделения внут�
ренней прорисовки персонажа требуется светлый цвет. Daffy Duck – хороший
пример такого стиля осветленных линий, хотя в его случае внешний контур
остается черным. Часто прорисовка цветными линиями используется в сочетании
с черными (рис. 3.4).

именно в этих цветах. Аудитория просто примет это, как данность. Все это со�
ставляет еще один фактор, помогающий донести смысл и рассказать вашу ис�
торию. Одному лишь цвету это не под силу, но в сочетании со всеми остальны�
ми факторами он способен повести зрителя в верном направлении, сделав
вашу задачу проще.

Цвета вы подбираете по своему вкусу. Как это часто бывает, если речь идет
о создании фильмов, четких предписаний на этот счет не существует. Убеди�
тесь, что цвет вашего персонажа правильно сочетается с цветом фона. Они
должны быть выдержаны в едином стиле и в то же время легко различаться
аудиторией. Нам не нужно, чтобы персонаж «потерялся» на фоне. Например,
персонаж в футболке небесно�голубого цвета, расположенный на фоне голубо�
го неба, будет казаться головой, повисшей в воздухе. А уж если и цвет его кожи
сделать голубым, то он просто исчезнет!

Индивидуальное восприятие «подходящего» цвета очень субъективно, так
что экспериментируйте с цветовыми решениями и помните, что никогда не
стоит недооценивать их важности.

Дизайн

Внешний вид персонажей, фонов и обстановки целиком остается на ваше ус�
мотрение. Что, по вашему мнению, соответствует требуемому внешнему виду,
отражает сюжет или просто выглядит здорово, определяется личным вкусом.
Для начала – чем проще, тем лучше. Не добавляйте себе лишней работы и учи�
тесь быть самокритичными, особенно если вы делаете Flash�фильм, над кото�
рым чаще всего приходится работать в одиночку. Научитесь почаще глядеть со
стороны на свой фильм, на какой бы стадии создания он ни находился. Часто
возникает искушение поскорее пойти дальше. Иногда становится крайне нуд�
но раз за разом просматривать все ту же сцену, но в этом процессе выявляются
все проблемы и недостатки фильма.

Общий дизайн практически обеспечивает цельное визуальное восприятие,
если он совпадает с сюжетом и связывает разрозненные визуальные элементы
вместе. Вдохновение и идеи можете черпать из своих любимых фильмов – как
художественных, так и анимационных.

Персонажи
История, которую вы собираетесь поведать, будет в основном рассказана ва�
шими персонажами. То, что они говорят, что делают и как выглядят, даст по�
нять вашему зрителю, кем являются ваши персонажи, как с ними связан сюжет

ГЛАВА 3 ▼ Художественное оформление Персонажи

Рис. 3.4

Цвет
Цвет будет влиять на восприятие аудиторией происходящего на экране. Наи�
более ярким примером передачи настроения цветом можно назвать примене�
ние синей палитры для передачи холода или ночи. Красная/оранжевая гамма
символизирует тепло или огонь.

Цвет также передает чувство опасности, добро, зло и вообще любой набор
эмоций и мыслей. Какого цвета добро или зло? В принципе, можно выбрать
любой цвет, главное – быть последовательным. Сцены в доме Бабы Яги можно
окрасить в желтые и розовые тона, лишь бы зло постоянно было выдержано
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и как развиваются их отношения друг с другом. Их внешний вид и поведение
зависят от их личности. Внутренняя суть персонажа должна отражаться в его
внешнем виде, или, по крайней мере, значительно на него влиять. Иногда боль�
ший эффект производят заведомо нестандартные персонажи. Например, зло�
дею не обязательно быть большим и угрожающим. Это все ваши собственные
творческие решения, которые необходимо продумать, причем именно сейчас,
а не в процессе анимации фильма. Иначе у вас будет сборище персонажей, не
имеющих между собой ничего общего и принадлежащих явно к разным мирам.

Дизайн персонажей, стиль и способ их прорисовки будет зависеть во мно�
гом от вашего персонального вкуса и стиля, а также профессионального уме�
ния.

Будьте проще

Не усложняйте себе задачу, придумывая сложных для рисования или анимации
персонажей. Скорее всего, вам придется рисовать своих героев в разных позах
и под множеством разных углов, а также анимировать их движения. Если ди�
зайн соответствует этим задачам, то рисование станет намного легче, а анима�
ция – интересней. Вам скорее удастся испробовать несколько разных способов,
проиллюстрировать сюжет и немного снизить риск неудачи.

Помимо того что этот персонаж похож на плод чьего�то больного вообра�
жения, его анимация станет настоящим кошмаром (рис. 3.5).

!!! Придерживайтесь простого дизайна. Анимация будет выглядеть хорошо ровно на;
столько, насколько хороши ваши рисунки.

Костюм тоже может добавить кое�что в ваш фильм. Это «кое�что» – нервный
срыв. Остерегайтесь узоров и сложного или запутанного дизайна.

При любом движении персонажа перо тоже придется анимировать. Это не
значит, что нужно совсем отказаться от разных элементов костюма наподобие
перьев, просто помните о том, что это прибавит работы (рис. 3.6).

ГЛАВА 3 ▼ Художественное оформление Персонажи

Рис. 3.5

Особенно много времени потребует ходьба. Действия, жестикуляция, даже зе�
вота (!) станет проблемой. Хорошенько подумайте, стоит ли вводить в фильм две�
надцатиногих персонажей, разве что они просидят весь фильм на одном месте…

Рис. 3.6

Но не слишком просто

Посмотрите на нашего человечка с рис. 3.7.

Рис. 3.7
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Этот подход, пожалуй, уж слишком прост. Развлечь публику такими фигур�
ками – очень непростая задача. Однако то, что это уже удавалось (и с потряса�
ющим эффектом) – факт! Если вы собираетесь прибегнуть к помощи человеч�
ков, то у вас должен быть исключительно сильный сюжет…

!!! Аниматору будет сложнее вызвать эмоции слишком простыми персонажами. Хотя
их проще рисовать, такой стиль усложняет задачу придания им выразительной ми;
мики.

Отдельные элементы

Часто бывает разумнее спроектировать своих персонажей так, чтобы их мож�
но было разбить на отдельные элементы. Эта техника получила широкое при�
знание по мере развития телевизионной анимации. Известная под именем «ог�
раниченной анимации» (в противовес полной анимации, где весь персонаж
перерисовывается при каждом движении целиком), она позволяет сэкономить
на рисовании немало времени, наряду с тем, что, будучи умело использована,
оказывается весьма эффективной. Последние эксперименты в этом жанре при�
несли ему дурную славу. Но это связано, скорее, с экономией средств и плохой
анимацией, чем с внутренними недостатками самого стиля (рис. 3.8).

таким способом, оказывались намного интереснее более дорогих полномет�
ражных анимационных фильмов. В числе удачных примеров чаще всего оказы�
вались наиболее «ограниченные»… на ум приходят «Rocky and Bullwinkle» и
«Roger Ramjet». Если бы эти мультфильмы снимали сейчас, то, скорее всего,
они бы создавались при помощи Flash. Отдельными элементами в фильме мо�
гут быть головы, руки, ноги, глаза, рот и т.д. – в зависимости от требований к
персонажу.

При разработке своих героев не забывайте о разделении элементов. В на�
шем примере мы позволили себе отделить глаза и рот. Мы предоставили этим
элементам достаточно пространства, чтобы они могли выполнять свои функ�
ции, не влияя при этом на все лицо.

Отделение глаз позволяет заставить персонаж моргнуть, не перерисовывая
при этом всего лица (рис. 3.9 и 3.10).

ГЛАВА 3 ▼ Художественное оформление Персонажи

Рис. 3.8

Ранние примеры ограниченной анимации, выполненные такими студиями,
как Hanna�Barbera, отличались сильным визуальным стилем и были очень ин�
тересны. Все это стало возможно благодаря хорошим сюжетам, персонажам,
мастерскому художественному оформлению и анимации – хотя и «ограничен�
ной», но выполненной опытными аниматорами. Частенько телешоу, сделанные

Рис. 3.9

Рис. 3.10
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Отделение рта дает возможность анимировать реплики персонажа без пе�
рерисовки головы (или даже всего тела!). Подробнее мы поговорим об этом,
начав рисовать и анимировать наших героев во Flash (рис. 3.11).

Обдумайте важность прорисовки линий. Работа с линиями составляет один
из наиболее приятных моментов во Flash – настолько удобна здесь оптимиза�
ция и выпрямление линий для придания им по�настоящему мультяшного внеш�
него вида. Именно на это обратили свое внимание 2D�аниматоры, впервые
познакомившись с этой программой. Кстати, так можно понять, у кого есть
опыт в анимации, а у кого – нет. Малоопытные Flash�аниматоры иногда недо�
оценивают значение этого важного инструмента.

Из двух рисунков одного и того же персонажа, размещенных ниже (рис. 3.15),
второй производит намного более сильное впечатление. Он выглядит более ди�
намичным и живым. Линии первого варианта кажутся слабыми и невырази�
тельными. Помимо того что этот рисунок визуально менее привлекателен, он
может повлиять зрительскую реакцию на персонажа и сюжет в целом. Возмож�
но, зритель будет невнимательно следить за повествованием или вовсе отвле�
чется от него. Мы захотим, чтобы он сконцентрировался на сюжете, а зритель

ГЛАВА 3 ▼ Художественное оформление Персонажи

Рис. 3.11

Мы можем разделить элементы всего тела точно таким же способом.
Если у нас есть сцена, в которой персонаж должен жестикулировать, то мож�

но отделить его руку (рис. 3.12 и 3.13).

Рис. 3.12

Рис. 3.13

Отделение ног дает возможность анимировать циклы ходьбы и бега, не пе�
рерисовывая персонаж целиком в каждом кадре (см. главу об анимации)
(рис. 3.14).

Рис. 3.14
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будет думать: «…что за топорный рисунок!» (все основано только на личных
пристрастиях… оригинальные у автора взгляды… и т.д., и т.п.!)

Состав исполнителей

Рисуя персонаж, всегда начинайте с грубого наброска, будь то рисование для
образца модели, плана или в процессе анимации. Учитесь выстраивать своих
персонажей из базовых фигур, а затем добавлять детали. Как и в процессе ки�
нопроизводства, рисунок – это то, что вы делаете сами. Грубая работа при раз�
работке идеи персонажей предоставляет вам намного больше свободы и про�
стора в решении проблем дизайна. Когда вы будете удовлетворены результатом,
тогда и подчистите рисунок.

!!! В анимационных студиях процесс окончательной шлифовки выполняется не анима;
торами, а целым специальным отделом, но в нашем случае мы – это аниматор и
техник;шлифовщик в одном лице!

Так как эти рисунки являются только образцами для сверки, мы можем оста�
вить их в грубом исполнении (рис. 3.16).

ГЛАВА 3 ▼ Художественное оформление Образцы моделей

Рис. 3.15

Образцы моделей
При рисовании и анимации персонажа очень важно постоянство модели. От
одного ключевого рисунка к другому персонаж должен выглядеть одинаково,
даже если его растянули или сплющили. Это особенно важно, если героя рису�
ет целая команда аниматоров. У отдельного художника всегда есть собственный
стиль. Потому у других аниматоров всегда должно быть достаточно материала
для сверки, чтобы быть уверенными наверняка, что они все рисуют одного и
того же персонажа.

Есть разница между рисованием по модели и без модели, сверяясь с образ�
цом модели или обходясь без него. Главным элементом для сверки является об�
разец модели. В нем обычно объединяются разворот (персонаж, позирующий
под разными углами: вид спереди, в профиль, сзади, спереди и сзади в пол�обо�
рота), разные повороты головы, разные позы и несколько ключевых рисунков,
изображающих персонаж в сценах, которые действительно произойдут.
Пользуясь всем этим справочным материалом, нарисуют ли все аниматоры
одинаковую модель? Нет! Но у нас есть гарантия, что они будут гораздо ближе
к этой цели, чем в противном случае.

Наш набор моделей не обязательно должен быть везде настолько деталь�
ным, насколько этого требует команда упрямых и непослушных аниматоров –
мы ведь собираемся всю анимацию рисовать во Flash самостоятельно. Однако
бывает полезно иметь какие�то образцы для сверки.

Рис. 3.16

Поворот вокруг оси

Когда герой нарисован, нам нужно его развернуть – то есть рассмотреть под
разными углами.

Возьмите свой первый рисунок (вид спереди) и используйте как образец для
остальных рисунков. Важно добиться последовательности пропорций и соот�
ветствия деталей между ними.
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Мальчик

Нам нужен полный базовый разворот мальчика, главного персонажа «Мальчи�
ка, который кричал: «Волк!». Тогда мы сможем решить множество проблем
прорисовки, которые возникнут, если нам придется рисовать нашего героя под
разными углами, и получим большую свободу в его анимации с разных точек
обзора, не особо над этим задумываясь (рис. 3.17).

Крестьяне

Обойдемся одним мужчиной и одной женщиной. Можно будет использовать их
повторно, немного по�разному анимируя и размещая в разных местах экрана.
В зависимости от положения – на переднем или на заднем плане – можно будет
сделать их больше или меньше. Если потребуется, поменяем и цвет, чтобы как�
то разнообразить персонажей (рис. 3.19).

ГЛАВА 3 ▼ Художественное оформление Образцы моделей

Рис. 3.17

Рис. 3.18

Другие персонажи не так важны, как мальчик. Для необходимого образца
нам потребуется лишь по одному рисунку каждого из них – это решение, будучи
принято на ранней стадии, позволит сберечь массу сил. Представим роли вто�
рого плана в «Мальчике, который кричал: «Волк!».

Овца

Одной модели овцы будет достаточно. Как
говорится, если видел одну овцу – значит,

видел всех. В нашем фильме овец, ско�
рее всего, даже не придется анимиро�
вать, так как мы только проводим ка�
меру мимо них в начальной сцене.
Можно нарисовать несколько овец

разных цветов или в слегка отличаю�
щихся позах – благо, редактировать во

Flash разные экземпляры чрезвычайно
просто (рис. 3.18).

Рис. 3.19

Волк

Волка мы видим только в профиль. Так что одного рисунка хватит (рис. 3.20).

Рис. 3.20
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Размер персонажей

В нормальный студийный набор моделей, когда над фильмом работают более
одного аниматора, мы бы включили лист сравнения размеров. Это линейка со
всеми персонажами, на которой показаны их размеры относительно друг дру�
га. Это помогает аниматорам и проектировщикам не только рисовать героев в
правильном соотношении друг с другом, но и задавать правильное направле�
ние взгляда в кадре, когда один персонаж смотрит на другого, находящегося за
кадром.

Лист сравнения размеров также дает вам быстрое представление о том, как
герои смотрятся вместе, нормального ли размера их головы. Выглядят ли они
как представители одного вида (если так было задумано)?

Вот так должен выглядеть лист сравнения размеров (рис. 3.21). Нам не ну�
жен лист для всех персонажей, поскольку мы можем подправить их по мере ри�
сования фильма.

от основного действия. Должно быть соответствие между тем, что делают ге�
рои, где проходит действие, и фонами, на которых разворачивается сюжет.

Способ подхода к каждому фону зависит от того, где вы намереваетесь его
использовать и в каком кадре он будет находиться.

Постановка кадров

Постановка напрямую зависит от фона, поскольку именно он показывает зри�
телю окружающую среду и положение персонажей. Все персонажи демонстри�
руются в контексте фона (рис. 3.22).

ГЛАВА 3 ▼ Художественное оформление Фоны

Рис. 3.21

Если впоследствии вам случится работать над более амбициозными проек�
тами, с большой командой, тогда такие листы окажутся просто бесценными.

Фоны
Фоны – это окружающая среда, та вселенная, в которой разворачивается дей�
ствие. Внешний вид любого фильма зависит от того, как персонажи и обста�
новка вписываются и сочетаются с окружающей их средой. Хорошо продуман�
ные и отрисованные фоны и интересная (и подходящая) постановка камеры
могут ускорить развитие сюжета вообще безо всякой анимации. Фоны могут
быть интересными, даже впечатляющими – главное, чтобы они не отвлекали

Рис. 3.22

На крупном плане фон представляет собой задник для действия, актерской
игры. Важно не отвлечь зрителя от анимации героя чрезмерной детализацией
фона или палитрой, которая будет чересчур пестра или негармонична.

!!! Важно, чтобы персонажи не сливались с фоном, но выделялись так, чтобы аудито;
рия могла легко следить за действием. Остерегайтесь использовать в фоне те же
цвета, что и в персонажах, поскольку это может привести к недоразумениям.

В целом, чем крупнее план, тем проще должен быть фон. На нашем крупном
плане мы выдержали фон в предельно простом и упорядоченном стиле, чтобы
не отвлекать зрителя от действия (рис. 3.23).
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На этом примере видно, что мы расфокусировали фон, чтобы создать ощу�
щение перспективы. Таких эффектов фокусировки невозможно добиться во
Flash, придется их импортировать из других программ наподобие Photoshop
(рис. 3.24).

персонаж и растровый фон может выглядеть дрожащим из�за того, что фон
начнет пикселизоваться по мере увеличения масштаба – ведь векторные изоб�
ражения могут перерисовываться на субпиксельном уровне, а растровые (по
определению) – нет. Вопросы совмещения тоже могут усложниться. Существу�
ет и множество различных техник обработки и импортирования фонов (и дру�
гих элементов) из Photoshop во Flash.

Фоны на крупных планах иногда можно делать простыми, как цветовые кар�
ты. Это карта сплошного цвета, которая совпадает с цветом области ключево�
го фона, но не содержит абсолютно никаких деталей. Такая уж точно не отвле�
чет от персонажа.

Цветовые карты успешно применялись в «Ren and Stimpy», причем не толь�
ко как обычный фон, но и для того, чтобы вызвать различные чувства и настро�
ения. Их использовали и в традиционной 2D�анимации для обозначения взры�
ва: в короткий период времени – скажем, от 8 до 24 кадров, в каждом кадре
демонстрировались карты различных цветов. Это обычно основные цвета:
красный, желтый и синий.

Рисуя свои фоны, лучше начать с ознакомительных кадров или крупных
планов каждой локации. Как только они будут готовы, в соответствии с ними
можно рисовать все остальные фоны той же локации. Во многих случаях мож�
но использовать повторно ключевой фон, перемещая его или увеличивая так,
чтобы он подходил к сценам. Для крупных планов можно использовать часть
основного. Все это здорово помогает при создании эффекта непрерывности (а
также освобождает от лишней работы).

Для «Мальчика, который кричал: «Волк!» ключевой фон мы сделали во
Flash. Возможно, вы предпочтете сначала набросать рисунок на бумаге. Потом
его можно импортировать во Flash или использовать в качестве образца для
Flash�версии того же фона.

ГЛАВА 3 ▼ Художественное оформление Фоны

Рис. 3.23

Рис. 3.24

Глубина фокусировки выглядит здорово, но помните, что такие импортиро�
ванные фоны заметно увеличат объем вашего файла, так что при создании
фильмов для Интернета, где размер файла очень важен, их надо использовать
крайне благоразумно.

Вдобавок, осторожнее применяйте растровые фоны во Flash, поскольку это
может повлиять на движение камеры. Например, медленный наезд на векторный Рис. 3.25
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Так как мы делаем черно�белый фильм, то весь фон будет нарисован при
помощи серых линий. Тогда наши персонажи с черным контуром будут лучше
выделяться на нем (рис. 3.25).

Мы выдержали наш фон в простом стиле, но зато, как будет объяснено в
главе об анимации, разделили его на несколько самостоятельных элементов
(передний и задний слои), чтобы придать панораме глубину. Мы добьемся это�
го, варьируя скорость панорамы для создания ощущения перспективы.

Дизайн фонов должен приносить столько же удовольствия, сколько и сама
анимация, тем более что здесь у нас меньше ограничений, поскольку фоны не
придется анимировать. Можете добавить в свои рисунки деталей, не заботясь,
что их придется потом перемещать.

Раскрашивание
Мы уже говорили о том, как сильно цвет может повлиять на аудиторию. Цве�
том можно вызвать сильную эмоциональную реакцию, создать настроение и
атмосферу.

Теплые цвета создают ощущение комфорта. Более холодные – чувство хо�
лода или отчуждения. Цветовая палитра персонажа может отражать его лич�
ные качества. Яркие цвета подойдут для экстраверта, темные – для злодея.
Если выдерживать цветовую гамму последовательно, то это поможет аудито�
рии различать героев и определять, как они относятся друг к другу. Обратите
внимание, как они сочетаются с общей схемой. Всех злодеев можно нарядить
в светлые цвета, а «хороших парней» – в темные. Отдельные персонажи окра�
шиваются в цвета, отличающиеся от всех остальных. Впрочем, и тут жестких
правил нет.

Как только вы сделали ключевой фон (вводный кадр), раскрасьте своих ге�
роев и вставьте их в этот кадр. Во Flash это сделать несложно, зато вы получи�
те четкое представление о том, как персонажи вписываются в окружающую
среду.

Пусть ваши цвета также отражают время суток. Если сюжет фильма разво�
рачивается от рассвета до заката, то соответственно подправьте цвета.

Будьте осторожны с черным цветом. Черный не является цветом как тако�
вым. Иногда он выглядит как черная дыра в экране. Слишком много черного
может заставить вашего зрителя смотреть на поверхность экрана, вместо того
чтобы наблюдать за изображениями (то есть вашим фильмом), которые на него
проецируются. Не забывайте: фильм – это свет, спроецированный на экран.
Это не значит, что вам придется отказаться от мрачных произведений. Просто

помните о кое�каких ловушках. Не стоит слишком преклоняться перед фунда�
ментальными принципами. Достаточно знать правила настолько хорошо, что�
бы можно было их нарушать!

Что касается вас
Все художественное оформление состоит из различных визуальных элемен�
тов – линий, цвета, дизайна, которые будут определять внешний вид вашего
фильма. Соотнесите эти элементы с фоном и дизайном персонажей, чтобы они
гармонировали друг с другом и стали частью единого целого. Этим целым, на�
деемся, станет ваш фильм, который будет и выглядеть хорошо, и иметь инте�
ресный сюжет.

Пересмотрите свои любимые фильмы, чтобы почерпнуть в них вдохнове�
ние. Иногда это влияние на уровне подсознания, проникающее в подкорку.
Иногда все более очевидно: «Я могу использовать такой кадр!»

Поэкспериментируйте с различными стилями и настроениями и понаблю�
дайте за результатом. Если не получилось, то будет несложно все исправить.

Исследуйте, каких эффектов вы можете достигнуть в разных жанрах, напри�
мер, использовав драматическое освещение в фильме ужасов.

Если уж вы остановились на каком�то общем
стиле для вашего фильма, придерживайтесь
своего решения. Лучше переделать все стиле�
вые решения заранее, чем когда фильм уже
наполовину готов.

При умелом обращении оформление
становится важной частью всего сюжета и
помогает завоевать аудиторию, так что вре�
мя, потраченное на него сейчас, с лихвой
окупится впоследствии.

ГЛАВА 3 ▼ Художественное оформление Что касается вас
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Кэтому моменту у вас уже должен быть готов сценарий. В этой главе мы
возьмем составляющие его сцены и посмотрим, как лучше представить
их визуально, при помощи хорошей композиции и соответствующих

техник постановки камеры. К концу главы вы будете вооружены всей техникой
и терминологией, которая только может понадобиться для создания вашей соб�
ственной раскадровки.

Раскадровка получила широкое признание вместе с развитием анимацион�
ных фильмов. Это изобретение приписывают студии Уолта Диснея. Называясь
изначально последовательностью эскизов, раскадровка использовалась для
иллюстрирования сюжета, почти как комиксы, и в настоящее время остается
неотъемлемой частью процесса создания анимационного фильма.

Планирование раскадровки
Как следует из названия, раскадровка призвана проиллюстрировать сюжет,
изложенный вами на бумаге, и фильм, который вы представляете в своем вооб�
ражении. Это – первое визуальное воплощение вашего сценария. На этой ста�
дии можно рисовать приблизительно, держа в уме общую картину, одновремен�
но выстраивая основу для более детальных сцен, которые последуют позже.
Вам нужно продумать, как наиболее эффективно рассказать свою историю, и
разбить сюжет на отдельные кадры. В каждой сцене должен содержаться соот�
ветствующий диалог и сопутствующее действие.

Раскадровка4Глава

Планирование раскадровки

В профессиональных анимационных студиях эта задача решается при помо�
щи специальных панелей кадров, прикрепляемых аниматором на стенку и демон�
стрируемых режиссеру. Для наших целей будет вполне достаточно небольших,
грубых рисунков – то есть набросков, расположенных на бумаге.

Это схема стандартного макета раскадровки: как вы можете убедиться, она
предельно проста (рис. 4.1).

Рис. 4.1

От слов – к картинкам: визуализация сюжета
Именно на стадии раскадровки у вас должно сложиться четкое и ясное пред�
ставление о том, как будет выглядеть ваш будущий фильм, вы должны начать
мыслить и практически, и образно. В этой главе мы рассмотрим все понятия,
которые могут вам понадобиться в этом процессе, от композиции и постанов�
ки экрана до движений камеры или того, что под этим подразумевается в бес�
камерной среде Flash. Как только вы проникнетесь терминологией и освоите
технику, мы перейдем к нашему проекту и продемонстрируем принятые реше�
ния по раскадровке. Затем вы будете готовы к созданию собственной раскад�
ровки, применяя все то, чему научились в этой главе.

К нашему фильму мы применим традиционный подход, но помните, что
кинопроизводство, как и любая форма искусства, предлагает бесчисленное
количество вариантов. Нет никаких аксиом – нет «правильного» или «непра�
вильного» способа делать фильм. О вашем фильме можно судить только по
тому, интересен он или нет, но даже это чрезвычайно субъективно.
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9392 ГЛАВА 4 ▼ Раскадровка Композиция и структура кадров

Правила существуют для того, чтобы их нарушать, но чтобы нарушить, сна�
чала надо их узнать. В нашей главе мы опишем основные традиции раскадров�
ки, которые вам нужно будет изучить, чтобы впечатляюще рассказать сюжет и
донести свои мысли до зрителя. Как только вы освоитесь со всеми «можно» и
«нельзя», то сможете поэкспериментировать с разными подходами в поисках
собственного визуального стиля.

Композиция и структура кадров
Пришло время разобрать, как построить наши кадры, поскольку это решение
будет оказывать огромное влияние и на сюжет, и на аудиторию. Кадры связы�
вают персонажей друг с другом и с фоном, а также помогают вести повествова�
ние.

Основные планы

Это способы, которыми можно показать сцены. В самом общем виде их можно
разбить на три группы: дальний план, средний план и крупный план. Рассмот�
рим их по очереди.

Дальний план

Обычно он используется в качестве вводного, или начального, кадра – благо�
даря тому, что связывает персонаж и фон. Дальний план показывает аудито�
рии место, где разворачивается сюжет, и местоположение персонажей отно�
сительно друг друга (рис. 4.2). Применение дальних планов этим, бесспорно,

Рис. 4.2

не ограничивается, но помните о том, что дальний план требует анимировать
все тело персонажа, поэтому во Flash его нужно использовать очень взвешенно!

Средний план

Он может потребоваться, если осуществляется физическое действие – напри�
мер, жест рукой. Такой план также хорошо подходит для показа двух или более
персонажей (рис. 4.3).

Рис. 4.3

Крупный план

Диалог и более тонкое выражение лица лучше всего изображать этим спосо�
бом. Крупные планы позволяют нам показать особые действия, важные для
сюжета: например, руку, вынимающую пистолет, или ногу, растаптывающую
сигарету (рис. 4.4).

Рис. 4.4
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В этих трех группах можно выделить различные варианты основных планов
(рис. 4.5 и 4.6).

Рис. 4.6

Предельно дальний план Предельно крупный план

Рис. 4.5

Вид сверху Вид снизу

Из-за плеча Одиночный кадр

Двойной кадр Тройной кадр

Flash и виртуальная камера

Прежде чем идти дальше, нам нужно кратко остановиться на роли камеры во
Flash. Важность камеры в фильме трудно переоценить – это и окно, через кото�
рое аудитория видит события, и наш взгляд. При помощи камеры создается
напряжение и драма, развивается сюжет и оказывается максимально сильное
эмоциональное воздействие на зрителя. Это справедливо и для Flash�фильмов,
и для голливудских блокбастеров.

Во Flash, конечно, физически никакой камеры не существует, так что нам
надо придумать свою «виртуальную камеру», которая будет находиться в фик�
сированном положении, покуда мы двигаем наши рисунки для создания иллю�
зии движения. Когда мы производим «приближение камеры» во Flash, то про�
сто делаем наши объекты крупнее, вместо того чтобы двигать камеру. А когда
делаем панорамный кадр, то на самом деле перемещаем не камеру, а фон.

В данной главе мы будем часто возвращаться к камере – а пока просто за�
помните, что мы говорим о камере в концептуальном смысле: например, если
вы можете представить себе, где находилась бы камера в физической трехмер�
ной сцене, это поможет вам нарисовать сцену под нужным углом. Вы глубже
осознаете эти понятия и концепции, как только начнете применять их на прак�
тике в следующей главе. Главное – помнить, что камера всегда остается на мес�
те, а двигается мир вокруг нее.
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Постановка экрана
Снимая фильм, важно помнить, что зритель знает, где находятся персонажи по
отношению друг к другу (если только его не ввести в заблуждение намеренно!).
Чтобы это передать, важно понимать, где находится камера и как ее можно пе�
редвинуть по отношению к персонажам, чтобы не сбивать с толку аудиторию
неправильной постановкой сцены.

Переходя черту

Наиболее фундаментальным правилом постановки экрана является линия дей�
ствия, иногда называемая линией 180°. Это воображаемая линия, проходящая
обычно напротив камеры и обозначающая границу, до которой камера может
размещаться, не «ломая» постановку экрана. Проиллюстрируем это на приме�
ре двух персонажей, расположенных друг напротив друга (рис. 4.7).

Самый простой способ выяснить, где поставить камеру, это нарисовать план.
Здесь мы разместили камеру в трех разных положениях с одной стороны линии.
Посмотрим на разные кадры, которые получатся с этих трех точек (рис. 4.8).

ГЛАВА 4 ▼ Раскадровка Композиция и структура кадров

Первый кадр – это двойной дальний план, снятый с камеры 1 (рис. 4.9).
Второй кадр – крупный план персонажа A, снятый при помощи камеры 2

(рис. 4.10).
Третий кадр – крупный план персонажа B, снятый камерой 3 (рис. 4.11).

Однако если мы разместим камеру на
другой стороне воображаемой линии и за�
меним третий кадр другим, снятым с этой
точки, то постановка экрана станет более
запутанной (рис. 4.13 и 4.14).

Персонаж B каким�то таинственным
образом поменял свое расположение, так
что теперь он находится с левой стороны
экрана, чем нарушает весь вид. Таким об�
разом, мы можем убедиться, насколько

Рис. 4.7 Рис. 4.8

Камера 3

Камера 1

Камера 2

Рис. 4.9 Рис. 4.10

Рис. 4.11

Рис. 4.12

Если мы запустим последовательность с помощью этих трех кадров (или
панелей кадров), то постановка экрана будет понятной – аудитория без труда
разберется, где именно находятся оба героя (рис. 4.12).

Камера 1 Камера 2 Камера 3

Рис. 4.13

Камера 4
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Рис. 4.14

Камера 1 Камера 2 Камера 4

ГЛАВА 4 ▼ Раскадровка Применение камеры

важно добиться ощущения постоянства в месторасположении персонажей
по отношению друг к другу.

Композиция кадра

В предыдущем примере персонаж A находится на первой панели слева. Следу�
ющая панель является одиночным кадром, но здесь наш герой размещен не в
центре, а смещается к левой стороне экрана. На последней панели персонаж B
располагается справа на экране. Когда мы смонтируем эти кадры вместе, это
поможет зрителям легче понять, где находятся персонажи (рис. 4.15).

Рис. 4.15

Выразительность композиции

Композиция кадра может помочь аудитории понять чувства и взаимоотноше�
ния героев, а также то, где они находятся физически.

Здесь, на первой панели, персонаж помещен в центре. На второй панели он
располагается в кадре выше, что создает впечатление доминирования, силы
или угрозы. Поместив героя ниже на третьей панели, мы намекаем на прямо
противоположное: подчинение, слабость или даже страх (рис. 4.16).

Если обратиться к взаимоотношениям двух персонажей, то там действуют
те же правила.

В следующем примере первая панель показывает двух персонажей, стоящих
лицом к лицу. Вторая – одиночный кадр персонажа, находящегося слева. На

Рис. 4.16

этом кадре он помещен низко, со смещением влево. Третья панель – одиноч�
ный кадр другого персонажа, на экране справа, который не только выше на
этом кадре, но и находится прямо в его центре. Первый персонаж у нас не
выходит за пределы левой части экрана, даже в одиночном кадре. В противо�
вес ему второй персонаж во всех своих кадрах занимает на экране больше мес�
та. Что мы здесь подразумеваем? Может, персонаж слева просто физически
мельче, чем другой парень. Даже если так, здесь также предполагается, что
человек справа – доминантная фигура, особенно если принять во внимание тот
факт, что первый персонаж смещен влево, а второй всегда занимает большую
часть экрана (рис. 4.17).

Рис. 4.17

Одно только месторасположение не раскроет всего сюжета, скорее, оно
поможет развернуть его в требуемом направлении, придать нужную окраску.
В анимации обычно не хватает ни времени, ни места, и применение визуаль�
ных хитростей поможет вам лаконичнее выразить смысл.

Применение камеры
Изображая ключевые сцены таким способом, мы задумываемся, как предста�
вить нашу историю графически, но нам нужно пойти еще дальше и продумать,
как выжать максимум возможностей из техники анимации, чтобы оживить наш
сюжет. Сама камера может служить неплохим подспорьем для повествования,
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придания визуального интереса и развития сюжета. Посмотрим, как этого до�
биться.

Движения камеры

Перемещение камеры добавляет визуальной привлекательности и создает впе�
чатление безграничности пространства, которое не кончается за краем кадра.
Эти движения можно использовать и вместо смонтированного перехода к дру�
гой сцене. Слишком усиленное применение «резкого» монтажа может придать
фильму рваный вид, если им не пользоваться в сочетании с переходами каме�
ры. В данном разделе мы остановимся на основных движениях камеры.

В «живых» фильмах передвижение камеры означает, что камера перемеща�
ется физически. Это происходит независимо от того, следует ли фиксирован�
ная камера за объектом, снимая панораму, или она движется вместе с субъек�
том, путем сопровождения или с помощью наезда и отъезда.

В анимации, как уже упоминалось, камера зафиксирована, а двигается рису�
нок, но мы применяем для этого процесса все те же термины «живого» дей�
ствия. Мы по�прежнему рассуждаем о перемещении и регулировании камеры.
Во Flash и 3D�анимации, конечно же, никакой камеры нет, но, как и в традици�
онной анимации, нам нужно воссоздать ее движения, чтобы создать чувство
реальности происходящего.

В анимации применяются два основных типа движения камеры: панорама и
наезд. Рассмотрим их прямо сейчас.

Панорама

Панорамой называется перемещение камеры вдоль экрана по горизонтали, вер�
тикали и под любым углом. В анимации панорамой называется то, что в обыч�
ном фильме назвали бы той же панорамой или движением камеры.

Ниже на рис. 4.18 приведен пример горизонтальной панорамы, охватываю�
щей два поля (экрана).

ГЛАВА 4 ▼ Раскадровка Применение камеры

Рис. 4.18

Начало Конец

Это вертикальная панорама, также покрывающая два поля (рис. 4.19).

!!! Искривленные линии, примененные в этом кадре, создают ощущение масштаба.

А это диагональная панорама (рис. 4.20).

Рис. 4.19

Конец

Начало

Рис. 4.20

Конец

Начало

Панорамное перемещение камеры во Flash производится по тем же прин�
ципам, что и манипуляции с традиционной камерой. Изображение двигается,
а камера остается фиксированной (рис. 4.21).

Рис. 4.21

Камера Камера

Начало Конец

Здесь показан пример того же базового метода, применяемого во Flash: ри�
сунок двигается, камера неподвижна (рис. 4.22 и 4.23).
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Большим преимуществом Flash является возможность немедленного внесе�
ния коррективов в свою работу.

Наезд

Наездом называется движение камеры, приближающее или удаляющее кадр.
Здесь мы видим пример наезда, когда камера от начальной до конечной

позиции движется внутрь кадра (рис. 4.24).
Отъездом, наоборот, называют движение, когда камера начинает с крупного

плана, а потом постепенно отодвигается назад (рис. 4.25).
В традиционной анимации наезд означает движение камеры к предмету или

от него. Разница между Flash и традиционной анимацией состоит в способе

Рис. 4.23

Начало

Рис. 4.22

Конец

Рис. 4.24 Рис. 4.25

Начало

Конец

Конец

Начало

действия камеры. В традиционной анимации большая часть кадров выполня�
ется при разной постановке.

Например, если мы рисуем крупный план, то нам не придется делать рису�
нок во весь лист, мы можем поставить его компактнее, то есть сделать сам ри�
сунок меньше (рис. 4.26).

Однако для дальнего плана нам пришлось бы сделать рисунок в полный
лист, показав больше деталей (рис. 4.27).

Рис. 4.26 Рис. 4.27

Затем сама камера подстраивается по высоте и фокусу, чтобы в поле ее съем�
ки попало нужное изображение (рис. 4.28).

Во Flash камера действует практически с точностью «до наоборот». Она
остается неподвижной, в то время как полем зрения является рабочее поле.
Любые изменения плана подразумевают изменения в самом изображении, так
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Рис. 4.28

Камера

Движение
наезда

ГЛАВА 4 ▼ Раскадровка Применение камеры

что в данном примере нам нужно увеличивать рисунок, как показано на
рис. 4.29.

Рис. 4.29

Flash предлагает нам широчайшие возможности в технике наезда камеры,
поскольку мы не ограничены размером конечного поля. Рисунок можно увели�
чивать практически до бесконечности, в то время как традиционная камера
все�таки имеет границы, до которых она может увеличивать изображение.
У нас есть полная свобода для эксперимента, чтобы установить, что подойдет
лучше, а в сочетании с затемнениями эта техника может порождать очень ин�
тересные эффекты. Мы рассмотрим эти вопросы глубже в главе 5.

Теперь, когда вы познакомились с движениями камеры, можете попробо�
вать применить их к своим основным сценам, чтобы развить сюжет и сопрово�
дить действие.

Применение камеры для развития сюжета

Важным понятием является вводный кадр. Он нужен для «привязки» взгляда
зрителя к конкретной части экрана или некоему элементу в кадре. Затем он
создает у аудитории ожидание последующих событий (рис. 4.30).

Рис. 4.30

Начало Конец

В этом вводном кадре панорама показывает место действия, а при помощи
наезда внимание фокусируется на домике. Это вполне стандартный кадр, кото�
рый вы часто видите и в анимации, и в фильмах в стиле noir.

Камеру можно использовать также для передачи нарастания напряжения
или драмы в кадре (рис. 4.31).

Рис. 4. 31

Начало

Конец
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Это простой кадр, в котором с точки зрения анимации практически ничего
не происходит, но его можно сделать весьма драматичным лишь при помощи
наезда. Без этого кадр останется плоским и безжизненным.

!!! Музыка также способна оживить анимацию: например, короткий, резкий звук
скрипки, добавленный к наезду, может сильно повысить напряженность сцены. Мы
рассмотрим добавление звука более детально во второй части главы, где расска;
зывается о проекте фильма.

Применение камеры для создания эффекта глубины

Двигающаяся камера может добавить дополнительное измерение в кадр, кото�
рый вы решили оставить зафиксированным. Эти движения камеры обычно
бывают очень мягкими и незначительными и не отвлекают аудиторию, застав�
ляя ее ломать голову, почему камера передвинулась.

В нашей сцене камера медленно перемещается из начальной в конечную
позицию – это называется наплыв. При этом сцена становится визуально эф�
фектнее, однако ее целостность остается неприкосновенной. Этот прием чаще
всего длится на протяжении всей сцены, действуя почти на бессознательном
уровне, но внося свой вклад в напряжение и драму (рис. 4.32).

!!! Если вы анимируете своих персонажей до того, как анимировать движения камеры
во Flash, вам иногда придется конвертировать анимацию персонажей в отдельный
символ, для которого можно создать промежуточную анимацию в одинаковом по
сравнению с фоном темпе. Подробнее об этом читайте в главах о проекте и «Маль;
чике, который кричал: «Волк!».

Рис. 4.32

Начало

Конец

Наплывы могут придать глубину вашему фильму, особенно если их сочетать
с различным (и отличающимся) фоном и элементами на переднем плане. Эти
отдельные элементы называются верхним и нижним слоем, в зависимости от
того, располагаются ли они спереди или сзади основной анимации (верхний
слой помещается впереди, а нижний – позади).

Чтобы проиллюстрировать это, посмотрим на образец кадра. Этот дальний
план вмещает в себя три отдельных элемента фона (рис. 4.33).

Рис. 4.33

Начало Конец

Первый из них мы и назовем собственно фоном – небо и облака (рис. 4.34).

Рис. 4.34

Начало Конец

Второй мы назовем нижним слоем – далекие горы и земля (рис. 4.35).

Рис. 4.35

Начало Конец
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Третий – это верхний слой: дерево на переднем плане (рис. 4.36).

Рис. 4.36

Начало Конец

Если провести панораму из точки A в точку B, где все элементы будут переме�
щаться с одинаковой скоростью, то кадр покажется плоским, двухмерным. Неваж�
но, насколько хорошо прорисован фон, он не вызовет ощущения перспективы.

Рис. 4.37

Рис. 4.38

Начало Конец

Начальная позиция

Начало Конец

Конечная позиция

Если варьировать скорость панорамирования элементов фона, то вам удастся
передать настоящую глубину, расстояние и даже чью�то точку обзора. В нашем
примере элементы фона перемещаются крайне медленно, они почти неподвиж�
ны. Панорама нижнего слоя движется чуть быстрее (заметьте: это сработает, если
только на «земляном слое» нет никаких деталей, поскольку любая деталь станет
отдельным элементом и будет неизбежно взаимодействовать с параметрами перс�
пективы, которые диктуют отношения между элементами переднего и заднего
плана). Наконец, верхний слой панорамируется еще быстрее (рис. 4.37 и 4.38).

Это даст вам точку обзора персонажа, который двигается в кадре, будто бы
выглядывая в окно движущейся машины, – элементы переднего плана движут�
ся намного быстрее. Пропорция определяет движение разных элементов в
кадре с разной скоростью, что создает ощущение глубины.

Вы можете попробовать панорамирование верхнего слоя в противополож�
ном направлении. Это даст эффект камеры, которая движется вокруг элемента
переднего плана (верхнего слоя). Перемещение верхнего слоя должно быть
очень медленным (рис. 4.39 и 4.40).

Рис. 4.39

Рис. 4.40

Начало Конец

Начальная позиция

Начало Конец

Конечная позиция

ГЛАВА 4 ▼ Раскадровка Применение камеры

w
w

w
.k

od
ge

s.
ru

http://www.kodges.ru/


111110

Такой прием даст аудитории впечатление движения вокруг дерева и создаст
очень реалистичное ощущение глубины. Рисуя элементы фона, которые затем
будут проходить вдоль камеры, не забывайте рисовать их достаточно далеки�
ми, чтобы они сочетались с движением. Сделайте их достаточно длинными,
чтобы у вас позже имелся резерв в регулировании скорости панорамирования
(рис. 4.41).

ГЛАВА 4 ▼ Раскадровка Применение камеры

Рис. 4.41

Нарисуйте
фон так, чтобы

он выходил
за края кадра

Нарисуйте
фон так, чтобы

он выходил
за края кадра

Начало Конец

Другим эффективным способом использования отдельных элементов для
достижения эффекта глубины является наезд камеры (рис. 4.42).

Рис. 4.42

Конец

Начало

Конец

Начало
Начальная позиция Конечная позиция

По мере того как камера приближается к дому, перемещайте два дерева за
пределы экрана чуть быстрее. И снова это не только добавит визуальной при�
влекательности, но и создаст зрителю ощущение движения мимо деревьев в
трехмерном ландшафте.

!!! Не забывайте, здесь нет настоящей камеры, мы только создаем иллюзию ее при;
сутствия.

Скорость, которую вы, в конце концов, подберете, будет в значительной
степени результатом проб и ошибок, потребует некоторого труда, зато в итоге
даст вам гораздо более интересную сцену.

Таким образом, если вы поймете, что камерой можно оперировать точно
так же, как и любым персонажем во Flash, то сэкономите массу усилий и сможе�
те представить свою историю намного реалистичнее.

Использование камеры для экономии на анимации

Так как большая часть фильмов во Flash демонстрируется в Интернете, важно
минимизировать объем файла. Это означает ограничение в использовании
полной анимации – ради того, чтобы наши фильмы быстрее загружались и вос�
производились более гладко. К счастью, есть положительные примеры! В те�
чение многих лет аниматоры субботних утренних телешоу пытались решить
эту самую проблему (и, по большому счету, решили), но верно и то, что было
сделано и несколько абсолютно кошмарных шоу, созданных, по заявлению ав�
торов, во имя принципов ограниченной анимации.

Еще анимация во Flash предлагает ряд замечательных (и дающих экономию
во времени) преимуществ по сравнению с традиционным двухмерным подхо�
дом, которые мы обсудим в главе, посвященной Flash�анимации.

Нам необходимо помнить, что мы должны придерживаться наиболее эко�
номичного способа на любой стадии процесса кинопроизводства. Неоценимую
помощь может оказать даже план камеры.

В следующем примере мы имеем шагающий персонаж, который располага�
ется как в центре экрана, так и в центре целого кадра. Если применить первый
подход, показанный на левом рисунке, нам понадобится только один рисунок
и немного растягивания и сплющивания, а также промежуточное заполнение

Рис. 4.43

Панорамирование
фона

Панорамирование
фона
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кадров, чтобы создать иллюзию ходьбы. При использовании второго подхода
нам придется анимировать цикл ходьбы полностью (рис. 4.43).

Если в фильме потребуется дальний план идущего персонажа, то потребует�
ся и рисунок дальнего плана, а следовательно, и вся вытекающая отсюда рабо�
та, так что помните об альтернативе. Как еще можно снять этот кадр? Можно
ли его сделать по�другому, не нарушая логики повествования? Можно прибег�
нуть к некоторым профессиональным хитростям – например, нарисовать пер�
сонаж в мантии или длинном платье, расположить его за кустами, чтобы не
пришлось анимировать ноги.

Другим приемом ограниченной анимации, который проповедовали адепты
субботних телешоу, является действие, происходящее за экраном. Помимо эко�
номии усилий, это часто оказывается наиболее эффективным способом про�
иллюстрировать какой�то поворот сюжета.

В нашем примере персонаж бежит по центру экрана, а мимо него проплыва�
ет фон. В кадр въезжает столб, и персонаж налетает на него (рис. 4.44).

ГЛАВА 4 ▼ Раскадровка Растворение, затемнение и вытеснение

Рис. 4.44

Панорамирование
фона

Панорамирование
фона

В панораму
въезжает столб

В следующем примере персонаж бежит по центру экрана, как и прежде. За�
тем он начинает убегать (постепенно перемещаться за экран) влево, пока не
пропадет с экрана. Немного ждем (три или четыре кадра при скорости 12 кад�
ров в секунду), а затем раздается грохот, и камера трясется: меньше работы, но
больше эффекта (рис. 4.45).

Тряска камеры – это ее вертикальные, горизонтальные или случайные дви�
жения (рис. 4.46).

Рис. 4.45

Панорамирование
фона

Персонаж
убегает за экран

Рис. 4.46

Вращательная тряска камеры Горизонтальная тряска камеры Вертикальная тряска камеры

Тряска камеры во Flash не так эффектна, как в традиционной анимации, посколь�
ку нам чаще приходится работать при частоте 12 кадр/с (в противовес 24 кадр/с),
но временами и она тоже используется. Какой именно вид тряски вы изберете, за�
висит от действия, которое она передает. Например, удар об землю потребует вер�
тикальной тряски, поскольку и само действие по своей природе вертикально.

Работа с камерой во Flash часто требует совсем небольших усилий (и файло�
вого объема), чтобы внести элемент драмы, впечатлить зрителя и сэкономить
на анимации! Невероятно сложные кадры, снятые в «живом» действии, можно
воспроизвести во Flash. Внимательно последите за своими любимыми режис�
серами: как они снимают кадры и перемещают камеру. Гарантируем, что это
возможно и во Flash!

Растворение, затемнение и вытеснение
Именно эти приемы в основном используются во Flash, чтобы передать переход в
другую локацию или прошествие некоторого периода времени (или и то и другое).

Растворение

Этот прием лучше всего описать как плавное растворение одного кадра в дру�
гом. Растворение можно проделывать с любого количества кадров, скажем, с 6

w
w

w
.k

od
ge

s.
ru

http://www.kodges.ru/


115114

до 24 (при частоте 12 кадр/с). Во Flash этот прием реализовать очень просто: до�
статочно одной сцене задать переход от параметра Alpha со 100% до 0%, а дру�
гой – переход с 0% до 100%. Как только в главе о проекте фильма мы начнем рабо�
тать с этой техникой, вы сами оцените все ее достоинства и недостатки (рис. 4.47).

ГЛАВА 4 ▼ Раскадровка

Рис. 4.47

Затемнение

Затемнение может быть как собственно затемнением, так и «проявлением».
Обычно (хотя и не всегда) это проявление из черного экрана и затемнение до
черного экрана. Проявление с последующим затемнением или быстрым пере�
ходом кадра может вызвать впечатление нахождения в совершенно другом вре�
мени и пространстве. Используйте этот прием, если вам нужно по�настоящему
отделить уже происшедшее от последующих действий. Проявление вводит в
сюжет новую сцену. Затемнением вы добиваетесь завершения момента, преж�
де чем переходить к следующей части сценария.

Вытеснение

Существуют несколько разных типов вытеснения. Традиционно под вытеснением
понимается стирание части одной сцены наложением другой горизонтально, вер�
тикально или диагонально, хотя вариантов тут может быть множество (рис. 4.48).

Рис. 4.48

Горизонтальный обрез Вертикальный обрез Диагональный обрез

Вытеснение нынче используется нечасто, по крайней мере, в вышеупомяну�
тых формах – даже в анимации. Другим способом наложить одну сцену на дру�
гую является использование в кадре того, что мотивирует этот переход: элемен�
та переднего плана на панораме или персонажа, двигающегося вдоль кадра и
оставляющего за собой новую сцену (рис. 4.49).

Рис. 4.49

В нашем примере человек проходит в кадре на переднем плане и приносит
за собой следующую сцену. Вытеснения такого типа (во множестве вариантов)
постепенно снова завоевывают признание, сначала в рекламе, а теперь и в ху�
дожественных фильмах, которые снимают режиссеры, снимавшие раньше рек�
ламу!

Совпадающий монтаж

Совпадающий монтаж включает в себя все особенности растворения одной
сцены в другой, но им не является. Совпадающий монтаж привносит в обыч�
ное растворение очень мягкое визуальное развитие событий, когда при пере�
ходе из одной сцены в другую доминирующий элемент остается (обычно) в
обеих сценах на прежнем месте.

Рис. 4.50

Растворение, затемнение и вытеснение
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В примере на рис. 4.50, предлагающем классический совпадающий монтаж,
солнце превращается в голову персонажа. Такой монтаж обретает новый смысл
и становится частью событий, если элементы монтажа отражают характер ге�
роя или какой�то поворот сюжета. Этот прием может стать юмористическим
элементом или метафорой какого�то события в повествовании.

В следующем примере, очевидно, персонаж выступает марионеткой или
жертвой (рис. 4.51). Совпадающий монтаж может по�настоящему впечатлить
зрителей, так что подумайте о возможности его использования!

ГЛАВА 4 ▼ Раскадровка Мальчик, который кричал: «Волк!»

Рис. 4.51

Быстрый переход

Быстрые переходы обычно воспринимаются как разрывы. Они противопо�
ложны тем мягким переходам, убаюкивающим аудиторию, которые мы обсуж�
дали раньше. Время, пространство и персонажи сопоставляются хаотично.
Быстрые переходы, как правило, служат в качестве драматического приема,
особенно в музыкальных клипах, где стиль превалирует над повествователь�
ностью. Кратко остановимся на некоторых подвохах, которых стоит избе�
жать (рис. 4.52).

Рис. 4.52

В нашем примере делается переход от кадра «до пояса» до чуть более круп�
ного плана. При этом создается эффект, как будто персонаж «прыгнул» к каме�
ре. Остерегайтесь делать кадры излишне похожими, иначе произойдет слиш�
ком резкий переход.

Мальчик, который кричал: «Волк!»
Попробуем применить полученные знания к сценарию «Мальчика, который кри�
чал: «Волк!». Сценарий уже подправлен и сжат. Исходный сюжет разбит на реа�
лизуемые сцены, снабженные письменными пометками, связывающими текст и
возможности визуализации. Теперь мы должны сделать наброски кадров, создать
композицию и связать их в цельный и, надеемся, интересный фильм.

Сцена 1

Во вводном кадре нам нужно привлечь и заинтриговать аудиторию: а что же
произойдет дальше? Используя крупный начальный план, мы связываем маль�
чика и окружающий его мир. Начнем с холма, на котором может располагаться
одна овца, показываем заглавие, затем заглавие медленно исчезает, а мы прово�
дим панораму, открывая все больше овец на переднем плане, деревню на зад�
нем плане, и наконец, наводим камеру на мальчика, который сидит под дере�
вом и скучает (рис. 4.53).

Рис. 4.53

Сцена 2

Крупный план мальчика. Он кричит в камеру: «Волк!!» Крупный план передает
экспрессию (рис. 4.54).

Обращение персонажа непосредственно к камере/аудитории – прием, ко�
торый нужно применять крайне осторожно. Он может разрушить иллюзию
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взгляда в другой мир, особенно если прежде герои обращались к персонажам,
находящимся за экраном, глядя при этом мимо камеры. Это называется «разру�
шение четвертой стены» – стены, находящейся между сценой и зрителем. В на�
шем случае этот прием добавляет эффект потрясения, которого мы добивались
после показа скучного пейзажа в начальной сцене.

Сцена 3

Средний план паникующих крестьян (не глядящих в камеру). Средний план
хорош тем, что достаточно близок, чтобы показать чувства персонажей, а по�
скольку это групповой кадр, он должен быть достаточно широк, чтобы вмес�
тить как можно больше действующих лиц.

Преимущество нашего сюжета в том, что он хорошо известен. Обычно нам
приходится объяснять, где находятся эти люди и что связывает их с мальчиком.

Рис. 4.54

ГЛАВА 4 ▼ Раскадровка Мальчик, который кричал: «Волк!»

Рис. 4.55

Здесь же мы можем сразу перейти к кадру, демонстрирующему реакцию, так как
предполагаем, что зрители могут об остальном догадаться сами (рис. 4.55).

Сцена 4

Кадр с изображением мальчика «по пояс». Нам не нужен такой же крупный
план, как в сцене 2, поскольку здесь напряжение снижено. Мальчик расслаблен
и доволен (рис. 4.56).

Рис. 4.56

Сцена 5

Здесь используется почти тот же план, что и в сцене 3, – может, лишь чуть бо�
лее дальний, чтобы снять часть напряжения, хотя крестьяне снова реагируют
на мальчика: «Что?» (рис. 4.57).

Рис. 4.57
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Сцена 6

Резкий переход к мальчику. Теперь он еще ближе к камере, чем в сцене 2. Его
голова заполняет собой весь экран.

Еще более близкий план создает напряжение. Мальчик снова кричит (более
пронзительно): «ВОООЛК!!!!» (рис. 4.58)

ГЛАВА 4 ▼ Раскадровка Мальчик, который кричал: «Волк!»

Рис. 4.58

Сцена 7

Переход к крестьянам, находящимся опять чуть подальше, чтобы передать их
дистанцирование от мальчика.

Они не знают, стоит ли ему теперь верить: «В самом деле?» (рис. 4.59).

Рис. 4.59

Сцена 8

Средний план мальчика, снова довольно ухмыляющегося. Чуть ближе, чем в
сцене 4, однако не так близко, как в сценах с криками. Все еще присутствует
настроение расслабленности, хотя мы и приблизили камеру, чтобы увеличить
напряжение (рис. 4.60).

Рис. 4.60

Затемнение экрана вплоть до черного… проходит время.

Сцена 9

Предельно крупный план мальчика (его рот заполняет весь экран) на рис. 4.61.
Орет: «ВОООЛК!!!!!!!» Очень настойчиво!

Рис. 4.61
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123122 ГЛАВА 4 ▼ Раскадровка Вся раскадровка целиком

Сцена 10

Средний план крестьян. Снято, как в сцене 3 (рис. 4.62).
На этот раз причина эмоциональной реакции в другом. Они злятся!

Рис. 4.62

Сцена 11

Начинается с крупного плана мальчика на движущемся фоне. Похоже, он бе�
жит: «О нет!». Камера отъезжает, показывая волка, который гонится за ним…
«ААААААААА!!!» (рис. 4.63).

Растворение кадра (проходит время) в следующем…

Рис. 4. 63

Совпадающий монтаж, переход к могильной плите: «Покойся с миром, маль�
чик, который кричал «Волк!». Отъезд. Показываем дерево, под которым сидел
мальчик. Затемнение до надписи «Конец» (рис. 4.64).

Рис. 4.64

Вся раскадровка целиком
Мы только что разбили нашу раскадровку на отдельные сцены, чтобы лучше
объяснить, какие кадры мы используем. Вот так это выглядит в виде готовых стра�
ниц; наброски сцен могут быть предельно просты, как человечки из палочек, или

Рис. 4.65
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сложны, как чуть более сложные человечки из палочек! Выбор за вами – глав�
ное, чтобы они передавали идею. Панели кадров для «Мальчика, который кри�
чал: «Волк!» отлично подходят в качестве примера: грубые, размашистые, но
раскрывающие сюжет. Главное – чтобы вы понимали, что они значат. У вас
будет еще масса возможностей произвести своими выдающимися художничес�
кими навыками впечатление на своего Зрителя (рис. 4.65–4.67).

Качество рисования

На ранних стадиях разработки фильма нам нужно осторожнее расходовать вре�
мя и силы, не тратясь на рисование, которое, может, и не пригодится в фильме.
Небрежная работа не только экономит время, но и позволяет переносить свои
идеи на бумагу быстро, побуждает вас мыслить смелее, шире и свободнее.

И наоборот, самые сложные проблемы с сюжетом или анимацией мы можем
снабдить любым количеством набросков, выражающих идеи, альтернативы и
решения, практически без затрат времени и энергии. Чем более отточен наш
рисунок, тем больше времени на него ушло, и с тем большим сожалением ху�
дожник отвергнет рисунок, даже если тот весьма сомнительно вписывается в
общую концепцию. Симпатия к хорошему рисунку может затмить вашу непред�
взятость в суждениях – за деревьями вы не увидите леса.

Уровень детализации

Как мы уже видели, на стадии раскадровки мы впервые адаптируем наши идеи
к визуальному исполнению, и в основном делаем это широкими мазками. Все
это общая картина. Основа для последующей работы. По мере продвижения к
новым этапам картина будет становиться все совершеннее.

В кинопроизводстве дьявол может скрываться как раз в мелочах, но об этом
позже. Тем временем сооружение хорошего каркаса снизит количество про�
блем на более поздних стадиях и вызовет меньше сбоев. Всего имеющегося у
нас вполне достаточно, чтобы импортировать это во Flash как базу для даль�
нейших действий. Помните, что фильм делаете вы – шаг за шагом.

Что касается вас
Теперь вам нужно взять свой сценарий, который вы доделали к концу прошлой
главы, и начать делать наброски первой раскадровки. Лучше всего делать это
на бумаге, изображение с которой потом можно отсканировать, пока у вас не
будет доступа к панели рисования или вы не станете достаточно уверенно
рисовать прямо на экране компьютера.

ГЛАВА 4 ▼ Раскадровка Что касается вас

Рис. 4.66

Рис. 4.67
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Переберите в уме все понятия, которые мы рас�
сматривали:

Постройте диаграммы, изображающие поста�
новку каждого кадра – как зритель будет смотреть

на все «глазами» камеры. Это окажет огромное
воздействие на объем дальнейшей работы

над проектом.
Поразмышляйте над тем, какую инфор�

мацию можно донести посредством раз�
личных панорам, наездов и других манев�

ров камеры и, конечно, над тем, что из
перечисленного будет хорошо смотреться в

вашем фильме.
Определите, как связаны между собой сцены и

где использовать монтаж, растворение или вытес�
нение для перехода между ними. Помните,

что эти приемы могут передавать информа�
цию, а также лучше или хуже смотреться от�
носительно друг друга.

Ваша законченная работа может быть настолько детализирована, насколь�
ко вы сочтете нужным, но для вас, как новичка, чем тщательнее будет ваша пла�
нировка на этом этапе, тем меньше проблем возникнет впоследствии.

Если раскадровка – вольная визуальная интерпретация сценария, то в про�
екте мы компонуем все визуальные элементы в единую цельную платфор�
му, на которой и будем выстраивать весь фильм. Ваша раскадровка долж�

на проиллюстрировать каждую сцену движениями камеры или кадрами. В этой
главе мы поработаем над импортированием раскадровки во Flash и использо�
ванием ее для создания базового аниматика, или сюжетной ленты.

Как традиционно делается проект
В традиционной двухмерной анимации проектный отдел берет панели раскад�
ровки и разбивает их на отдельные сцены, помещая всю информацию в папки
сцен. Проектировщик совместно с режиссером подчищает и разрешает все
технические проблемы. Сцены должны быть точно определены, движения ка�
меры отработаны, а постановка должна соответствовать тому, что происходит
на экране. Проектировщик тщательно прорисовывает изображения фона и его
элементов (верхний и нижний слой и т.п.). Подбирается масштаб персонажей,
и они часто рисуются таким образом, чтобы своими позами отражать основ�
ные события в сцене.

Проектировщик также строит направляющие поля, которыми операторы
и аниматоры пользуются для подгонки пропорций изображений, движений
и оформления к рамкам кадров фильма. Таким образом, остальные отделы
будут знать, как снимать анимацию. Затем руководство по фонам отправляется

Проект 1:

создание

аниматика5Глава
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в отдел по фонам, а проект анимации уходит в отдел анимации. Эти отдельные
элементы соединяются уже в камере, рождая сцену, которую представлял себе
режиссер.

Во Flash превращение панелей раскадровки в проект намного проще. Мы
берем наши панели и «разрезаем» их на отдельные сцены, встраивая в сюжет�
ную ленту. Это первая версия нашего фильма, которую мы уже можем смотреть.
Она служит фундаментом для всех последующих стадий: анимации, фонов и т.д.
Мы выполнили нашу раскадровку на бумаге и именно сейчас импортируем по�
лученный результат в программу Flash.

Одно из главных различий между созданием анимационных и «живых»
фильмов заключается в том, что процедуры, которые выполняются после сня�
тия фильма, в анимации выполняются перед съемочным процессом (монтаж,
планирование, эффекты и т.д.). Природа анимации предоставляет ее создате�
лю куда больший контроль. Всегда остается возможность что�то подправить и
подчистить. А в игровом фильме переснятие кадра – всегда большое событие,
даже принимая во внимание все чудеса компьютерной графики!

Большим преимуществом анимационных фильмов, которое очень ценят
режиссеры, является возможность полностью увидеть фильм на ранних стади�
ях производства. Обычно для этого склеивают панели раскадровки, чтобы по�
лучить аниматик или фотоленту. Это первая версия фильма, и поскольку здесь
выкладываются или анимируются сцены, из них можно составить аниматик.
Он позволяет аниматору изучить течение и темп анимации с возможностью
одновременного редактирования, не дожидаясь стадии доработки после созда�
ния фильма, хотя и такая возможность у нас есть.

Преимущества Flash

Будучи Flash�аниматорами, мы можем свободно регулировать и дорабатывать
наш фильм. В программе очень просто внести изменения, чтобы немедленно их
увидеть, не дожидаясь возврата фильма из лаборатории. Будь то двухмерная или
трехмерная графика, цифровые технологии совершили революционный пере�
ворот в процессе производства анимационных фильмов, и сейчас очень немно�
гие студии по�прежнему пользуются традиционной техникой «камера�кель».

Мы выполняем проекты в самом фильме, не раскладывая их по отдельным
папочкам и не рассылая информацию по разным отделам. Как только анима�
тик будет нормально выглядеть, хорошо проигрываться, а технические вопро�
сы (постановка, движения камеры и т.д.) улажены, можно считать, что проект
готов!

Свойства фильма
Прежде чем приступить к созданию нашего Flash�фильма, нужно задать его
свойства. Они будут влиять на частоту кадров и форматное соотношение.

Частота кадров

Анимация и фильмы вообще – это серия изображений, помещаемых перед ка�
мерой, чтобы создать иллюзию движения. От того, сколько изображений или
кадров за определенный момент времени мы будем использовать, зависит, на�
сколько плавными будут выглядеть действия. Частота кадров означает количе�
ство кадров фильма, которые пройдут перед камерой за секунду.

Обычные фильмы воспроизводятся со скоростью 24 кадр/с, видео – 25 кадр/с.
По умолчанию частота кадров во Flash равна 12 кадр/с, и для интернет�филь�
мов это наилучший вариант, поскольку так они воспроизводятся более плавно.
Тот же прием работает и с телевизионными мультфильмами, хотя и снятыми
на частоте 24 кадр/с, но фактически анимированными на 12 кадр/с. Каждый
рисунок воспроизводится в течение двух кадров. Если нам понадобится очень
быстрое действие или будет задействовано движение камеры, мы применим
одиночные кадры (по рисунку на каждый кадр).

Если вы собираетесь импортировать свой фильм на видео, то, возможно,
захотите задать более высокую частоту – лучше всего подойдет 25 кадр/с. Вы
сможете анимировать фильм при любой частоте кадров; простая задержка ри�
сунков на два кадра даст вам тот же эффект, что и частота в 12 кадр/с. Преиму�
ществом работы с частотой 25 кадр/с является более плавная анимация, осо�
бенно при движениях камеры – панорамах и наездах. Это позволит вам
избежать эффекта под названием «стробирование» – мерцания, которое иног�
да возникает при движениях камеры.

Иногда возникают проблемы при добавлении звуков в фильмы, сделанные
на частоте 25 кадр/с, поскольку программе не удается синхронно их воспроиз�
водить. Так что если вам не нужно выпускать фильм на видео, придерживай�
тесь частоты 12 кадр/с. Важно помнить, что независимо от частоты кадров,
вам не обязательно рисовать по одному изображению на каждую секунду. Ри�
сунки можно задерживать на любое время.

И снова повторимся: существует техника, экономящая время (и деньги!).
Это та техника, к которой мы не просто обращаемся в разделе об анимации, но
которой всецело придерживаемся, следуя по пути создания интересного и
энергосберегающего кинопроизводства.
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Формат кадра

Второй параметр, который нам нужно установить, – это формат кадра. Это
соотношение описывает пропорции ширины и высоты экрана и является важ�
нейшим компонентом, определяющим внешний вид фильма. Хотите ли вы,
чтобы он выглядел, как телешоу, или же вам нужен эффект широкого кинема�
тографического экрана – это определяется форматом кадра и должно рассмат�
риваться в контексте каждого конкретного случая. Например, если бы ваш
фильм был пародией в стиле 50�х, то формат кадра, очевидно, отличался бы от
эпического вестерна. В традиционном кинопроизводстве принято несколько
стандартов формата кадра. Мы рассмотрим два основных.

Стандарт 4:3

Для стандартного ТВ характерно соотношение 4:3, или 1,33:1. Другими слова�
ми, ширина изображения в 1,33 раза больше, чем его высота, и точно такое же
соотношение разрешения применяется для большинства компьютерных мони�
торов, например 800×600 или 1024×768. Такой стандарт раньше традиционно
использовался на ТВ. Он стал терять популярность с распространением широ�
коэкранного телевидения, когда зрители предпочитали смотреть фильмы с
черными кромками, нежели обрезанные по краям (рис. 5.1).

Во Flash формат кадра определяется свойствами документа и измеряется в
пикселях. Это просто размер кадра или рабочего поля, колеблющийся между
ТВ�форматом и широким экраном.

Для большинства интернет�фильмов прекрасно подойдет принятый во Flash
по умолчанию формат 550×400; при нем фильм неплохо публикуется в окне бра�
узера и независимо от разрешения вашего монитора всегда отображается в кад�
ре. Начинать лучше всего с этого формата. Позже вы сможете поэксперимен�
тировать с различными соотношениями.

Если вы планируете выпускать свой фильм на видео, вам придется подо�
брать соответствующий формат кадра.

Следующие установки – пример пиксельных соотношений D1 PAL и NTSC
Video (похоже, наиболее распространенных), однако, настраивая свой фильм
для переноса на видео, нужно позаботиться о некоторых вещах: важнее всего
определиться с видеомонтажным оборудованием, которое вы намереваетесь
использовать, поскольку это повлияет на выбор параметров фильма во Flash.
Рекомендуем вам внимательно изучить опции копирования видео, прежде чем
приступить к созданию фильма, если вы планируете переписать его на кассету.

D1 PAL
➤ Стандарт 4:3 – 720×576 (форматное соотношение пикселей 1,07)
➤ Широкий экран 16:9 – 720×576 (форматное соотношение пикселей 1,42)

D1 NTSC
➤ Стандарт 4:3 – 720×480 (форматное соотношение пикселей 0,9)
➤ Широкий экран 16:9 – Широкий экран = 720×480 (форматное соотноше�

ние пикселей 1,2)

ГЛАВА 5 ▼ Проект 1: создание аниматика Свойства фильма

Рис. 5.1

Широкий экран 16:9

С введением цифрового телевидения был принят новый стандарт – 16×9, или
1,77:1. Хотя мы и привыкли думать о нем, как о «широком экране», есть и бо�
лее широкие, обычно используемые в художественных фильмах (рис. 5.2).

Рис. 5.2
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Рис. 5.4

Зона
телевизионного

обреза

Края рабочего
поля Flash

На что еще надо обратить внимание (и о чем большинство людей забыва�
ет), так это на то, что во Flash изображения создаются в квадратных пикселях,
а на видеокассете пиксели прямоугольные. Так что, задав параметры пикселей
во Flash, равные вышеупомянутым видеопараметрам, при переносе на видео вы
получите слегка растянутые рисунки. Поэтому лучше установить в фильме па�
раметры для квадратных пикселей, а потом преобразовать рисунки под видео�
стандарты для переноса на кассету после выпуска их во Flash – и опять все бу�
дет зависеть от вашего видеомонтажного оборудования.

Для вышеупомянутых форматов кадра в видео должны задаваться следую�
щие параметры квадратных пикселей:

➤ Pal квадратные пиксели – 768×576;
➤ NTSC квадратные пиксели – 720×540 (как показано в телевизионном шаб�

лоне во Flash, о нем ниже).

Установка параметров формата кадра

Чтобы задать эти параметры, откройте Flash, а затем разверните Property Ins�
pector (Инспектор свойств) внизу экрана. Щелкнув по табличке Size (Размер),
вы откроете окно Document Properties (Свойства документа) (рис. 5.3).

!!! Не забывайте сохранять свою работу почаще: нет более веской причины уйти в за;
пой, чем необходимость перерисовывать что;то из;за сбоя в компьютере.

Зона телевизионного обреза

Область рабочего поля, которая совер�
шенно точно будет видна зрителю по
телевизору или на мониторе, ограни�
чивается зоной телевизионного обре�
за. Здесь будут края телеэкрана. По�
скольку рамка телевизора не совпадает в
точности с рабочим полем, некоторая часть изоб�
ражения всегда будет теряться при переводе в ви�
деоформат (рис. 5.4).

В традиционной анимации художники пытаются
выдерживать важные действия в рамках этой облас�
ти. Вы же не захотите, чтобы что�то значительное
происходило рядом с краем экрана – или оно может
оказаться вообще за экраном!

Мы видим, что данный кадр вполне прилично смотрится на рабочем поле,
однако стоит нам только перенести его на видео, как значительная его часть
потеряется в процессе этого переноса, в результате чего кадр будет выглядеть
грубо и куда менее эффектно (рис. 5.5).

ГЛАВА 5 ▼ Проект 1: создание аниматика Свойства фильма

Рис. 5.3

По умолчанию заданное значение – 550×400, при частоте 12 кадр/с. Если
вы хотите использовать формат кадра или частоту кадров, отличающиеся от
предлагаемых по умолчанию, введите здесь требуемые параметры.

Когда проделаете это, сохраните свой фильм.
Перейдите к File ➤ Save (Файл ➤ Сохранить), укажите путь (куда сохранить)

и имя файла. В нашем случае он назван animatic. Нажмите Save (Сохранить).

Рис. 5.5

Если вы делаете свой фильм «под Интернет», об этом не стоит беспокоить�
ся. Однако если вы намереваетесь в какой�то момент перенести его на видео,
то стоит подумать над этим вопросом, чтобы избежать раздражающей подгон�
ки размеров впоследствии.
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Полезнее всего нарисовать внутри области основного рабочего поля специ�
альный кадр, который даст вам уверенность, что все задуманное действие про�
изойдет в поле зрения. Этот кадр известен под названием «гарантированная
направляющая поля» или «направляющая ТВ�поля», и его нужно размещать на
отдельном слое (рис. 5.6).

Мы не будем пользоваться этим шаблоном для нашей направляющей – ведь
наш фильм предназначен исключительно для Интернета; направляющая нам
понадобится в основном для выравнивания панелей раскадровки.

Использование сетки

Чтобы нарисовать направляющую поля, сначала включите на рабочем поле
сетку, нажав View ➤ Grid ➤ Show Grid (Вид ➤ Сетка ➤ Показать сетку) или
нажав Ctrl/ +#. Сетка – очень полезный инструмент и для размещения

ГЛАВА 5 ▼ Проект 1: создание аниматика Свойства фильма

Рис. 5.6

Края рабочего поля Flash

Направляющая ТВ-поля

Мы сделаем такую направляющую поля и для нашего аниматика. Здесь нуж�
но упомянуть, что поскольку мы делаем фильм исключительно для Интернета,
не намереваясь переносить его на видео, то создадим нашу направляющую
только для примера и в основном будем использовать ее для выравнивания
панелей раскадровки во время импортирования (по ходу действия вы разбере�
тесь, что мы имеем в виду).

Область, которая пропадает при переносе на видео, может существенно
различаться, и направляющую нужно делать размером около трех шагов сетки
внутри рабочего поля в противовес одношаговой направляющей, которую мы
сделаем для нашего фильма.

Пользователи Flash MX должны знать, что теперь эта версия выходит со
встроенным шаблоном с ТВ�направляющей. Чтобы выбрать этот шаблон, на�
жмите File ➤ New From Template ➤ Broadcast (Файл ➤ Новый из шаблона ➤
Телевизионный). Откроется новый фильм, в котором направляющая для вас
уже нарисована. Можете подогнать ее под свой фильм (рис. 5.7).

На этом шаблоне видны три рамки, внутренняя помечена как Title safe
(Зона заголовка) – это границы для заголовка и любого текста. Вторая рамка
названа Action safe (Зона действия); здесь будут происходить все ключевые
действия.

Рис. 5.7

Этот слой – направляющая, и его не будет в вашем фильме. Можно его скрыть или удалить

Зона заголовка. В этих границах размещается заголовок и текст

Зона действия. В этих границах помещается действие и все движения

Рабочая зона. 720    540 – подрегулируйте ее, чтобы она совпадала в пропорциях с размером вашего фильма
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объектов и персонажей на рабочем поле, и для выравнивания изображений –
в последующих главах мы не раз будем прибегать к ее помощи. По умолчанию
используется сетка размера 18×18, ею�то мы и воспользуемся.

Нужно как�то обозначить этот слой. Дважды щелкните по его имени (Layer 1)
и назовите его TV Frame (рис. 5.8).

Теперь в качестве цвета заливки выберите «прозрачный»: при этом малень�
кое квадратное окошко в правой верхней части панели выбора цвета должно
быть перечеркнуто красной линией (рис. 5.11).

ГЛАВА 5 ▼ Проект 1: создание аниматика Свойства фильма

Рис. 5.8

!!! У вас должно войти в привычку давать всем своим слоям имена; это сильно упрос;
тит вашу работу и сделает ее яснее, особенно когда мы приступим к анимации. Вы
обнаружите, что вам понадобится множество слоев, и в них легко заблудиться, если
слои только пронумерованы.

Теперь зададим нашу зону ТВ�обреза. Выбрав кадр 1, нажмите на главной па�
нели инструментов кнопку инструмента Rectangle (Прямоугольник) (рис. 5.9).

Теперь выберите цвет рамки – красный отлично подойдет для таких целей,
поскольку отличается от остальной прорисовки линий (рис. 5.10).

Рис. 5.9 Рис. 5.10

Чтобы задать этой линии толщину, перейдите к Property Inspector внизу
экрана и выберите нужную толщину при помощи ползунка. Мы используем тол�
щину, равную 2, достаточную для того, чтобы линию было хорошо видно.

Рис. 5.11

Затем нарисуйте рамку, отступив от границ рабочего поля примерно на
один квадрат сетки. Так у вас получится направляющая, с помощью которой
вы сможете держать всю свою анимацию внутри, не теряя при этом значи�
тельной части рабочей области (рис. 5.12). Помимо того, что мы следим, что�
бы анимация не заходила за край экрана, мы ведь не хотим, чтобы все дей�
ствие развивалось на крохотном участке в центре, посреди огромного пустого
пространства?

Рис. 5.12
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Так как наш фильм не предназначается для видео, мы оставляем эту рамку
только в качестве ориентира. На самом деле область, которая теряется при
переносе на видео, может очень сильно меняться. Лучше всего делать зону
ТВ�обреза дальше от края рабочего поля: 2,5–3 клеток для направляющей дол�
жно хватить.

Создание слоев
Традиционная анимация предстает перед камерой на разных уровнях (или сло�
ях). На каждом уровне содержатся разные элементы. Например, один уровень
для фона, другой для первого персонажа и еще один – для второго. Это дает
аниматору возможность двигать и распределять по времени один слой незави�
симо от других.

В ограниченной анимации персонажи разбиты на отдельные элементы: ту�
ловище, голова, рот и так далее. Для эффективной работы лучше всего поду�
мать об этом на стадии художественного оформления, что мы и сделали. В де�
тали этого процесса мы окунемся по�настоящему в главе о Flash�анимации, но
для того, чтобы импортировать раскадровку, нам нужно изучить вначале осно�
вы механики слоев.

В отличие от традиционной кель�анимации, одним из главных преимуществ
Flash является то, что вы не ограничены в количестве слоев (или уровней), ко�
торые можете использовать. В традиционной анимации все рисунки копирова�
лись на прозрачные ацетатные кели, так что существовал определенный лимит

на число рисунков, которые можно было накладывать один поверх другого,
пока не станут возникать тени или небольшие цветовые изменения. Так как во
Flash кели не нужны, то нет и этих нестыковок, поэтому у нас появляется пре�
имущество неограниченного количества слоев. Однако большая часть тради�
ционной анимации в наши дни рисуется и снимается в различных композици�
онных программах, так что, возможно, когда�нибудь использование келей
окончательно уйдет в прошлое, это лишь вопрос времени (рис. 5.13).

Чтобы создать слой во Flash, щелкните по значку Insert Layer (Вставить
слой) внизу левого края временной шкалы, а затем дайте ему имя. Так как имен�
но на этот слой мы собираемся импортировать нашу раскадровку, назовите его
Storyboard (рис. 5.14).

ГЛАВА 5 ▼ Проект 1: создание аниматика Создание слоев

Рис. 5.13

eyes

head

body

Рис. 5.14

Если при добавлении этого нового слоя у вас был выбран слой TV Frame,
вы увидите, что Flash поместил новый слой поверх выбранного. Поскольку нам
нужно, чтобы он находился под слоем TV Frame, щелкните по новому слою и
перетащите его вниз. Вы увидите, что нам придется частенько перемещать
слои, особенно когда мы начнем анимацию (рис. 5.15).

Рис. 5.15
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Импортирование раскадровки
Переход от раскадровки к стадии проекта у нас не так запутан, как в традици�
онной анимации. Проект во Flash – это, по сути, панели раскадровки, разделен�
ные на отдельные сцены и грубо подогнанные по времени, чтобы получился
фильм, который можно воспроизвести, посмотреть и подправить. В традици�
онной анимации проектировщики перерисовывают элементы куда более де�
тально: ставят кадры, рисуют элементы фонов и предоставляют аниматору
позирующих персонажей. Во Flash мы сразу вставляем все эти элементы в наш
фильм и работаем с ними там.

Так как у нас есть раскадровка на бумаге, мы отсканируем наши рисунки и
импортируем их во Flash. Как и во всей анимации, тут нет жестких правил, и в
некоторых ситуациях может оказаться проще нарисовать все прямо во Flash.
Однако раскадровка на бумаге, особенно если вы новичок во Flash�анимации,
позволит лучше сконцентрироваться на сюжете, вместо того чтобы пытаться
разобраться в механике воплощения своих идей.

На этой стадии полезно бывает «разрезать» раскадровку и сохранить каж�
дую панель отдельно. Из�за своих малых файловых размеров для этих целей
отлично подойдут JPEG� или GIF�изображения. Для работы с ними существуют
две хорошие программы: Paintshop Pro и Adobe Photoshop. Если у вас нет дос�
тупа к этим программам – не переживайте, вы все равно сможете добиться того
же эффекта.

!!! Перед импортированием убедитесь, что все ваши изображения располагаются
последовательно, например, sb panel 01, 02, 03 и т.д. Это поможет организовать
работу на последующих стадиях. Лучше всего первой цифрой ставить ноль, напри;
мер 01, чтобы, когда вы дойдете до 10, элементы не перепутались.

Теперь мы готовы к началу импортирования наших изображений с раскад�
ровки. Каждый рисунок, или кадр, представляет отдельную сцену или действие
в сцене. То, что мы создаем – это мультипликационная лента, которую мы смо�
жем воспроизвести как повествование. Это платформа, на которой будет стро�
иться наш фильм, – она станет нашим антиматиком.

Выберите на слое Storyboard кадр 1, потом выполните File ➤ Import
(Файл ➤ Импортировать) или нажмите Ctrl/ +R. Выберите файлы, которые со�
бираетесь импортировать, и щелкните по кнопке Open (Открыть) (рис. 5.16).

!!! Если вы именовали изображения последовательно, вам нужно выделить только
первый файл; затем Flash спросит, хотите ли вы импортировать всю последова;
тельность, – щелкните по Yes (Да).

Теперь Flash вставит все изображения на временную шкалу и в библиотеку,
выведя на рабочее поле первый кадр. Первая панель раскадровки для «Маль�
чика, который кричал «Волк!» выглядит на экране именно так, каждое отдель�
ное изображение помещено на свой собственный кадр (рис. 5.17).

ГЛАВА 5 ▼ Проект 1: создание аниматика Импортирование раскадровки

Рис. 5.16

Рис. 5.17

Если у вас не было возможности «разрезать» раскадровку на отдельные изоб�
ражения, это будет означать, что вы импортируете страницу целиком, поэтому
управлять этим рисунком будет несколько труднее.
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Другим преимуществом небольших изображений является то, что во Flash
они будут воспроизводиться немного более плавно, когда мы перейдем к тести�
рованию нашего аниматика (сюжетной ленты). Но большой разницы нет, мы
все равно будем впоследствии заменять панели раскадровки, так что все это,
скорее, вопросы удобства (рис. 5.18).

ГЛАВА 5 ▼ Проект 1: создание аниматика Импортирование раскадровки

Рис. 5.18

Масштабирование панелей раскадровки

Начнем выстраивать композицию из наших индивидуальных сцен. Возьмем
панели раскадровки и впишем их в направляющую на рабочем поле. Не забы�
вайте о ТВ�обрезах и о том, хорошо ли отцентрирована панель. Как и все во
Flash, вы всегда сможете подправить это впоследствии, но лучше не забывать о
композиции с самого начала.

Выберите первое изображение, щелкнув по временной шкале или на рабо�
чем поле. Выделенный кадр будет подсвечен на временной шкале, а на рабо�
чем поле вокруг изображения появится пунктирная линия.

Выберите на панели инструментов инструмент Transform (Трансформиро�
вать), а потом щелкните по инструменту Scale (Масштаб) (рис. 5.19).

Рис. 5.19

Рис. 5.20

Теперь перетаскивайте один из углов рисунка и проследите за тем, чтобы
рисунок подходил к рамке, – с помощью Arrow вы можете передвинуть рису�
нок куда угодно. Здесь вы почувствуете пользу направляющей поля; подгоните
размер рисунка под нее.

!!! Убедитесь, что вы взялись именно за угол рисунка, поскольку при этом масштаби;
рование будет осуществляться с сохранением пропорций высоты и ширины. Если
щелкнуть в середине одной из сторон, изображение будет растягиваться в высоту
или ширину.

Такой способ масштабирования очень полезен, и мы к нему еще вернемся.
Пока нам нужно только подобрать размер рисунка, сохраняя исходные пропор�
ции (рис. 5.20).
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Так как вводная сцена у нас – панорама, на которой сцену иллюстрируют
более одной панели, то пока мы просто центрируем первый кадр этой сцены –
и двигаемся дальше.

Добавление и удаление кадров
Поскольку это сцена 1 и нам нужна панель только первого изображения, все
остальные из сцены можно удалить. Добавление и удаление кадров часто осу�
ществляется в контексте анимации и распределения по времени в процессе
редактирования готовых сцен.

Выделите все остальные изображения, щелкнув по ним, а затем, нажав левую
кнопку мыши, перемещайте курсор по временной шкале. Как только все кадры
будут выделены, выполните Insert ➤ Remove Frames (Вставка ➤ Удалить кадры)
или нажмите Shift+F5. Так мы удалим все остальные кадры (рис. 5.21).

о скорости фильма, монтировании его частей и воспроизведении, мы еще смо�
жем решить этот вопрос.

Чтобы добавить кадры, перейдите к кадру 50 и выделите кадры одновремен�
но на обоих слоях. Затем щелкните по Insert ➤ Frame (Вставка ➤ Кадр) или
нажмите F5. Теперь длина нашей сцены составляет 50 кадров (рис. 5.22).

Вы легко можете узнать длину сцены в кадрах или в секундах, взглянув на ниж�
нюю часть временной шкалы. В нашем примере сцена длится 50 кадров при час�
тоте 12 кадр/с, что равняется 4,1 секунды. Вы также можете заметить, что, стоит
вам передвинуться по временной шкале или выбрать любой кадр, программа точ�
но скажет, в каком кадре вы находитесь и в какую секунду этот кадр будет воспро�
изводиться. Особенно это важно при анимации (рис. 5.23).

ГЛАВА 5 ▼ Проект 1: создание аниматика Создание сцен

Рис. 5.21

Нам не нужно, чтобы сцена состояла из одного кадра. Каждая сцена должна
быть достаточно длинной, чтобы при воспроизведении мы могли ее спокойно
рассмотреть. Поэтому нам нужно добавить кадры.

На данном этапе точная длина сцены не имеет большого значения, так что
«на глаз» поставим для начала 50 кадров. Позднее, когда придет время задуматься

Рис. 5.22

Рис. 5.23

Создание сцен
Так как раскадровка разбита на отдельные сцены, следующим шагом станет
создание этих сцен во Flash, а также размещение и масштабирование в них
панелей раскадровки, как в сцене 1.

Создание отдельных сцен позволит вам разбить весь фильм на более управ�
ляемые секции. Точно так же делаются и традиционные фильмы, от кадра к
кадру, от сцены – к сцене. Когда начнете тестировать свой фильм, вы можете
захотеть поменять порядок сцен – сгруппировав их по отдельности, мы сдела�
ли эту задачу намного проще. Вообще�то это работа монтажера, которая в «жи�
вых» фильмах выполняется уже после съемки фильма.

Чтобы создать новую сцену, выполните команду меню Insert ➤ Scene (Встав�
ка ➤ Сцена). Теперь Flash создал новую, пустую сцену 2.

Нам нужно поместить сюда изображение из раскадровки для сцены 2. А пос�
кольку все рисунки из раскадровки находятся в библиотеке, нам остается пере�
тащить нужный рисунок на экран и подогнать его по размеру, как в сцене 1. Для
этого откройте библиотеку, выполнив команду Window ➤ Library (Окно ➤
Библиотека).
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Затем выберите в библиотеке изображение второй панели раскадровки,
щелкните по нему и перетащите на рабочее поле, а потом увеличьте сцену до
50 кадров, как предыдущую (рис. 5.24).

Затем на временной шкале сцены 1 выделите первый кадр слоя ТВ�рамки и
скопируйте его: Edit ➤ Copy Frames (Правка ➤ Скопировать кадры) или Ctrl/

+Alt+C (рис. 5.26).
Затем при помощи переключателя сцен вернитесь к сцене 2, вставьте новый

слой, выберите на нем первый кадр и вставьте ТВ�рамку туда (рис. 5.27). (Edit ➤
Paste Frames (Правка ➤ Вставить кадры) или Ctrl/ +Alt+V).

ГЛАВА 5 ▼ Проект 1: создание аниматика Создание сцен

Рис. 5.24

Чтобы вставить сюда рамку ТВ�обреза, вернитесь к сцене 1, для этого перей�
дите к переключателю сцен в нижней правой части временной шкалы, а затем
выберите там сцену 1 (рис. 5.25).

Рис. 5.25

Рис. 5.26 Рис. 5.27

Вы заметите, что Flash переименовал слой и вставил необходимое количество
кадров. Увеличьте изображения до границ ТВ�рамки, как в сцене 1 (рис. 5.28).

Рис. 5.28
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Проделайте те же операции, чтобы вставить все оставшиеся сцены рас�
кадровки. Вот так они выглядят для «Мальчика, который кричал: «Волк!»
(рис. 5.29 и 5.30).

Как и в сцене 1, в сцене 11 действие описывается более чем одной панелью.
Для начала воспользуемся только первой из них (рис. 5.31).

ГЛАВА 5 ▼ Проект 1: создание аниматика Создание сцен

Рис. 5.29

Рис. 5.30

Рис. 5.31

Мы создали все сцены нашего фильма и заложили базовую структуру анима�
тика. Теперь у нас есть сюжетная лента, которую можно проиграть. Пока на нее
еще не очень интересно смотреть, да и анимации в ней нет, зато фундамент
будущего фильма уже готов.

!!! Сохраните сейчас свой FLA;файл и не забывайте сохраняться почаще – иначе по;
жалеете!

Теперь можно начинать процесс редактирования аниматика, и мы восполь�
зуемся панелями раскадровки для постановки движений камеры. Помните, что
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во Flash «камера» ведет себя иначе, чем настоящая камера: она остается непод�
вижной, а меняется картинка.

Создание панорамы
Первая сцена нашего фильма включает в себя панораму, и это неплохое нача�
ло. Как мы уже замечали, панорамирование предполагает простое перемеще�
ние изображения из одной точки в другую перед камерой.

В сцене 11 у нас есть пример другого вида панорамы (технически это «съем�
ка с движения»), которая является вариацией на все ту же основную тему. Фон
проходит через кадр, в то время как и мальчик, и волк остаются в центре экра�
на – но об этом позже!

Мы уже задали начальную позицию для сцены 1, так что следующим шагом
будет назначение конечной позиции. Затем мы скомандуем Flash переместить
рисунок между этими двумя точками.

Прежде чем мы сможем репозиционировать панель раскадровки и передви�
нуть ее из одной точки в другую, нам нужно преобразовать ее в символ, чтобы
программа правильно опознала этот объект и смогла с ним работать.

Преобразование изображений в символы

Нет более важной и широко используемой функции во Flash�анимации, чем
преобразование изображений в символы, и мы еще будем обсуждать ее более
детально в последующих главах.

Существуют три разных типа символов: графические символы, кнопки и
символы�клипы. Мы чаще будем сталкиваться именно с графическими. В осно�
ве своей графический символ является статическим изображением, которое
сохраняется в библиотеке путем преобразования уже существующего рисунка,
как в нашем случае, или создается «с нуля» (рисуется во Flash). Чтобы преобра�
зовать в символ уже имеющийся рисунок, выделите его на рабочем поле или на
временной шкале – в нашем случае это рисунок раскадровки в сцене 1. Затем
выполните Insert ➤ Convert to Symbol (Вставка ➤ Преобразовать в символ)
или нажмите F8.

После этого Flash предложит вам ввести имя символа и выбрать его тип. Мы
назовем наш символ storyboard panel 1 (панель раскадровки 1) и сделаем его
графическим.

Если вы пользуетесь Flash MX, то можете заметить в диалоговом окне панель
выбора точки регистрации; по умолчанию Flash размещает символ в центре
экрана, и для наших целей этого вполне достаточно, так что просто щелкните
по OK (рис. 5.32).

Если же вы используете более раннюю версию Flash, то точка регистрации
всегда будет по умолчанию располагаться в центре – хотя в любой версии вы
сможете это исправить, если понадобится.

Мы преобразовали наш рисунок в графический символ, и он был помещен в
библиотеку. Все готово для создания нашей первой панорамы.

Управление слоями

Однако прежде, чем приступить к построению панорамы, давайте быстро
пройдемся по временной шкале и рассмотрим различные способы управления
слоями. Вы можете заметить, что в левой верхней части временной шкалы рас�
полагаются три разных значка: глаз, замок и квадрат (рис. 5.33).

ГЛАВА 5 ▼ Проект 1: создание аниматика Создание панорамы

Рис. 5.32

Рис. 5.33

Они управляют отображением и редактированием слоев.
Первый значок – глаз – переключатель опции «скрыть/показать все слои»

и, будучи отмеченным, делает слой невидимым на рабочем поле, что также оз�
начает, что слой нельзя будет редактировать. Это очень полезная опция, кото�
рую мы будем детально разбирать в главе об анимации.

Второй значок, замок, блокирует и разблокирует слои – если его выбрать,
слой будет заблокирован, но останется видимым. Это значит, что хотя мы и
сможем видеть слой, но не сможем внести в него никаких изменений или пере�
местить находящееся в нем изображение.

Третий значок, квадрат, переключает режим показа контура слоя и близок к
функции калькирования, к которой мы вернемся в главе об анимации, когда эта
функция действительно нам понадобится.
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Создание данной панорамы предполагает перемещение позиции слоя рас�
кадровки, и если мы заблокируем слой ТВ�рамки, то не сможем случайно пере�
двинуть его при репозиционировании панели раскадровки. Итак, напротив
слоя для ТВ�рамки щелкните по точке под замком – возле имени слоя появится
еще один замок, показывающий, что слой заблокирован и ТВ�рамку теперь
нельзя передвинуть (рис. 5.34).

Нам нужна конечная позиция для панорамы, так что вставим на 100�й кадр
слоя с раскадровкой новый ключевой кадр, как в кадре 50. Итак, на временной
шкале у нас есть и начальная и конечная позиции (рис. 5.36).

ГЛАВА 5 ▼ Проект 1: создание аниматика Создание панорамы

Рис. 5.34

Заметьте, что если щелкнуть по самому замку, то заблокируются сразу все
слои. То же самое относится и к двум другим значкам.

Так как первая сцена является вводным кадром и в первом нашем кадре со�
держится заголовок, нам придется задержаться какое�то время на этом кадре,
прежде чем начать панораму. Как уже говорилось, точную продолжительность
этой сцены мы отрегулируем во время тестирования аниматика. Пока достаточ�
но только настроить механику сцены.

Начало панорамы

Так как первая панель держится в течение 50 кадров, нам нужно вставить еще
50 кадров для панорамы. И снова выбранное нами время совершенно произ�
вольно и является просто неким исходным пунктом.

Поскольку панорама начинается в 50�м кадре, нам нужно на слое раскадров�
ки вставить здесь ключевой кадр, чтобы программа знала, откуда начинать па�
нораму. С ключевыми кадрами соотносятся ключевые пункты в анимации или
любые действия (например, движения камеры).

Вставив ключевой кадр, выберите на слое раскадровки кадр 50 и выполни�
те Insert ➤ Keyframe (Вставка ➤ Ключевой кадр) или нажмите F6 – рис. 5.35.

Flash поместил на временной шкале новый ключевой кадр.
Теперь перейдем к кадру 100, выделим его на обоих слоях и вставим новые

кадры, как мы делали это раньше (Insert ➤ Frame (Вставка ➤ Кадр) или F5).
Общая длина нашей сцены теперь составляет 100 кадров, с ключевым кад�

ром на 50 кадре слоя раскадровки, откуда начнется панорамирование.

Рис. 5.35

Рис. 5.36

Теперь нужно переместить раскадровку в кадре 100, чтобы последняя панель
вошла в кадр. Для этого выберите инструмент Arrow.

Затем щелкните по изображению раскадровки на рабочем поле или выбе�
рите ее на временной шкале. Вокруг изображения должна появиться синяя
рамка.

Щелкнув по изображению и удерживая его, вы сможете переместить его в
любую точку рабочего поля. Расположите последнюю панель так, чтобы она
помещалась в кадр (в этом вам поможет рамка ТВ�обреза).

Удерживая при перемещении клавишу Shift, вы сможете ограничить движе�
ние, что позволит вам добиться горизонтального выравнивания (рис. 5.37).

Теперь у нас есть и начальная и конечная позиции.
Можно переместить изображение по�другому, воспользовавшись клавишами со

стрелками на клавиатуре. Просто выделите рисунок и нажмите клавишу, указыва�
ющую направление, в котором вы хотите переместить изображение. Этим при�
емом можно добиться большей точности, поскольку рисунок будет двигаться стро�
го вдоль той оси, на которую указывает стрелка. Перетаскивать изображения
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с помощью Arrow очень удобно, но им нельзя достичь такой точности, как при
использовании клавиатуры.

Следующий шаг – скомандовать Flash переместить изображение между дву�
мя заданными точками.

Основы анимации движения

Анимация движения – один из краеугольных камней Flash�анимации. В тради�
ционной анимации она известна как «построение промежуточных кадров»
(подробнее мы будем говорить об этом в главе, посвященной принципам ани�
мации), а во Flash это означает простое перемещение объекта из одной точки
в другую.

Как уже упоминалось, эту операцию можно проделать только с изображени�
ями, созданными или преобразованными в символы.

Проиллюстрируем на примере: у нас есть статическое изображение в двух
разных позициях, и нам требуется, чтобы Flash создал промежуточные рисун�
ки между этими двумя точками (рис. 5.38).

Именно это Flash будет делать с нашим рисунком из раскадровки, создавая
промежуточные изображения между двумя ключевыми кадрами.

Чтобы скомандовать Flash создать такую анимацию движения, выберите
панели раскадровки в начальной точке на 50�м ключевом кадре временной

шкалы, а затем выполните Insert ➤ Create Motion Tween (Вставка ➤ Создать
анимацию движения).

Того же результата можно добиться, раскрыв диалоговое окно Property Ins�
pector внизу экрана и, открыв список в поле Tweening (Анимация), выбрать
пункт Motion (Движение) (рис. 5.39).

Рис. 5.37

ГЛАВА 5 ▼ Проект 1: создание аниматика Создание панорамы

Рис. 5.38

Ключевой кадр 1 Промежуточные изображения Ключевой кадр 2

Рис. 5.39

Вы увидите, что Flash вставил на слой раскадровки временной шкалы стрел�
ку между начальной и конечной позицией. Это означает, что были успешно
созданы все промежуточные изображения между этими двумя точками
(рис. 5.40).

Рис. 5.40

Чтобы убедиться в этом, нажмите на красный индикатор кадра сверху вре�
менной шкалы и, не отпуская кнопку мыши, двигайте курсор вдоль сцены. Рас�
кадровка должна перемещаться из одной позиции в другую.
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Первая панорама готова. Сохраните свою работу!
Как уже упоминалось, существует несколько типов панорам. Мы только что

сделали горизонтальную, но и для горизонтальной, и для вертикальной, и диа�
гональной принципы одинаковы. По сути, все они являются движением из од�
ной точки в другую.

Существует, однако, множество вариаций на эти основные темы, связанных
преимущественно со скоростью, которые будут обсуждаться в основной главе
по Flash�анимации.

Создание наезда камеры
Теперь, когда готова панорама и конечная позиция всей сцены является конечной
точкой панели раскадровки, мы сделаем наезд. Камера при этом как бы надвигает�
ся на персонаж, сидящий под деревом. Как уже говорилось, во Flash камера при�
ближаться не будет, а будет разрастаться сама сцена, заполняя наш экран.

Для этого мы проделаем все те же шаги, что и в панораме, но за одним ис�
ключением.

Так как последний кадр панорамы становится первым кадром наезда, нам
остается создать конечную позицию наезда.

Чтобы все было одинаковым, длину наезда мы тоже установим равной
50 кадрам. Так что выделяйте 150�й кадр нашей временной шкалы, затем встав�
ляйте кадры, как в панораме, потом делайте ключевой кадр для конечной точ�
ки наезда в кадре 150. После всего этого ваша временная шкала должна выгля�
деть так, как показано на рис. 5.41.

Сделайте это по аналогии с тем, как мы растягивали и подгоняли размеры
раскадровки, при помощи инструментов Transform и Scale. Возможно, вам
придется слегка подвинуть изображение (воспользуйтесь инструментом Arrow
или клавишами), чтобы оно находилось в центре рамки ТВ�обреза.

Вместе с ТВ�рамкой, совпадающей с конечной позицией наезда на раскад�
ровке, последний кадр должен выглядеть, как показано на рис. 5.43.

ГЛАВА 5 ▼ Проект 1: создание аниматика Создание наезда камеры

Рис. 5.41

В зависимости от размера вашего монитора, вы можете и не видеть всех
кадров временной шкалы одновременно, так что просто прокрутите шкалу до
150�го кадра. Для этого удерживайте курсор на полосе прокрутки, прямо за
счетчиком секунд, и двигайте его вправо. Так вы перейдете на нужную позицию
временной шкалы (рис. 5.42).

Теперь у нас есть начальная и конечная позиции для наезда, причем конеч�
ная находится на 150�м кадре слоя раскадровки. Выделите этот кадр. Следующим
шагом увеличим панель, чтобы в конечной позиции она заполняла весь экран.

Рис. 5.42

Рис. 5.43

Функция интерполяции создает промежуточные изображения не только для
рисунков одинакового размера, но и для отличающихся по размерам. Так что
нам нужно всего лишь приказать Flash создать анимацию движения для нашего
наезда между ключевыми кадрами, как в панораме.
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Выделите ключевой кадр с начальной позицией наезда в кадре 100, затем
выполните Insert ➤ Create Motion Tween (Вставка ➤ Создать анимацию дви�
жения) – и пожалуйста, наш наезд готов. Flash вставил еще одну стрелку между
двумя ключевыми кадрами, показывая, что анимация удалась.

Можете удостовериться в этом тем же способом, что и в случае с панорамой,
то есть перемещая курсор по временной шкале (рис. 5.44).

Создание затемнения

Так как наиболее распространенным типом затемнения является затемнение
до черного экрана, которым мы будем пользоваться в нашем фильме, то с него
и начнем.

Как мы уже упоминали, затемнение является простым постепенным пониже�
нием или повышением значения Alpha�фактора изображения со 100% до 0% или
наоборот, соответственно являясь собственно затемнением или проявлением.

Нам нужно затемнить наше изображение до черного цвета, и поскольку цвет
фона рабочего поля у нас является белым, простое понижение значения Alpha
до 0% даст нам абсолютно белый кадр. Так что лучший способ добиться нужно�
го эффекта – сделать то, что мы называем «черный экран», охватывающий все
пространство рабочего поля, включая и нашу анимацию, а потом повысить его
Alpha�значение с 0 до 100%, сделав черной всю сцену.

!!! Во Flash возникают проблемы с затемнением анимированных изображений, осо;
бенно если у нас разделены слои – так что это неплохой обходной путь.

Первое затемнение в нашем фильме предусмотрено в сцене 5. Для начала
нужно создать новый слой для «черного экрана». Так как этот слой должен

ГЛАВА 5 ▼ Проект 1: создание аниматика Переходы

Рис. 5.44

Как и с панорамой, мы подрегулируем скорость и темп, когда перейдем к
анимации, но в целом первая сцена нашего аниматика готова. Самое время
сохраниться.

Переходы
Мы изучили основы панорам и наездов камеры. Следующая тема – затемнения
и растворения. Как уже говорилось в главе о раскадровке, эти эффекты каме�
ры используются в основном для обозначения прошествия периода времени
или переходов между сценами.

Затемнения и растворения создаются путем повышения или понижения
прозрачности изображения, также известной как Alpha�фактор. Например,
если значение Alpha для изображения равно 100%, то рисунок полностью не�
прозрачен, а если понизить его до 0%, рисунок станет полностью прозрачным.

Поэтому, чтобы рисунок исчез, мы начнем с Alpha = 100%, а затем постепен�
но понизим значение до 0% – изображение медленно исчезнет, а если сделать
наоборот – проявится.

При вытеснении одна из сцен проплывает мимо камеры в сопровождении
вертикальной, горизонтальной или диагональной линии, проходящей через эк�
ран. Существуют и другие формы вытеснений, с которыми вам, дорогой чита�
тель, придется познакомиться самостоятельно. Вообще говоря, вытеснения
(другой тип перехода) – это то, чего стоит избегать во Flash, поскольку с ними
довольно сложно работать. В «живых» фильмах вытеснения давно вышли из
моды, но, похоже, снова обретают былую популярность. Рис. 5.45
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располагаться поверх всех остальных, выделите слой с ТВ�рамкой, затем до�
бавьте поверх него новый слой и назовите его black (рис. 5.45).

Так как затемнение должно начинаться в конце сцены, нам нужно создать
ключевой кадр для «черного экрана» в кадре 50, а затем удлинить сцену, чтобы
она вмещала и затемнение – пока нам хватит для этого 25 кадров (рис. 5.46).

Потом создайте в кадре 75 новый ключевой кадр, чтобы получить начальную
и конечную точки затемнения. Так как «черный экран» у нас должен проявлять�
ся, следующим шагом станет понижение его Alpha�значения в начальной точке
до 0%. Выделите прямоугольник, щелкнув по его символу на рабочем поле, потом
разверните Property Inspector, если нужно, и в раскрывающемся списке возле
надписи Color выберите Alpha (рис. 5.48).

ГЛАВА 5 ▼ Проект 1: создание аниматика Переходы

Рис. 5.46

Чтобы сделать «черный экран», выберите на соответствующем слое кадр 50
и нарисуйте прямоугольник, как мы делали это в случае с ТВ�рамкой, только
теперь вместо того, чтобы сделать область заливки пустой, выберите черный
цвет и нарисуйте прямоугольник, охватывающий все рабочее поле.

Затем преобразуйте это изображение в символ (Insert ➤ Convert to Symbol
(Вставка ➤ Преобразовать в символ) или F8) и назовите его black matte. Если
забудете преобразовать свой черный прямоугольник в символ, анимация не
сработает и у вас не получится создать затемнение (рис. 5.47).

Рис. 5.47

Рис. 5.48

Затем переместите правый бегунок до 0%; вы заметите, что на рабочем поле
по мере перемещения бегунка будет меняться прозрачность изображения, так
что через него станет виден слой раскадровки (рис. 5.49).

Рис. 5.49

Теперь в начальной точке на кадре 50 Alpha = 0%, а в конечной, на кадре 75 –
100%.

Создав анимацию движения между этими двумя ключевыми кадрами, точно
таким же образом, как с панорамой и наездом, Flash создаст промежуточные
состояния, в которых на протяжении 25 кадров постепенно растет значение
Alpha. Убедиться в этом можно, проведя курсор по временной шкале и увидев,
как сцена затемняется до черного экрана.

!!! Так как нам нужно провести точно такое же затемнение в сцене 8, вы можете скопи;
ровать это затемнение и вставить в эту сцену.

Выделите кадры 50–75 на слое черного экрана, а затем выполните Edit ➤
Copy Frames (Правка ➤ Скопировать кадры) или нажмите Ctrl/ +Alt+C.
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Перейдите к сцене 8, вставьте новый слой, расширяющий сцену до 75 кад�
ров, вставьте ключевой кадр на 50�м кадре, а потом вставьте готовое затем�
нение: Edit ➤ Paste Frames (Правка ➤ Вставить кадры) или Ctrl/ +Alt+V.

Затемнение добавлено в сцену 8 (рис. 5.50).

ГЛАВА 5 ▼ Проект 1: создание аниматика Переходы

Рис. 5.50

Создание растворения
При растворении одна из сцен исчезает, а другая проявляется на переднем
плане. Процесс создания растворения во Flash сильно напоминает затемнение,
только вместо сцены, переходящей в черный экран, в этом случае Alpha�значе�
ние сцены будет понижаться до 0% с одновременным повышением его до 100%
в последующей сцене.

Как уже говорилось в примере с затемнением, во Flash с этим эффектом
камеры порой возникают проблемы, которые мы будем обсуждать в главе об
анимации, но так как нам нужно только растворить одно статичное изображе�
ние в другом, об этом не стоит беспокоиться.

На раскадровке видно, что у нас не просто происходит растворение между
сценами 11 и 12, но есть еще и два наезда, и панорама фона.

В данный момент нас не сильно волнует панорама фона в сцене 11, поэтому
о ней до главы об анимации можно забыть. Однако первый отъезд в сцене 11
нужно разобрать сейчас, прежде чем мы начнем работать с нашим растворени�
ем, так что перейдем к сцене 11 и сделаем там отъезд.

Настройка растворения: сперва отъезд
Поскольку первая панель в сцене 11 выглядит так же, как и стартовая позиция
для второй панели, то в нашем аниматике нет нужды использовать обе эти па�
нели, поэтому мы увеличим вторую панель и настроим ее расположение на
рабочем поле, чтобы использовать ее в качестве стартовой точки (рис. 5.51).

Увеличьте сцену до 100 кадров, потом преобразуйте изображение раскадров�
ки в символ, добавьте ключевые кадры в кадрах 50 и 75.

Затем растяните конечную позицию в кадре 75, чтобы она совпадала с зо�
ной ТВ�обреза, и вставьте анимацию движения между этими двумя ключевыми
кадрами, чтобы у нас получился отъезд (рис. 5.52).

Рис. 5.51

Рис. 5.52

Теперь нас ждет хотя и более сложная задача, но все же не настолько страш�
ная, чтобы стать для нас препятствием.
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Совмещение сцен при растворении

Так как между двумя отдельными сценами во Flash растворение произвести
нельзя, нам нужно соединить их.

Сначала перейдем к сцене 12 и скопируем слой с раскадровкой, точно так
же, как мы копировали затемнение из сцены 5 в сцену 8.

Возвращаемся к сцене 11, вставляем новый слой, удлиняем сцену до 150 кад�
ров, делаем новый ключевой кадр в кадре 100 и вставляем кадры из сцены 12 в
новый слой сцены 11 на кадре 100.

Лучше дать слоям имена. Назовем их sc11 и sc12. Теперь ваша временная
шкала должна выглядеть примерно так, как показано на рис. 5.53.

ГЛАВА 5 ▼ Проект 1: создание аниматика Переходы

Рис. 5.53

Увеличьте панель раскадровки для слоя sc12 так, чтобы начальная точка
наезда помещалась в кадре (рис. 5.54).

Рис. 5.54

Как и для любого движения камеры, нам нужно задать начальную и конеч�
ную позиции. Для этого на кадре 100 слоя sc11 создайте начальную точку для
наезда, вставив туда ключевой кадр. Затем создайте на кадре 125 конечную точ�
ку для обоих слоев (рис. 5.55).

Рис. 5.55

Растворение

Растворение предполагает постепенное размытие одного изображения и про�
явление другого. Так как у нас должен пропадать слой sc11, перейдите на этом
слое в конечную позицию на кадре 125 и установите значение Alpha на уровне
0%, как для затемнения.

Далее нужно проявить слой sc12, для чего перейдем в его начальную точку
и снизим Alpha до 0%. Теперь у нас есть начальное и конечное значения.

!!! Чтобы сэкономить на мощности процессора, требующейся для растворения, вы
можете изменять только верхний слой – другой слой под ним скроется естествен;
ным образом, как только верхний станет непрозрачным. Это снизит общий объем
файла, так как Flash не придется теперь так сильно трудиться над этим эффектом.

Затем просто создайте анимацию движений между двумя позициями на каж�
дом слое. И все! Растворение готово. Можете на него полюбоваться, как и в
прошлый раз, проведя курсором по временной шкале.

Другой способ создать анимацию движения – выделить нужный кадр, щелк�
нуть правой кнопкой мыши (или выполнить Ctrl�щелчок для Mac), чтобы выз�
вать контекстное меню, и выбрать в нем пункт Create Motion Tween (Создать
анимацию движения) (рис. 5.56).

!!! Можно создать анимацию движений одновременно на нескольких слоях, выделив
все начальные точки на каждом слое сразу и нажав Create Motion Tween. Это очень
нам поможет, когда мы начнем анимацию.
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Завершение аниматика – затемнение
до черного
Когда растворение готово, все, что остается до полного завершения анимати�
ка, – это добавить финальный отъезд и затемнение до черного экрана.

Сначала удлиним сцену 11 на 50 кадров, чтобы всего она составляла 200 кад�
ров.

Затем перейдем к кадру 200 и вставим конечную позицию для отъезда в сце�
не 12. Настройте размер панели раскадровки и создайте анимацию движений,
чтобы закончить финальный отъезд.

Мы сделали отъезд длиннее, поскольку это финальная сцена всего фильма и
к тому же нам нужно еще встроить поверх отъезда затемнение (рис. 5.57).

Наконец, добавьте затемнение до черного, вставив новый слой, ключевой
кадр на кадре 150 и скопировав кадры из сцены 5 или 8, затем вставьте их на
слой sc11 по аналогии с прошлым разом.

Вы увидите, что Flash добавит дополнительные кадры к концу сцены после
отметки «200» в новом слое; можете удалить их, выделив и выполнив Insert ➤
Remove Frames (Вставка ➤ Удалить кадры) или нажав Shift+F5.

Конечный кадр вашей временной шкалы должен выглядеть, как на рис. 5.58.
Так как мы совместили сцены 11 и 12 (как слои sc11 и sc12), нам теперь нуж�

но удалить сцену 12 из фильма. Для этого перейдите к сцене 12, а затем выпол�
ните Insert ➤ Remove Scene (Вставка ➤ Удалить сцену).

Рис. 5.56

ГЛАВА 5 ▼ Проект 1: создание аниматика Завершение аниматика – затемнение до черного

Рис. 5.57

Рис. 5.58
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169168 ГЛАВА 5 ▼ Проект 1: создание аниматика Что касается вас

Программа спросит вас, хотите ли вы полностью удалить сцену 12 (Perma�
nently delete “Scene 12”?). Нажмите OK (рис. 5.59).

Рис. 5.59

Полюбуйтесь
Все сцены на месте, все движения камер установлены – наш первый вариант
аниматика готов. Можете посмотреть его (для этого выполните Control ➤ Test
Movie (Управление ➤ Протестировать фильм) или нажмите Ctrl/ +Enter).

!!! В следующей главе мы импортируем и вставим звук – в нашем случае это диалог –
и отрегулируем темп нашего аниматика.

Что касается вас
Теперь вам нужно взять раскадровку, которую вы приготовили для своего про�

екта, и импортировать ее во Flash, чтобы получить
аниматик. Это даст вам возможность «почувство�
вать» свой фильм и начать думать о его темпе.

Сначала установите свойства фильма: часто�
ту кадров и формат кадра.

Подумайте, предназначается ли ваш фильм ис�
ключительно для Интернета или он будет показан и

на видео тоже – в таком случае вам
придется учесть зону ТВ�обреза.

Импортируйте свою раскад�
ровку во Flash, настройте масштаб
панелей и затем добавьте или уда�
лите кадры, если это необходимо

для регулирования длительности ва�
шего фильма.

Затем вам нужно создать отдельные сцены в своем фильме и импортировать
соответствующие панели в каждую из них. На этом этапе уже можно начать уп�
равлять изображениями во Flash, преобразуя их в символы и добавляя базовые
анимации.

Начните добавлять главные движения камеры: панорамы, наезды и затем�
нения.

Просмотрите для примера файл animatic all scenes.fla (который можно ска�
чать на сайте «friends of ED»). Вы должны увидеть, что ваш фильм стал вырисо�
вываться, но все веселье только начинается – сейчас мы обратим свое внима�
ние на то, как импортировать звук.
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Проект 2: звук

и тестирование6Глава

Звук стал неотъемлемой частью любого фильма с того момента, как кино
из «немого» превратилось в «говорящее». Особенно важную роль игра�
ют диалоги. Они раскрывают характер персонажей и развивают сюжет.

Сейчас у вас есть самый основной Flash�аниматик. В этой главе мы импортиру�
ем и вставим звуковые эффекты и диалоги и с их помощью еще немного отре�
гулируем темп нашего фильма.

Говорят, что публика может простить и зернистый фон, и слабую визуализа�
цию фильма, но плохой звук наверняка оттолкнет ее почти сразу. Это верно –
до определенной степени. В нашем мире, мире домашних ПК и двадцатидолла�
ровых конденсаторных микрофонов, практическая необходимость диктует
нам уровень, на который можно рассчитывать. При этом надо сказать, что
приличное качество звука вполне достижимо.

Запись и импортирование звука
Теперь мы рассмотрим запись, импортирование и размещение диалогов в со�
ответствующих сценах нашего фильма. Позаботившись об этом на ранней ста�
дии, мы сможем лучше «почувствовать» темп фильма, когда начнем тестиро�
вать аниматик, а также облегчим себе регулирование длительности ролика еще
до начала работы с анимацией.

Существует множество различных звуковых программ для записи голоса,
и выбор целиком будет зависеть от вас. На наш взгляд, хорошей программой

является Cool Edit 2000, триал�версия которой доступна в сети (на сайте
www.syntrillium.com/download). В Cool Edit 2000 есть все необходимые инст�
рументы, но вы можете обнаружить, что и в вашей системе уже установлен
базовый пакет для записи и обработки звука.

Типы файлов и качество

Flash позволяет импортировать множество различных звуковых файлов, в том
числе WAV, AIFF и MP3, которые наиболее распространены. Выбор в основном
определяется типом компьютера: для пользователей PC – WAV�файлы, а для
тех, у кого Mac, – AIFF.

Следующий пункт – качество звука. Хотя звуки более высокого качества,
очевидно, будут звучать лучше, они могут сильно увеличить размеры вашего
фильма и повлиять на его воспроизведение в Интернете.

!!! Flash дает возможность задать различные звуковые параметры при публикации
фильма, так что лучше всегда импортировать звуки на самом высоком уровне каче;
ства, а затем понижать параметры качества при публикации. Но если звук был им;
портирован на низком уровне качества, то уже неважно, какие выходные парамет;
ры вы выберете, – лучше он не станет.

Лучше всех – звуки, записанные на уровне качества CD (44 КГц и 16 бит).
Однако если записывать диалоги самому, то итоговое качество будет зависеть
от используемого вами оборудования – микрофона, звуковой карты и даже по�
мещения, где проходит запись: все повлияет на качество звука. Эксперимент –
вот лучший (и самый забавный) способ получить звук, который вас устроит, так
что этот процесс мы целиком оставляем вам.

Разумеется, если вы производите профессиональный продукт, то и свои за�
писи вам нужно делать в профессиональной звуковой студии. Но для большин�
ства мультфильмов, созданных «под Интернет», методом проб и ошибок мож�
но довольно быстро получить записи приемлемого качества, подходящие под
стандарты большинства домашних компьютеров.

Редактирование

После того как вы запишете звук, вам придется подстраивать звуковые файлы
под отдельные линии диалогов. Диалог проще записывать как непрерывную
последовательность, но когда дело доходит до анимации, особенно если у нас
есть несколько сюжетных линий, разворачивающихся в разных сценах, проще
всего будет разбить диалоги на отдельные небольшие файлы. В принципе, это
можно проделать и во Flash, но практика показала, что лучше разобраться с
этой задачей еще до импортирования файлов.
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Конечно, существует множество вещей, которые можно проделать со зву�
ком, когда он уже помещен в компьютер, так же как существует множество спо�
собов получить требуемый для вашего мультика шум или эффект. Все в ваших
руках. Мы можем только посоветовать вам сохранять каждую линию диалога
или звуковой эффект под названием, которое для вас точно передает его
смысл. В отличие от картинок, здесь нет быстрого предпросмотра, и вы еще
успеете проклясть все на свете, если вам придется прослушивать все файлы в
поисках конкретного диалога или эффекта.

Импортирование

Когда все ваши диалоги будут записаны и сохранены под соответствующими
именами, придет время импортировать их во Flash. Так как наш первый диалог
появляется в сцене 2, мы начнем с нее.

Если у вас сейчас нет времени записывать собственные файлы, то все звуки,
которые используются в «Мальчике, который кричал: «Волк!», доступны для
скачивания на сайте www.friensofED.com.

Перейдите в меню File ➤ Import (Файл ➤ Импортировать), как мы делали
это при импортировании изображений раскадровки, и появится диалоговое
окно импортирования.

В зависимости от типа файлов, которые вы собираетесь импортировать,
некоторые из них могут не отображаться в этом окне. В таком случае в поле
Files of type (Файлы типа) выберите All Files (*.*) (Все файлы (*.*)).

Проще всего импортировать все звуковые файлы сразу. Для этого нужно
выделить первый из них и, удерживая Shift, выделить все остальные. Щелкни�
те по Open (Открыть). Теперь Flash поместит все ваши звуковые файлы в биб�
лиотеку (рис. 6.1).

Прежде чем мы сможем вставить звуки в сцену, нам нужно создать для них
слой. Создайте новый слой в сцене под слоем раскадровки и назовите его dia�
logue.

На нашем слое с диалогом нужно создать ключевой кадр там, где должен
начинаться диалог. В данный момент это не очень важно, так как мы все равно
будем вносить изменения на следующем этапе.

На 5�м кадре сцены вставьте новый ключевой кадр и убедитесь, что он выде�
лен. Затем в библиотеке выберите нужную линию диалога – в нашем случае это
«wolf 01» (рис. 6.2).

Запись и импортирование звука

Рис. 6.1

Рис. 6.2

Удерживая левую кнопку мыши нажатой, перетащите файл на рабочее поле.
Flash разместит звук на временной шкале, начиная с пятого кадра. Графически
это выразится появлением изображения звуковой волны на временной шкале
(рис. 6.3).
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Итак, в аниматик добавлена первая линия диалога.

Воспроизведение звука во Flash
Прежде чем двигаться дальше, давайте рассмотрим, каким образом Flash про�
игрывает звуки. Flash предлагает две опции для воспроизведения звуков: собы�
тийный звук и потоковый звук. Главное различие между ними состоит в услови�
ях запуска, но существует еще ряд дополнительных факторов, которые могут
повлиять на ваш выбор в пользу того или другого метода.

Событийные звуки

При выборе этой опции Flash, по сути, проигрывает звук так же, как символ.
Он загружает одну версию звука и использует ее повторно каждый раз, когда
звук нужно воспроизвести. Такая опция подходит для звуковых эффектов и
звуков, которые вы намереваетесь использовать многократно.

Однако с этим типом звуков возникают определенные проблемы, посколь�
ку они не всегда синхронизируются (то есть правильно или параллельно вос�
производятся) с анимацией. Хотя Flash запустит звук точно с указанной точки
временной шкалы, он не всегда будет совпадать с анимацией, особенно если
фильм проигрывается на более медленных компьютерах. Это происходит по�
тому, что Flash воспроизводит звук и анимацию независимо друг от друга. Еще
до начала проигрывания он загружает звуковой файл целиком, и при воспро�
изведении звук не синхронизируется с временной шкалой, за исключением на�
чальной позиции. Поэтому если Flash загружает и воспроизводит анимацию
кадр за кадром, а скорость при этом падает (потому что компьютеру требуется
больше времени на загрузку кадров, чем на их воспроизведение), синхрон�
ность звука с анимацией будет неизбежно нарушаться. Эта проблема наиболее
остро встает в диалоге, когда нам нужно, чтобы звук точно совпадал с движе�
ниями губ.

Другая проблема, связанная с применением событийных звуков во Flash,
состоит в том, что программе необходимо полностью загрузить звук перед вос�
произведением. Это повлияет на плавность проигрывания вашей анимации
(загрузку и просмотр через Интернет), так как Flash придется дождаться пол�
ной загрузки звука, прежде чем продолжить анимацию. Поэтому в качестве
событийных звуков лучше использовать только короткие звуки небольшого
файлового объема.

Еще один нюанс использования событийных звуков в анимации: эти звуки
будут слышны только при тестировании и публикации фильма, что особенно
важно при анимации диалогов, т.к. вы не услышите звук во время работы над
фильмом.

В главе об анимации мы еще поговорим об использовании событийных зву�
ков (и о том, как избежать проблем с ними).

Потоковые звуки

Когда вы выбираете эту опцию, Flash, по сути, разбивает звук на кадры и под�
гружает их по одному синхронно с анимацией, а это означает, что такие звуки
прямо привязаны к временной шкале в каждом кадре.

Однако, поскольку Flash приходится загружать звук только по одному кадру, это
тоже может вызвать проблемы. Если анимация начинает замедляться (особенно
на старых компьютерах или при медленном соединении с Интернетом), програм�
ма или остановит анимацию, пока остальная часть звука не загрузится, или будет
пропускать кадры анимации, чтобы не нарушить воспроизведение звука.

Существуют способы избежать подобных проблем, о них мы поговорим в
главе о публикации.

!!! Проблемы с потоковыми звуками возникают и при использовании стереодорожек.
Когда Flash публикует потоковый звук, он смешивает все стереодорожки в один
моноканал. Так что если вам нужно стереозвучание, придется его проигрывать во
Flash как событийный звук.

Еще одна особенность, которую не стоит упускать из вида: так как Flash не
держит их копию в компьютерной памяти, программа будет заново полностью
подгружать звук, если он используется более одного раза. И если звуки исполь�
зуются повторно, то общий файловый объем фильма увеличится.

В целом вам придется поэкспериментировать с этими двумя опциями вос�
произведения звука в фильме на этапе анимации, чтобы выбрать подходящий
вариант для каждого из своих звуков. Однако для анимации диалогов мы будем
использовать потоковый звук.

ГЛАВА 6 ▼ Проект 2: звук и тестирование Воспроизведение звука во Flash

Рис. 6.3
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Установка звука в аниматике

Чтобы установить звук как потоковый, выделите звук на временной шкале,
разверните Инспектор свойств и выберите Sync ➤ Stream (Синхронизация ➤
Потоковый) (рис. 6.4).

Как только вы справитесь с этой задачей, наш аниматик будет готов к пер�
вому тестовому «прогону» звука. Вы и так должны были периодически сохра�
нять свою работу, но сейчас особенно важный момент. Если впоследствии вы
вдруг решите, что совершили какую�то ужасную ошибку, то всегда можно будет
вернуться к данной версии.

Тестирование фильма
Одним из самых больших преимуществ анимации во Flash является то, что
уже на очень ранней стадии у вас появляется фильм, который можно посмот�
реть. Такой способ построения фильма очень эффективен, особенно если вам
приходится считаться с определенным периодом времени, отпущенным на
ролик. Вы можете зафиксировать общую длительность фильма и варьировать
его темп и скорость, чтобы ключевые сюжетные повороты оставались ясны.
Убедитесь, что любое действие максимально сжато и выразительно, а драма�
тическим и комедийным эпизодам хватает времени на то, чтобы внести свой
вклад в кульминацию и развязку. Всего этого можно достичь еще до заверше�
ния анимации.

В традиционной 2D�анимации эта стадия называется отливкой. Она прохо�
дит при помощи секундомера, когда кто�то определяет длину сцен, распреде�
ляя во времени воображаемые действия. Это значительно менее эффективно
и просто, чем наш подход.

Еще раз быстро посмотрим, чего мы успели добиться на данный момент. Наш
аниматик уже должен содержать все сцены, расположенные внутри ТВ�рамки в
правильном порядке. Все основные движения камеры на месте, все диалоги рас�
пределены по сценам.

В процессе создания проекта мы выполняли все операции, не особо забо�
тясь о распределении времени в фильме. Так что при первом просмотре наш
аниматик может показаться местами чересчур затянутым, к тому же не даст нам
настоящего представления о конечной точке в фильме. Чем он будет, так это
очень упрощенным фундаментом нашего фильма, который мы теперь можем
регулировать и править.

Так посмотрим же! Чтобы протестировать фильм, перейди�
те к Control ➤ Test Movie (Управление ➤ Проверить фильм).

После того как вы нажмете Test Movie (Проверить фильм),
Flash загрузит фильм в новое окно и начнет проигрывать. Удоб�
нее свернуть это окно, щелкнув по значку в правом верхнем
углу (рис. 6.6).

ГЛАВА 6 ▼ Проект 2: звук и тестирование Тестирование фильма

Рис. 6.4

Flash должен был поменять звук на потоковый. Проверить это можно, если
провести курсором по временной шкале – звук должен быть слышен.

Теперь нам нужно поместить оставшиеся диалоги во все остальные сцены
точно так же, как мы это делали в сцене 2, начиная с пятого кадра каждой сце�
ны. Выбирайте сцены по очереди, вставляйте в них слой dialogue, создавайте
ключевые кадры в кадре 5, и перетаскивайте нужный звуковой файл на времен�
ную шкалу.

К счастью, мы сохранили каждую линию диалога под именем, очень похожим
на текст на наших панелях раскадровки, так что с этим проблем быть не должно.

В сцене 11 у нас два звуковых файла. Один из них – где мальчик говорит
«О нет!», а другой – где он кричит, так что нам нужно задать им разные пара�
метры. Сначала создайте новый слой, переименуйте его в dialogue, вставьте в
пятый кадр ключевой кадр и добавьте файл oh no.

Что касается крика, то мы пока вставим его в начало отъезда камеры. Вы може�
те вставить на кадр 50 того же слоя новый ключевой кадр и поместить крик туда,
а можете сделать новый слой – dialogue 2 и вставить крик туда на 50�й кадр.

Если обойтись одним слоем, то ваша временная шкала в этой сцене будет
выглядеть, как на рис. 6.5.

Рис. 6.5 Рис. 6.6
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Ваше окно тестирования фильма должно теперь выглядеть, как на рис. 6.7,
и точно помещаться в кадр.

Проверка сцен на распределение по времени

Давайте просмотрим все сцены «Мальчика, который кричал: «Волк!» и подкор�
ректируем их. Точно так же, как мы проверяли весь фильм, можно протестиро�
вать и каждую сцену в отдельности.

Выберите Control ➤ Test Scene (Управление ➤ Протестировать сцену). Те�
перь Flash загрузит и воспроизведет аналогично фильму только ту сцену, в ко�
торой мы находимся.

Сцена 1

Поскольку это у нас вводная сцена, она не должна проноситься в одну секунду.
Надо дать зрителю время прочесть титры и проникнуться образами, которые
предстанут перед ним. Не забывайте, мы создаем атмосферу и настроение на�
шей аудитории.

Вообще эта сцена сейчас может показаться слишком быстрой, особенно
панорама. Так что для начала замедлим ее. Для этого нужно всего лишь подкор�
ректировать длину сцены.

Мы добавим к панораме еще 25 кадров (рис. 6.9). Выделите все кадры в сце�
не, начиная с конца панорамы (кадр 100).

ГЛАВА 6 ▼ Проект 2: звук и тестирование Тестирование фильма

Рис. 6.7

Вы можете управлять фильмом при помощи кнопок, подобных видеомагни�
тофонным, которые расположены в окне Controller (Контроллер). Откройте
его через Window ➤ Toolbars ➤ Controller (Окно ➤ Панели инструментов ➤
Контроллер) (рис. 6.8).

Рис. 6.8

Этим же способом можно посмотреть фильм во Flash, не прибегая к функ�
ции тестирования. Как и все окна в интерфейсе Flash MX, оно может быть сво�
бодно плавающим или прикрепленным к одной из фиксированных панелей –
мы часто прикрепляем его сверху временной шкалы, но вы можете сами ре�
шить, где вам будет удобнее.

Как вы можете убедиться, наш аниматик уже смонтирован и воспроизводит
в нужном порядке все сцены, основные движения камеры и диалоги. Он послу�
жит и фундаментом для нашего фильма, и базовым проектом, на котором мы
сможем разместить всю анимацию.

Рис. 6.9

Удерживая выделение, перетащите кадры в кадр 125. Это удлинит панораму
и всю сцену на 25 кадров (рис. 6.10).

Рис. 6.10

w
w

w
.k

od
ge

s.
ru

http://www.kodges.ru/


181180

Теперь можете проверить внесенные изменения, снова протестировав сце�
ну. Мы еще подправим ее, когда перейдем к анимации.

Сцена 2

От сцены 1 мы сразу переходим к сцене 2, этот прием называется быстрым
переходом (в противоположность растворению, затемнению и т.п.). Начальная
позиция сцены 2 должна точно совпадать с конечной позицией сцены 1 – это
называется присоединением – но так как мы не делали такую панель на раскад�
ровке, то можно просто оставить паузу в пять кадров, прежде чем начнется
диалог. Пока вместо присоединения хватит и этого. Мы разберемся с ним на
стадии анимации.

А вот что нам действительно нужно сделать, так это урезать сцену по длине
диалога. Для этого выделите все кадры с конца сцены до кадра 25 (рис. 6.11).

Для этого выделите в кадре 5 первый кадр звука на слое dialogue и перета�
щите его в кадр 1. Затем выделите ненужные кадры на всех слоях и удалите их
(рис. 6.13).

ГЛАВА 6 ▼ Проект 2: звук и тестирование Тестирование фильма

Рис. 6.11

Затем удалите их при помощи Insert ➤ Remove Frames (Вставка ➤ Удалить
кадры) или Shift+F5, чтобы временная шкала данной сцены приобрела вид, как
на рис. 6.12.

Рис. 6.12

Сцена 3

Нам нужно, чтобы эта сцена с паникующими крестьянами начиналась очень
быстро, а заканчивалась тоже вместе с речью, так что передвинем диалог в
самое начало сцены, а оставшиеся кадры удалим.

Рис. 6.13

Мы решили удалить все кадры после 39�го, приведя временную шкалу к виду,
показанному на рис. 6.14.

Рис. 6.14

Сцена 4

Эта сцена после фразы мальчика длится слишком долго, так что нужно обре�
зать и ее. Нам ведь нужно, чтобы фильм двигался, так что следует избегать
«мертвого времени», когда на экране ничего не происходит и сюжет не разви�
вается (рис. 6.15).

Рис. 6.15
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Так что выделяйте на всех слоях кадры после 25�го и смело удаляйте их
(рис. 6.16).

Сцена 6

И снова укорачиваем сцену в соответствии с диалогом, отрезая все после 24�го
кадра (рис. 6.19).

Рис. 6.16

Сцена 5

Эта сцена также слишком длинная – по тем же причинам. Мы укоротим ее, а
заодно укоротим и затемнение – все для того же темпа и «восприятия».

!!! Как и во многих других областях кино, здесь нет жестких правил и большое значе;
ние будут иметь личные предпочтения… потому;то оно и называется искусством!

Чтобы сократить сцену, мы начнем затемнение раньше, поэтому выделите
ключевой кадр в кадре 50 слоя с черным экраном и перетащите его назад по
слою, чтобы его начало совпало с концом диалога. Мы решили остановиться
на кадре 27 (рис. 6.17).

Рис. 6.17

Рис. 6.18

Рис. 6.19

Затем нам нужно удалить все, что остается после предполагаемого конца
сцены, который у нас находится в кадре 41, – так что выделяем на всех слоях
кадры после 42�го и нажимаем Shift+F5 (рис. 6.18).
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Сцена 7

Нам нужно обрезать немножко кадров после окончания диалога, но на этот раз
обрыв сцены сразу после речи покажется слишком резким и будет чересчур
торопить фильм. Оставим несколько пустых кадров и обрежем все после кадра
19 (рис. 6.20).

Рис. 6.20

Сцена 8

Точно так же мы уплотняем и сокращаем здесь и затемнение, и пустое время
после окончания фразы (рис. 6.21).

Рис. 6.21

Выберите первый кадр анимации затемнения и перетащите его назад, на
кадр 20. Теперь мы можем свободно сократить всю сцену, удаляя кадры после
35�го (рис. 6.22).

Рис. 6.22

Сцена 9

Мы подбираем темп/длину сцены, которые бы отражали происходящее на эк�
ране: мальчика, тревожно вопящего «Волк!». Удалив «немые» кадры, мы уско�
ряем фильм и нагнетаем ощущение тревоги (рис. 6.23).

Рис. 6.23
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Сцена 10

Так как крестьяне отвечают раздраженно, мы сохраняем темп, укорачивая сце�
ну так, что последним у нас становится кадр 27 (рис. 6.24).

ГЛАВА 6 ▼ Проект 2: звук и тестирование Тестирование фильма

Рис. 6.24

Сцена 11

Все предыдущие сцены мы только укорачивали, делая фильм более быстрым и
динамичным. Мы проделаем почти то же самое и с этой сценой, однако на это
раз нам придется потрудиться, поскольку здесь совмещаются две сцены. Слой
sc11 начинается с неприятностей у мальчика, затем камера отъезжает, чтобы
показать волка. Нужно ускорить это действие, чтобы придать ему больший
эффект.

Первую линию диалога перенесите на кадр 3, чтобы она началась быстрее:
выделите начальный кадр и тащите его назад.

Рис. 6.25

Затем, начиная с 50�го кадра (начало отъезда), выделите все кадры до конца
сцены и перетащите их назад, к конечной точке первой линии диалога, как в
сцене 1 (рис. 6.25).

Теперь сократите длину отъезда. Выделите его последний ключевой кадр (40�й
на слое sc11) и, удерживая кнопку мыши, перенесите его на кадр 25 (рис. 6.26).

Рис. 6.26

Далее остаток сцены нужно передвинуть к началу растворения, к 43�му кад�
ру, так мы сократим sc11. Для этого выделим все кадры от 65�го на всех слоях,
кроме диалогового, и перетащим их назад, в кадр 43, при этом данная часть
временной шкалы должна выглядеть, как на рис. 6.27.

Рис. 6.27

Вторая часть сцены 11 на самом деле является другой сценой – sc12. Мы
сделаем чуть динамичнее и ее, уменьшив длину отъезда и затемнения. Для это�
го выделите последние кадры на каждом слое и подправьте их так, чтобы дли�
на каждого движения камеры стала меньше (рис. 6.28).

Рис. 6.28
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Затем удалите все кадры в конце сцены, начиная с кадра 116. Итоговый ва�
риант временной шкалы см. на рис. 6.29.

ГЛАВА 6 ▼ Проект 2: звук и тестирование Что касается вас

Рис. 6.29

Можно показать фильм человеку, мнению которого вы доверяете. Удиви�
тельно, какие вещи мы иногда можем пропустить. Погрузившись в проект глу�
боко, вы можете не увидеть за деревьями леса. Так что свежий взгляд тут про�
сто бесценен!

На данный момент у нас готова базовая структура фильма; за ней последует
анимация. Ваш фильм начал вырабатывать собственный характер и жить по
своим законам. Следующий шаг – нарастить на этой структуре Flash�мультика
плоть, вставив и анимировав персонажей.

Теперь, глядя на фильм, мы можем увидеть, что он стал намного интерес�
нее. Даже на столь раннем этапе мы уже ощущаем, как будет выглядеть готовый
фильм и как сцены сочетаются друг с другом. Также мы можем рассчитать дли�
ну всего фильма и прикинуть, нужно ли его еще подгонять под наши требова�
ния.

Что касается вас
Итак, вы уже должны были переделать свою раскадровку в базовый аниматик.
Это первая версия того, что потом станет готовым фильмом. Пришло время
добавить в него звук и распределить время.

Запишите для своего фильма звук; если у вас нет
нужных программ, можете скачать их триал�вер�

сии из Интернета.
Разбейте звуковой файл на несколько от�

дельных файлов и назовите их так, чтобы из
имен было понятно, какой звук в них содер�
жится. Это упростит поиск нужного звука.

Импортируйте свои звуковые файлы во
Flash и определитесь, должны ли они быть со�
бытийными или потоковыми звуками.

Протестируйте фильм, чтобы проверить
распределение времени в нем.

Смотрите свой фильм как можно чаще. Чем больше
будете смотреть, тем больше углядите в нем незаметных
с первого взгляда ошибок.
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Итак, вы уже сумели сделать собственный аниматик и готовы погрузить
ся в процесс оживления анимации. Именно на этой стадии множество
хороших фильмов было погублено неумелой анимацией. Так что в дан�

ной главе вы получите «курс выживания» по принципам традиционной анима�
ции, чтобы впоследствии перенести эти приемы во Flash в следующей главе.
Эта глава по большей части дает теоретические сведения, но она крайне важна
для овладения методами традиционной анимации, которые являются истока�
ми тех приемов, которые используются во Flash.

Вам не нужно быть величайшим аниматором в мире, чтобы сделать интерес�
ный Flash�фильм. Зато вам нужно иметь твердое понимание базовых принци�
пов анимации. Плохие рисунки и анимация оттолкнут зрителя, как плохая игра
в обычном фильме. Если ваша идея стоит того, чтобы воплотить ее в фильм,
она стоит и того, чтобы это было сделано правильно.

Чтобы ваша анимация получилась по возможности наиболее профессио�
нально, мы изучим происхождение множества современных техник для полу�
чения представления о распределении времени в сценах, придании реализма
персонажам при помощи дуг и для обучения работе со временем.

Ограниченная анимация
Всю анимацию можно разделить на две особые категории: ограниченная и пол�
ная анимация. Полная обычно подразумевает перерисовку всего персонажа в

течение сцены и делает акцент на реализм. Этот стиль анимации наилучшим
образом, пожалуй, представлен в фильмах Уолта Диснея. Реалистичность и
внимание к деталям в таких фильмах впечатляет, но все же этот стиль требует
много времени и больших затрат.

В ограниченной анимации наибольших успехов добилась старая классичес�
кая школа Ханна Барбера (Hanna Barbera). Суть метода заключается в исполь�
зовании лишь необходимого минимума рисунков для передачи сюжета. Вместо
того чтобы перерисовывать героя заново в каждой сцене, его разделяют на
отдельные элементы – голову, рот, глаза – так что перерисовывать нужно толь�
ко необходимые элементы. Если персонаж говорит, мы можем отдельно пере�
рисовать губы и оставить все остальное неподвижным. Такой прием экономит
время и трудовые затраты, и это лишь один из обходных путей, применяемых
в ограниченной анимации, чтобы выразить суть наиболее лаконично.

Как вы можете убедиться, с учетом постоянной необходимости придержи�
ваться небольшого размера Flash�файлов (если вы планируете распространять
фильм через Интернет) и возможности использовать символы и анимацию,
Flash просто идеально подходит для ограниченной анимации – и именно на
этом стиле мы и сосредоточим наше внимание.

Изначально изобретенная телевизионными аниматорами в целях экономии
усилий и денег, ограниченная анимация в наши дни переживает ренессанс, кото�
рым обязана и популярности ретро�ностальгии по семидесятым, и возникнове�
нию Flash. Но не подумайте, что ограниченная анимация означает более низкое
качество фильма, – это значит, что вам нужно овладеть всеми профессиональны�
ми секретами, чтобы суметь успешно рассказать свою историю.

Ключевые позы
Аниматор редко прорисовывает каждую часть сцены. Вместо этого он выпол�
няет лишь основные рисунки, отражающие этапы действия. Они называются
ключевыми рисунками, или ключами. Эта техника получила название «от позы – к
позе», и применять ее можно в любой анимации – и в размашистом физичес�
ком действии, и в едва уловимой мимике.

Картинка  на рис. 7.1 иллюстрирует встающий персонаж. Мы разбили все
действие на три главных ключа. Начальная позиция изображает персонаж,
сидящий на стуле. На второй персонаж начинает вставать. Конечная позиция
изображает его стоящим.

Обратите внимание, что даже в таком простом примере этапы действия на
трех рисунках могут отличаться от тех, которые вы изначально представляли

Принципы

анимации7Глава
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себе для встающей фигуры. Возможно, вам казалось, что персонаж должен
вставать так, как изображено на рис. 7.2.

Хотя такой пример кажется вполне разумным на бумаге, при съемке он бу�
дет выглядеть плоским и невесомым. Попробуйте�ка встать таким образом –
может, вам это и удастся, но это точно не тот способ, которым пользуются нор�
мальные люди. Чтобы создать убедительную анимацию, важно всегда помнить
о законах физического мира.

Персонажи реального мира двигаются органично, очень редко двигая ко�
нечностями по прямой. В анимации существуют дуги, которые придают ей бо�
лее убедительный и натуралистичный вид. Дуги подходят и для свободной, и
для тонкой анимации (рис. 7.3).

!!! Во Flash создать дугу очень просто – достаточно отметить, где находится точка вра;
щения конечности, которую вы нарисовали, и затем использовать эту точку как
центр. Вращательная анимация при этом становится намного проще.

Те же правила действуют и для мимики, и для менее выраженных движений.
В нашем случае три ключевых рисунка описывают поворот головы. Вы можете
поэкспериментировать со степенью тонкости движений. Она может зависеть
от происходящего в сцене или от того, на что реагирует персонаж. Даже в та�
ком простом примере видна дуга движения (рис. 7.4).

ГЛАВА 7 ▼ Принципы анимации X�листы

Рис. 7.1 Рис. 7.2

Рис. 7.3

Анимация между этими двумя ключами
движется по дуге

Рис. 7.4

Ключевые рисунки – это краеугольные камни анимации в любой сцене. Ка�
кой станет наша анимация, в большой степени зависит от того, насколько мы
готовы ее оттачивать. В художественной анимации это самое начало. В ограни�
ченной анимации мы свяжем эти основные ключи наиболее простым из воз�
можных способов, пытаясь получить в итоге позу, которой будем придержи�
ваться и, возможно, разбивать на отдельные элементы. Помните про этот
подход, создавая анимацию во Flash.

!!! Старайтесь применять в своей анимации дуги, поскольку от этого она будет выгля;
деть более плавно и естественно. Если в чем;то сомневаетесь, проделайте это дви;
жение сами. В студиях традиционной анимации часто сами аниматоры снимают
«живое» действие, чтобы лучше понять какое;то движение.

X�листы
Демонстрационные, или X�листы (также известные как «хронометражные»,
или «предварительные», листы), служат в традиционной анимации визуальным
выражением времени. Именно посредством этих листов режиссер, аниматор,
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технический директор и разрисовщик доносят свои идеи до оператора. Во
Flash у нас есть преимущество – временная шкала, которая дает возможность
увидеть распределение нашей анимации по времени и ее протекание, что не�
вероятно полезно для тонкой регулировки, однако X�листы являются прекрас�
ным способом проанализировать анимацию на бумаге, не ограничиваясь воз�
можностями инструментов, доступных на компьютере.

X�листы остаются одним из лучших способов проследить за художествен�
ным оформлением на покадровом уровне. В небольших проектах для этого за�
мечательно подойдет временная шкала Flash, но если вы собираетесь создать
что�то сложное, тогда вам необходимо хорошо разбираться в X�листах.

Фильм пробегает перед камерой со скоростью 24 кадра в секунду. Так что в
традиционной анимации у нас есть 24 кадра, в которых можно разместить ри�
сунки. Большая часть анимации, даже в художественных фильмах, рисуется с
использованием дублей. Это значит, что каждый рисунок располагается в двух
кадрах, то есть всего получается 12 рисунков в секунду.

Анимация одиночных кадров используется, когда требуется передать быст�
рое движение или если есть вероятность, что изображение будет стробировать�
ся, например, при движении камеры. К одиночным кадрам можно прибегать
по необходимости и в других ситуациях.

X�листы разбиты на горизонтальные и вертикальные кадры (рис. 7.5).

включать в себя как очень общие суждения, так и конкретные временные ука�
зания. Часто эта область остается абсолютно пустой.

Затем идут номера кадров. Заметьте, что кадры разделены на 16 блоков – это на�
следие традиционных студий, выражающее действительный шаг кадров на пленке.

Следующая колонка названа DIAL (сокращенно от «диалог»). Здесь в фоне�
тической форме записываются все диалоги и размещаются звуки – на тех кад�
рах, где они должны вступать в фильм. Это помогает аниматору понять, какую
форму придать губам.

В середине страницы аниматор наносит схему рисунков. Здесь он как бы
общается с оператором, объясняя ему расположение рисунков перед камерой.
Эта область обычно разделяется на шесть или восемь уровней. Они отражают
различные уровни анимации: уровень 1 может быть фоном, уровень 2 – тулови�
щем персонажа, уровень 3 – головой и т.д.

Количество уровней было ограничено диапазоном от шести до восьми еще
в те дни, когда анимация вставлялась на кель и снималась камерой. Чуть боль�
ше слоев – и из�за их толщины цвет под объективом камеры изменился бы.
В эпоху цифровых технологий волноваться по поводу количества слоев уже не
стоит, но вот их порядок по�прежнему важен, хотя в большинстве случаев шес�
ти слоев вполне достаточно (рис. 7.6).

ГЛАВА 7 ▼ Принципы анимации X�листы

Рис. 7.5

В левой части страницы, названной Action (Действие), режиссер делает для
аниматора заметки, касающиеся хронометража. Здесь отражается режиссерс�
кий взгляд на то, как надо распределить время в сцене. Такие заметки могут

Рис. 7.6

Широкая колонка справа – для заметок о работе камеры: начальная и конеч�
ная позиции для наездов и панорам, размер поля и характер фона.

Оставшиеся столбцы X�листа, к счастью для нас – современных Flash�анима�
торов, не представляют никакого интереса, поскольку касаются физического
расположения рисунков перед настоящей камерой (рис. 7.7).
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Промежуточная анимация
Вы уже слышали о термине «анимация движения» применительно к анимации.
Часто употребляемый во Flash�анимации, он происходит от концепции проме�
жуточных изображений в традиционной анимации. Промежуточные изображе�
ния – это рисунки между ключами анимации. Аниматор, набрасывая основные
рисунки (ключи), одновременно решает, сколько рисунков потребуется между
ключами, чтобы описать траекторию действия, и с какой скоростью это дей�
ствие должно происходить (рис. 7.8).

!!! Как уже упоминалось, существуют и альтернативы X;листовой анимации, напри;
мер, мы можем пронумеровать все последовательные рисунки: A1, A2, A3 и т.д.
Недостатком такого метода является то, что номера рисунков не совпадают с но;
мерами кадров. Преимущество системы X;листов в том и состоит, что она позво;
ляет вам вернуться и вставить любой одиночный кадр.

Чтобы донести до рисовальщика промежуточных изобра�
жений информацию о том, что должно случиться между двумя
ключами, аниматор рисует шкалу, или схему, на одном из клю�
чей (рис. 7.9).

Эта шкала показывает художнику, сколько промежуточных
изображений нужно вставить между ключами, а также как их
разместить. Художник сначала рисует A5, располагающийся на
полпути между A1 и A9. Затем между A1 и A5 вставляется A3, а
между A5 и A9 – A7. От того, как расположит их аниматор, бу�
дет зависеть скорость (или хронометраж) действия.

Если аниматор решит добавить несколько спланированных
по времени промежуточных изображений – в нашем случае A2
и A8 – к одиночным, он вставит их на шкалу хронометража так,
как показано на рис. 7.10.

И снова применяемая нами система нумерации дает анимато�
ру свободу вернуться к сцене позднее и добавить эти рисунки,
причем ему не придется называть их A7. Большинство анимато�
ров привыкли мыслить «дублями», регулируя хронометраж по�
зднее, особенно в наши дни, когда машины линейного тестиро�
вания стали доступны практически всем профессиональным
аниматорам. Flash также предоставляет аниматорам возмож�
ность просмотреть анимацию по мере ее создания.

На рис. 7.11 A3 располагается посередине, между A1 и A9,
так что рисовальщик промежуточных изображений сначала
изобразит его. Затем будет нарисован A5 и, наконец, A7. Как
вы можете убедиться, пробелы между промежуточными изоб�
ражениями не всегда одинаковы. Существует много способов
варьировать позицию промежуточного рисунка, оказывая воз�
действие на хронометраж действия (рис. 7.11).

На примере встающего человека у нас есть три промежуточ�
ных рисунка между каждым ключом. Обратите внимание на
дугу, которую описывают промежуточные рисунки. Чтобы художник мог вос�
создать такую дугу, аниматору нужно снабдить его необходимыми набросками.

ГЛАВА 7 ▼ Принципы анимации Промежуточная анимация

Рис. 7.7

Рис. 7.8

Здесь у нас два ключевых рисунка. A1 изображает слегка согнутую руку. A9 –
ту же руку, но уже вытянутую вперед.

Нумерация этих рисунков соответствует номерам кадров на X�листах:
A1 находится на кадре 1, A9 – на кадре 9.

Рис. 7.9

Рис. 7.10

Рис. 7.11
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Это грубые рисунки, выполненные аниматором с целью обозначения траекто�
рии действия, являющейся альтернативой прямой линии (рис. 7.12).

У нас есть два ключа, приблизительно описывающих указывающую руку. То,
как мы составим шкалу промежуточных изображений, отразится на действии,
которое в конечном итоге отобразится на экране.

ГЛАВА 7 ▼ Принципы анимации Хронометраж

Рис. 7.12

Рис. 7.13

На рис. 7.13 изображены шкалы хронометража для данного действия.

Хронометраж
Время – это все. Ну, может, не совсем все, но хронометраж – важнейший фак�
тор, влияющий на реалистичное движение персонажа. Количество промежу�
точных изображений, которые мы нарисуем между ключами, определяет ско�
рость действия. Чем больше промежуточных изображений будет между
ключами, тем медленнее станет движение. Место вставки этих промежуточных
рисунков тоже повлияет на скорость движения. Изучите простое действие,
показанное на рис. 7.14.

Рис. 7.14

Рис. 7.15

Рис. 7.16
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Если назвать первый ключ A1, а второй – A5, то промежуточное изображе�
ние будет всего одно (с учетом дублей). Так что у нас получится весьма быстрое
действие (рис. 7.15).

Это то же самое движение, но возле первого ключа к нему добавлено еще одно
промежуточное изображение. Оно создаст эффект замедления после первого
ключа, зато второй будет достигнут с той же скоростью, что и в первом примере
(рис. 7.16). Такой хронометраж придаст руке больший вес, и она покажется тя�
желее. К сожалению, это приведет и к слишком резкой остановке. Действие по�
кажется неестественным. Решение кроется в замедлении остановки.

Смягчение

Смягчения играют в анимации фундаментальную роль. Смягчение – это способ
придать нашему рисунку нужную форму так, чтобы скорость и движения смот�
релись как можно естественнее (рис. 7.17).

действие почти так же, как в предыдущем примере, но само смягчение сделать
сильнее (рис. 7.18).

Рис. 7.17

Данный хронометраж оказывает эффект, противоположный предыдущему.
Происходит резкое движение от первого ключа, которое замедляется (смягча�
ется) по мере приближения ко второму.

Смягчения чрезвычайно важны для распределения времени в анимации,
чтобы придать ей приятный вид. В природе никогда не происходит резких
обрывов, так что надо избегать их и в нашей анимации – особенно в ограни�
ченной анимации, где конечная позиция может удерживаться. Для этого есть
несколько способов.

Наиболее простой способ смягчить переход от одной позы к другой – это
сделать резкое движение от первого ключа, а промежуточные изображения
вставить ближе к другому концу. То есть вы можете хронометрировать это

Рис. 7.18

Дополнительные промежуточные рисунки смягчают движения. Даже если
учесть, что расстояние между A1 и A3 останется тем же самым, жест будет ка�
заться медленнее, терять свою силу.

Другим решением является добавление еще одного ключа. Это дает нам воз�
можность улучшить хронометраж. Имея только два ключа, мы ограничены в
своих возможностях. А дополнительный ключ позволяет установить разные
режимы скорости для одного действия (рис. 7.19).

Рис. 7.19

Если вставить одно промежуточное изображение на дубли между A1 и A5,
то движение будет очень быстрым. С дополнительным ключом на A5 мы смяг�
чаем это быстрое действие, чтобы оно не пролетало у нас в одну секунду.

ГЛАВА 7 ▼ Принципы анимации Хронометраж
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Итак, мы можем представить себе важность смягчения в анимации. Смягче�
ние придаст вашей анимации более естественный вид – ведь даже тончайшей
анимации требуется определенный вес и темп. Помимо более естественного
вида, смягчения дают возможность глазу, что называется, «зацепиться» за дей�
ствие, происходящее на экране. Это особенно важно в стремительной, простой
анимации, где персонаж мгновенно меняет позы. Без смягчения быстрые дви�
жения воспринимались бы нечетко, и действие выглядело бы запутанным и
незаконченным. Зрителям потребовалось бы немало времени, чтобы разоб�
раться в происходящем, и они утратили бы сюжетную нить.

В данном примере персонаж изначально находится в полуприсевшем поло�
жении. Затем он отклоняется и выпрямляется. Мы можем описать это действие
тремя основными ключами:

➤ исходное положение;
➤ конечное положение;
➤ смягчение, которое, по сути, является то же позой, только еще более вы�

тянутой и с поднятыми руками (рис. 7.20).

ключами всего одно промежуточное изображение на одиночном кадре, уско�
рив его вдвое по сравнению с предыдущим вариантом. Смягчение к конечному
кадру хронометрируется точно таким же образом (рис. 7.22).

ГЛАВА 7 ▼ Принципы анимации Хронометраж

Рис. 7.20

Это действие можно хронометрировать несколькими способами: например,
с переходом от A1 к A5 с одним промежуточным изображением на дублях и
смягчением к A15. Так у вас получится очень быстрое изначально движение,
сопровождающееся десятикадровым смягчением (рис. 7.21).

Использование смягчений позволяет усилить резкость анимации. Быстрые
движения будут восприняты зрителями, поскольку у них хватит времени уяс�
нить суть происходящего. В нашем примере мы вставили между первыми двумя

Рис. 7.21

Рис. 7.22

Использование смягчений для создания резкости

Последний ключевой рисунок движения не обязательно должен изображать
самое сильное отклонение. На самом деле, если вы хотите сделать движение
или жест по�настоящему резким, то ключом с наибольшим отклонением дол�
жен быть предпоследний. Вы все еще производите смягчение при движении к
последнему кадру, но это уже обратное смягчение. Этот прием действует намно�
го сильнее, чем тот, о котором мы говорили прежде. Примеры такой анимации
можно найти в старых мультфильмах «Tex Avery» и «Warner Brothers». «Ren and
Stimpy» также частенько прибегают к этому сильному, резкому темпу.
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Смягчения в «Ren and Stimpy» контролируются очень жестко. Количество
промежуточных изображений в них не превышает одного�двух. В итоге движе�
ние не смягчается, как происходило бы, если бы в нем использовались три�че�
тыре промежуточных изображения.

Рассмотрим смягчение указывания.
При движении от первого ключа ко второму мы можем обойтись вообще без

промежуточных кадров. Можно вставить один�два; это не смягчит нашего дей�
ствия, зато даст возможность что�то подправить в хронометраже даже при та�
ком размашистом, простом жесте (рис. 7.23).

размещено на одиночном кадре. Помните об этой опции, даже если она покажет�
ся вам более утонченной, чем требуется.

Шатание

Шатание – это анимационный прием, использующий промежуточные изобра�
жения и X�листы. Анимированное шатание рождает впечатление, что персо�
наж напрягается (рис. 7.25).

ГЛАВА 7 ▼ Принципы анимации Хронометраж

Рис. 7.23

Пунктирная линия обозначает середину. Это место, где обычно по умолчанию
помещается промежуточный кадр. Часто, особенно в художественной анимации,
аниматор рисует шкалу наподобие этой, чтобы художник промежуточных изоб�
ражений мог сориентироваться. Это позволяет отшлифовать анимацию, а так�
же заставляет художника сильно поломать голову. В нашем примере размещение
промежуточного изображения возле первого ключа позволит уловить смысл дей�
ствия без потери резкости. Темп при этом не изменяется, поскольку изображение

Рис. 7.24

Рис. 7.25

Мы рассчитали эту шкалу по одиночным изображе�
ниям, так что теперь можно изобразить эти рисунки в
виде шатания.

Шатание лучше всего работает с одиночными кад�
рами, поэтому рассмотрите эту шкалу. Эффект, кото�
рого мы добиваемся, – это уменьшающееся колебание,
которое подразумевает, что персонаж напрягается и
почти достигает крайней точки. Мы можем добиться
этого смягчением, расположив кадры, как показано на
рис. 7.26.

Шатание пользуется всеми преимуществами убыва�
ющих колебаний промежуточных изображений при
смягчении, давая абсолютно новый эффект.

Другая возможность использовать шатание пред�
ставляется, если персонаж сильно напуган (рис. 7.27).

Рис. 7.26
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Смягчение возрастает по мере продолжительности крика. Можно предста�
вить его в виде шатания (рис. 7.28).

Оно построено на дублях. Шатание сработает на дублях, но они куда грубее,
чем одиночные кадры. Зато во Flash на частоте 12 кадров в секунду (что соответ�
ствует размещению рисунков на дублях) оно оказывается удивительно эффектив�
ным. Шатание привносит в анимацию интенсивность, производя намного более
сильное визуальное впечатление, нежели обычное смягчение (рис. 7.29).

Здесь персонаж съеживается, реагируя на крик или неприятный звук. Хро�
нометраж будет точно таким, как в предыдущих примерах. Распределение прак�
тически идентично: 1, 2, 3, 2, 3, 4, 3, 4, 5, 4, 5, 6 и т.д. – два шага вперед, один
назад.

Общим местом для всех шатаний является то, что они обычно показывают
персонаж в состоянии стресса – напрягающегося, пугающегося или реагирую�
щего на что�то ужасное.

Вытягивание и сплющивание
Даже в реальном мире все, что движется в пространстве, в котором действует
по законам гравитации, всегда немного деформируется – и в особенности орга�
ническая материя (очевидно, это связано с инерцией и массой).

Деформация – это то, что мы, как аниматоры, используем для передачи ощуще�
ния энергии и веса, чтобы придать нашей анимации динамику и живость (рис. 7.31).

ГЛАВА 7 ▼ Принципы анимации Хронометраж

Рис. 7.27

Рис. 7.28 Рис. 7.29

Размещение шатания на одиночных кадрах сделает движение более плав�
ным, но и более интенсивным. Расположите эти рисунки так же, как на X�лис�
те, показанном на рисунке выше (рис. 7.30).

Рис. 7.30

Рис. 7.31
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Возьмем пример упрощенной человеческой фигуры, изображающей как вы�
тянутое, так и сплющенное положение. Чтобы лучше проиллюстрировать ба�
зовые принципы вытягивания и сплющивания, мы еще более упростим эту фи�
гуру (рис. 7.32).

Степень вытягивания или сплющивания объекта может варьироваться.
Бывают ситуации, в которых вам вообще не захочется деформировать объект;
например, падающий шар для боулинга (рис. 7.34). Здесь вы хотите добиться
ощущения тяжести и жесткости, даже при падении на землю и отскоке от нее.

Вес

Чтобы персонаж создавал ощущение поднятия настоящего веса, аниматор дол�
жен сначала обратиться к двум предыдущим темам: хронометражу и вытягива�
нию со сплющиванием. Сочетание этих двух основных ингредиентов может
создать впечатление, что двухмерный персонаж действует в реальном мире, где
существуют законы гравитации, пусть даже иногда эти законы изменяются и
нарушаются.

ГЛАВА 7 ▼ Принципы анимации Хронометраж

Рис. 7.32

Главное, что нужно помнить, вытягивая и сплющивая анимацию: масса
объекта всегда остается примерно одинаковой.

Принципы вытягивания и сплющивания применимы к любым анимирован�
ным элементам. В нашем случае во время диалога вытягивается и сплющивает�
ся голова персонажа (рис. 7.33).

Рис. 7.33

!!! Конечно же, персонаж должен выглядеть все тем же человеком даже при деформа;
ции – вот где пригодится заранее проявленная забота о дизайне персонажей!

Рис. 7.34

Рис. 7.35

Если анимированному персонажу придется поднимать камень, он сделает
это примерно так, как показано на рис. 7.35. Как и везде в анимации, тут суще�
ствует несколько вариантов, но представленный выше, пожалуй, наиболее оче�
виден.
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Но прежде чем мы приступим к хронометражу, давайте приглядимся побли�
же к ключевым рисункам и подумаем, что поможет нам донести до зрителя
ощущение, что персонаж имеет вес.

Линия действия
Линия действия проходит через персонаж и самым элементарным образом
описывает его положение. Когда аниматор начинает делать наброски дей�
ствия, он частенько рисует только самый общий контур этого действия, чтобы
быстро сделать несколько рисунков, схватывая самую суть движения без лиш�
ней детализации. Рисуя больше, аниматор только замедлил бы работу и поте�
рял основную нить рассуждений. Иногда анимация требует от своего создате�
ля «погрузиться» в нее; прокрутить фильм в своем воображении и попробовать
перенести действие на бумагу. Аниматор переходит от одного листа к другому,
делая быстрые наброски, как если бы он выдерживал рисунки перед камерой,
и рассматривает каждый рисунок как часть общей последовательности, то есть
одним из кадров в последовательном ряду.

Линия действия двуногого персонажа обычно проходит, начиная от просто�
го круга, обозначающего голову, через спину и вниз к ступням.

В серии набросков, представленных на рис. 7.36, вы можете видеть, как ли�
ния действия меняется от наброска 1, выгибаясь в обратном направлении на
набросках 2, 3 и 4. Линия действия изображает персонаж, сгибающийся под
давлением веса объекта, который он пытается поднять. На последнем наброс�
ке он уже поднял камень – и его линия действия изменилась соответствующим
образом (рис. 7.36).

!!! Помните, что часто самые простые вещи могут выразить очень многое. Этот при;
мер доказывает, что одно и то же действие можно передать более интересным об;
разом и стилем, требующим меньше работы от аниматора. И снова это зависит от
типа анимации, которую вы намереваетесь создать.

Ниже приводится пример линии действия, проходящей через персонаж,
раскачивающийся на веревке. Мораль: не тратьте время на рисование, если не
уверены, что действие сработает. И снова повторим, что рисунки, как и сам
фильм, создаются вами (рис. 7.37).

ГЛАВА 7 ▼ Принципы анимации Линия действия

Рис. 7.36

Такие схематичные наброски, состоящие только из линии действия и еще,
может быть, головы персонажа, ухитряются передать удивительно много ин�
формации, особенно на этапе съемок.

Рис. 7.37

Под весом не обязательно подразумевается реальный вес персонажа. Вес
присущ каждому отдельному виду движения или действия.

Судя по трем ключам, описывающим прыгающий персонаж, тут вес вообще
отсутствует: нет никакого вытягивания и сплющивания. Движение кажется плос�
ким и безжизненным (рис. 7.38).

Рис. 7.38
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В следующем примере персонаж тянется и приседает, что создает впечатле�
ние веса и реалистичности. Это уже намного ближе к реальному поведению
человека (рис. 7.39).

Походка, изображенная на рис. 7.41, получится намного динамичнее, чем в
предыдущем примере.

!!! Предостережение – пользуйтесь техникой вытягивания и сплющивания осторожно,
или ваши персонажи будут выглядеть, словно сделаны из резины, что полностью
сведет на нет весь эффект веса!

Сначала мы рассматривали вес в контексте вытягивания и сплющивания.
Мы использовали только одиночные рисунки, чтобы передать ощущение веса,
массы и действия силы тяжести. Где поставить ключи и промежуточные рисун�
ки – решать вам, поэкспериментируйте. Большим достоинством Flash�анима�
ции, как мы увидим в следующих главах, является то, что хронометраж можно
подправить прямо во время анимирования.

Дуги
Мы уже касались темы дуг раньше. Рассмотрим ее более детально. Анимацию
можно разбить на ключи и промежуточные изображения. От их расположения
будет зависеть траектория действия. Изучим простой пример на рис. 7.42.

ГЛАВА 7 ▼ Принципы анимации Дуги

Рис. 7.39

Даже самое обыденное действие, а не только размашистые и резкие движе�
ния, требует придания веса. Возьмем, к примеру, идущий персонаж (рис. 7.40).

Рис. 7.40

На этом примере четырех ключей обычной походки персонаж не проявля�
ет при ходьбе никаких признаков приседания или выпрямления. Хотя на бума�
ге эти рисунки смотрятся нормально, они совсем не передадут ощущения веса.
Походка получится неестественной.

На следующем рисунке – тот же самый первый ключ. На втором ключе, так
как персонаж переносит вес на правую ногу, она подгибается, изображая этот
вес. В третьем ключе персонаж выпрямляет правую ногу, как бы подбрасывая
себя, что дает ощущение высвободившейся энергии. Четвертый ключ – это
повторение первого.

Рис. 7.41

Рис. 7.42
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Представьте, что три данных ключа изображают руку, хватающую что�то в
воздухе. Аниматор уже начертил дугу; в своем воображении он видит, как дей�
ствие проходит по этой дуге, и может рассчитать сцену, как показано на
рис. 7.43.

и движения. Такой рисунок прочерчивает ярко выраженную, органичную кру�
говую линию действия (рис. 7.45).

В мультфильмах Уолта Диснея времен 1940�50�х гг. искусство использования
дуг в анимации достигло вершин мастерства. Обратите внимание на убедитель�
ность веса и естественную эластичность в этих фильмах. Аниматоры Диснея в
определенном смысле изобрели анимацию и возвели ее в ранг искусства, и к
40�м годам подняли ее на уровень, который никому не удалось превзойти и по
сей день. Анимационные фильмы, производившиеся в студиях в то время, яв�
ляются настоящим эталоном.

Очень важно помнить про дуги, занимаясь анимацией во Flash. Программа,
скорее всего, выберет кратчайший путь между двумя ключами при интерполя�
ции движения, так что о дугах нужно помнить вам. Вам придется добавить ин�
формацию либо с помощью увеличения количества ключевых кадров, либо
прибегнув к направляющим движения – мы рассмотрим этот процесс, когда
начнем создавать наш мультфильм во Flash.

Ракурс
Ракурс – это технический термин в рисовании, касающийся эффекта восприя�
тия, когда объекты, расположенные близко к камере, кажутся больше отдален�
ных. В результате создается иллюзия глубины поля.

На примере простого жеста мы видим, что приближение правой руки созда�
ет ощущение глубины и трехмерности (рис. 7.46).

Та же поза, но без изменения ракурса, кажется более плоской и двухмерной
(рис. 7.47).

ГЛАВА 7 ▼ Принципы анимации Ракурс

Рис. 7.43

В студии аниматор не занимается промежуточными изображениями лично.
Работа рисовальщика промежуточных изображений заключается в том, чтобы
разместить рисунки между ключами, следуя указаниям на шкалах. Кратчайший
путь между двумя точками пролегает по прямой, поэтому неопытный рисоваль�
щик мог бы выстроить промежуточные рисунки так, как показано на рис. 7.44.

Рис. 7.44

Такие рисунки в итоге приведут к несвязному и неестественному действию.
Сравните их с движением, которое изображено здесь: это, пожалуй, наиболее

эффективный способ анимировать действие. Он передает сильное ощущение веса

Рис. 7.45
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По общему признанию, это, скорее, вопрос эскизов, но очень важно не за�
бывать об этом эффекте в своей анимации – особенно сильно он повлияет на
линию дуг. Попытайтесь представлять свои рисунки как округлые трехмерные
изображения. Это особенно важно в ограниченной анимации, где одна поза
может удерживаться некоторое время.

Дуги в сочетании с остальными приемами придадут вашей анимации ощуще�
ние веса и реалистичности. Зритель ничего о них не знает – ему это и не нужно,
но естественный, органичный вид вашей анимации – это еще один указатель вер�
ного направления, ведущего аудиторию через минные поля вашего фильма!

Действие и его подготовка
«Для каждого действия существует равное противодействие». Так сказал сэр
Исаак Ньютон, и кто мы такие, чтобы с ним спорить? Теоретическая физика
может казаться неуместной в легкомысленном мире мультипликации, но если
вы проследите за следующим сценарием, то увидите, что слова сэра Исаака
могут сильно пригодиться вам в анимации.

Персонаж стоит, а затем убегает за экран (рис. 7.48).

Хотя данное действие описывается двумя ключами, но даже при помощи
промежуточных изображений и тщательнейшего хронометража этой анима�
ции будет недоставать не только веса, но и вообще какого�либо ощущения реа�
листичности.

Чего здесь не хватает, так это ощущения готовности (рис. 7.49). Оно нужно
не только для того, чтобы дать аудитории понять, что что�то должно произой�
ти, но и для того, чтобы доставить Ньютону радость!

ГЛАВА 7 ▼ Принципы анимации Действие и его подготовка

Рис. 7.46 Рис. 7.47

Рис. 7.48

Рис. 7.49

Начальный ключ мы оставим без изменений, а затем наш персонаж перей�
дет к действию, приседая. Это преувеличенная подготовка к последующему
действию. Затем персонаж срывается с места и бежит.

Данный пример, пожалуй, несколько мягче, чем большинство из тех, что
применяются в настоящей анимации. Пойдем несколько дальше (рис. 7.50)

Рис. 7.50
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Здесь гротеск выражен намного сильнее. Такая анимация выглядит экспрес�
сивно, но менее реалистично (рис. 7.51).

«Сухая кисть» получила свое название потому, что она требовала от худож�
ника рисования буквально сухой кистью, что давало эффект размытого движе�
ния. Вы часто можете встретить такой эффект в старых мультфильмах. Он при�
менялся – и, пожалуй, чересчур часто – по отношению ко многим быстрым
действиям, так что в наши дни его редко увидишь, разве что в мультфильмах,
нарочно выдержанных в ретро�стиле, или у аниматоров, которые не понима�
ют, что на самом деле эта размытая техника только замедляет действие.

Подготовка необходима не только резким действиям, которые мы рас�
смотрели выше. Простейшие и едва уловимые движения также требуют не�
которой подготовки. Чтобы анимировать указывающий жест, руку надо
предварительно отклонить назад, прежде чем придать ей окончательный
вид (рис. 7.54).

ГЛАВА 7 ▼ Принципы анимации Действие и его подготовка

Рис. 7.51

Другое применение гротеск находит в беге. Возможно, вы смягчите его при
помощи нескольких промежуточных кадров (рис. 7.52).

Рис. 7.52

Молниеносность

Это классический мультяшный гротескный прием, обозначающий молниенос�
ный бег (рис. 7.53). Молниеносность – прекрасное, трудосберегающее устрой�
ство из ограниченной анимации. Не давая персонажу пробежать по всему эк�
рану и убежать за него, аниматор применяет показанный выше прием, и с
помощью парочки кадров того, что принято называть «сухая кисть», персонаж
пропадает!

Рис. 7.53

Рис. 7.54

Ниже нарисован персонаж, собирающийся издать мощный вопль. Не забы�
вайте – амплитуда и сила подготовки должны соответствовать последующему
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действию. Здесь крик действительно силен, так что и подготовка получается
гротескной (рис. 7.55).

Мультяшный кадр

Так называется кадр, в котором персонаж реагирует на что�то в преувеличен�
ной манере (рис. 7.59).

ГЛАВА 7 ▼ Принципы анимации Действие и его подготовка

Рис. 7.55

Хронометрировать данное действие можно несколькими путями. Вот один
из них, включающий шатание (рис. 7.56).

Рис. 7.56

Такой тип действий прекрасно подходит для шатания, поскольку персонаж,
очевидно, переживает большой стресс! Чтобы шатание сработало, мы добави�
ли еще один ключ. Впрочем, он бы нам наверняка понадобился вне зависимос�
ти от того, как мы рассчитаем действие. Можно сделать это способом, показан�
ным на рис. 7.57.

Два промежуточных изображения на дублях производят смягчение при под�
ходе к гротескному моменту (A7). Затем мы резко переходим к действию (A9).

Можно вставить промежуточное изображение на одиночном кадре, но, учиты�
вая наш подход (мы идем напрямик!), для такого размашистого действия это
совсем не обязательно. Три промежуточные изображения на одиночных кад�
рах, смягчающие подход к последнему ключу (A13), дадут нам рисунки, кото�
рые требуются для изображения шатания на X�листе.

Порядок расположения показан на рис. 7.58.

Рис. 7.57 Рис. 7.58

Рис. 7.59
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Такой кадр является отличным примером действия и подготовки к нему.
Мультяшные кадры – краеугольные камни анимационного юмора. Warner
Brothers и в особенности Tex Avery довели этот прием до совершенства. Более
современные удачные примеры мультяшных кадров можно найти в мультфиль�
мах «Ren and Stimpy». Практически любая анимационная студия время от вре�
мени ими пользуется.

Второстепенное и сопроводительное действие

Наряду с основными движениями персонажа некоторые его части могут жить
собственной жизнью. Ими могут быть волосы, одежда, уши и т.д.

Собачьи уши – длинные и болтающиеся. Когда собака двигает головой, кон�
цы ушей немного задерживаются, прежде чем движение головы вовлечет и их;
они не успевают за движением (рис. 7.60).

Второстепенные действия проходят определенный путь, прежде чем пре�
кратиться (рис. 7.62).

ГЛАВА 7 ▼ Принципы анимации Действие и его подготовка

Рис. 7.60

Если собака остановится, то уши продолжат свое движение, постепенно
останавливаясь (рис. 7.61).

Рис. 7.61

Рис. 7.62

Скорость второстепенного действия в основном определяется скоростью,
с которой осуществляется главная анимация. Рисунок ниже представляет ско�
рость, с которой движется собака (a); по мере торможения собаки уши продол�
жают двигаться с прежней скоростью, пока не вытянутся максимально. Затем
они проделывают обратный путь, о котором мы уже говорили (рис. 7.63).

Рис. 7.63

Собака движется в этом направлении

!!! Позаботьтесь о том, чтобы второстепенные действия не отвлекали от сути проис;
ходящего.
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Здесь персонаж входит в кадр очень быстро, а затем движение смягчается
по мере приближения к остановке (рис. 7.64).

Действие и подготовка к нему абсолютно необходимы для передачи ощуще�
ния веса и энергии. Сила или легкость подготовки должны соразмерно отра�
жаться в последующем действии. Не верите – спросите у Исаака Ньютона.

Циклы
Циклы – великолепное средство для экономии времени, ставшее настоящим
фирменным знаком анимации, начиная с раннего Диснея и заканчивая Betty
Boop. В наши дни циклами пользуются для достижения ретро�эффекта – напри�
мер, в «Симпсонах» («The Simpsons»). Цикл – это анимация, которая «закольцо�
вана» так, что может воспроизводиться непрерывно. Большинство циклов обыч�
но изображают ходьбу или бег, но, в принципе, любое действие, которое можно
повторить, можно и преобразовать в цикл: например, флаг, развевающийся на

ГЛАВА 7 ▼ Принципы анимации Циклы

Рис. 7.64

Для ясности расположим эти три ключа иначе, так, как показано на рис. 7.65.

Рис. 7.65

Если мы нацепим на персонаж волосы и последуем всем правилам, о кото�
рых только что говорили, то волосы проделают примерно такой путь, который
показан на рис. 7.66, прежде чем примут окончательный вид. Такая анимация
выглядит, безусловно, чрезмерной, отвлекающей от основного действия – то
есть от нашего героя, входящего в кадр.

Более приемлемым может быть вариант, изображенный на рис. 7.67.
Создается эффект легкого второстепенного движения волос, не отвлекаю�

щего внимания от главного. Второстепенные действия должны дополнять ани�
мацию, чтобы основное действие не заканчивалось резким обрывом. Но они
ни в коем случае не должны затемнять главный смысл сцены.

Рис. 7.66

Рис. 7.67
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ветру или крутящееся колесо. Неважно, что вы зацикливаете, – главное, чтобы
последний рисунок анимации незаметно вел к первому.

Ниже приведен пример простого цикла. Этот цикл маятника работает бла�
годаря обычному проектированию анимации на X�листе туда�обратно. Мы смяг�
чили подходы к обоим крайним положениям (рис. 7.68).

Эти четыре ключевых рисунка изображают цикл ходьбы в самом общем
виде.

Построим шкалу данного примера с одним промежуточным рисунком на
дублях для каждого ключа. A13 перейдет обратно к A1 через один промежуточ�
ный рисунок – A15 (рис. 7.71).

ГЛАВА 7 ▼ Принципы анимации Циклы

Рис. 7.68

Изобразим это действие на X�листе, как показано на рис. 7.69.
Чтобы показать более сложные примеры использования цик�

лов, где последний рисунок ведет к первому, мы рассмотрим наи�
более распространенные из существующих циклов: ходьба и бег.

Циклы ходьбы

Циклы ходьбы совершенно необходимы для ограниченной анимации. Вспомни�
те, сколько раз вам доводилось видеть персонажей мультфильмов, долго идущих
мимо повторяющихся фонов. На рис. 7.70 изображено, как это делается.

Рис. 7.69

Рис. 7.70

Рис. 7.71

Можно выстроить данный цикл ходьбы следующим спосо�
бом. Это цикл ходьбы из восьми рисунков на дублях. Вы може�
те повторять его до бесконечности (рис. 7.72).

Существуют две основные сферы применения циклов ходь�
бы и бега. И оба сэкономят вам уйму времени, поскольку если
цикл нарисован, то с помощью нескольких рисунков вы може�
те покрыть любое расстояние и время.

Ниже приведен фиксированный кадр – камера в нем непод�
вижна. Нам нужно, чтобы персонаж прошел через сцену. Мы
задерживаем фон и панорамируем наш цикл ходьбы через эк�
ран на обычной скорости (рис. 7.73).

Рис. 7.72

Рис. 7.73
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Здесь уже персонаж располагается в центре сцены, а движется фон. Техни�
чески это «съемка с движения», в котором камера (по крайней мере, в «живом»
фильме) следует за персонажем (рис. 7.74). В настоящих фильмах эти персона�
жи часто предпочитают, чтобы их звали актерами!

Эти интервалы определяют скорость панорамирования и расстояние, кото�
рое будет проходить фон или персонаж за один кадр.

Во Flash, как мы убедимся в главе 9, вы можете создавать циклы ходьбы при
помощи символов�клипов. Быстрее всего добиться этого можно, создав символ�
клип идущего персонажа, а затем перетащив его на рабочее поле. Если потом
вы преобразуете его в графический символ, он будет меняться по мере вашего
движения по кадрам на временной шкале, что даст вам возможность создания
эффективной анимации, дабы ступни реалистично опускались на землю. По�
том вы можете преобразовать его обратно в символ�клип и избежать уймы лиш�
ней работы.

При панорамировании фонов в традиционной анимации всегда используют�
ся одиночные кадры. Это значит, что и ваша анимация должна располагаться
на одиночных кадрах, иначе она станет проскальзывать или стробироваться.
К счастью, во Flash, где мы обычно работаем при частоте 12 кадров в секунду
(установка по умолчанию), подгонка ритма дублей не должна вас беспокоить
(рис. 7.76).

ГЛАВА 7 ▼ Принципы анимации Циклы

Рис. 7.74

Панорамирование
фона

Из этих двух примеров видно, что циклы могут избавить вас от массы хло�
пот, а в контексте Flash они становятся еще выгоднее, чем в традиционной двух�
мерной анимации. В разделе о Flash�анимации вы узнаете, как преобразовать
цикл в символ, что дает аниматору такую свободу в разработке ходьбы и бега, о
какой обычные аниматоры могут только мечтать.

При анимации ходьбы и бега важно помнить о том, что в местах соприкос�
новения ступни и поверхности должны двигаться с одинаковой скоростью.
Если их скорость будет различна, то будет казаться, что ноги скользят по
фону.

Лучшим способом измерить скорость, с которой двигаются ноги, это отме�
тить места, где опускается пятка. Так вы сможете проконтролировать расстоя�
ние, которое проходит нога, и соблюсти нужные пропорции (рис. 7.75).

Рис. 7.75

Рис. 7.76

A9 – это отражение A1.
A13 – отражение A5 (рис. 7.77).

Рис. 7.77
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Вы можете видеть, как совпадают промежуточные изображения (рис. 7.78).

Ниже представлен точно такой же базовый цикл, как тот, о котором мы
только что говорили. Здесь применяются одни и те же принципы, просто все
действие развернуто к камере. X�лист для такой анимации не будет ничем отли�
чаться от предыдущего. Ходьба с двойным подскоком по направлению к каме�
ре. Один промежуточный кадр на дублях между всеми ключами. A21, A23 и об�
ратно к A1 (рис. 7.82).

ГЛАВА 7 ▼ Принципы анимации Циклы

Рис. 7.78

Походка, с которой мы работали до сих пор, достаточно хороша. Но… вы
уже догадались? Правильно – есть походка еще лучше! Ходьба с двойным под�
скоком создает впечатление большего веса, увеличивает амплитуду приседания
и выпрямления (рис. 7.79). Девять из десяти профессиональных аниматоров
предпочитают походку с двойным подскоком!

Рис. 7.79

Такую походку можно представить в виде схемы с одним
промежуточным кадром на дублях. Данный способ известен
под названием цикла ходьбы из двенадцати рисунков. X�лист
для него выглядит, как показано на рис. 7.80.

Помимо цикла персонажа, проходящего через кадр, или
панорамирования фона с персонажем в центре экрана, мы
можем анимировать цикл персонажа, приближающегося или
удаляющегося от камеры. Это те же самые циклы, только на�
рисованные под другим углом (рис. 7.81). Рис. 7.80

Рис. 7.81

Рис. 7.82

Выражение настроения

Есть мнение, что анимацию можно разделить на две сферы: мимика и действие.
В сущности, это одно и то же. Везде действуют те же правила: вытягивание,
сплющивание, гротеск, подготовка к действию. Настроение может влиять на
действие так же, как и на выражение лица персонажа. Похожи ли походки рас�
строенного персонажа и разозленного? Существует кучка аниматоров, которые
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будут неистово доказывать: «Нет! Не похожи!» А мы скажем: да, похожи – бо�
лее или менее. Одна нога впереди другой – но все будет зависеть от того, как их
нарисовать. Посмотрите на рис. 7.83.

Здесь ноги персонажа слегка согнуты и никогда не выпрямляются полнос�
тью. Его левая нога еле�еле отрывается от земли при ходьбе. Это создает образ
печальной или уставшей походки.

Размахивание руками с меньшей амплитудой также помогает придать нуж�
ное настроение (рис. 7.85).

ГЛАВА 7 ▼ Принципы анимации Циклы

Рис. 7.83

Здесь один и тот же ключевой рисунок из цикла ходьбы. Первый – походка
довольного персонажа, передающая общее хорошее настроение, которой мы
пользовались раньше. Второй производит впечатление грустного или удручен�
ного чем�то персонажа, а третий – агрессивного. Если присоединить эти позы
к циклам ходьбы, о которых мы говорили, они будут передавать нужное настро�
ение без необходимости менять анимацию.

Вы можете, само собой, подправить и походку, чтобы она лучше передавала
эмоции. Ленивое перетаскивание ног, шарканье ботинками по земле, замедле�
ние темпа. Ниже приведена вариация ключевого рисунка A9 из цикла ходьбы,
состоящего из двенадцати рисунков (рис. 7.84).

Рис. 7.84

Рис. 7.85

!!! О чем нужно помнить, анимируя руки в циклах ходьбы и
бега: они движутся в направлении, противоположном
движению ног.

Когда левая нога находится впереди, левая рука рас�
полагается сзади. Это может показаться очевидным, но
часто то, что воспринимается как само собой разумею�
щееся, ускользает от внимания.

В процессе анимации вам придется использовать множество циклов ходь�
бы. Знание, как эффективно их анимировать и адаптировать к циклу, позволит
сэкономить вам время и усилия, а также придаст фильму более профессиональ�
ный вид.

Циклы бега

Циклы бега следуют тем же законам, что и циклы ходьбы:
Ноги при соприкосновении с землей должны двигаться с постоянной ско�

ростью.
Руки раскачиваются в направлении, противоположном ногам.
Можно сделать цикл, в котором персонаж находится в центре экрана с па�

норамированием фона, а можно заставить цикл проходить через экран с фик�
сированным положением камеры.
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Циклы бега освобождают вас от лишней работы.
Это самый стандартный цикл бега: шесть рисунков, шесть ключей – все на

дублях (рис. 7.86).

предполагает небольшое подпрыгивание, но здесь энергия уже фокусируется
на движении вперед. На наброске 3 фактически нет никакого вертикального
движения. Такой бег должен хронометрироваться и распределяться по ключам
иным образом по сравнению с предыдущими типами бега.

Ниже приводится пример быстрого бега. Это цикл из четырех рисунков на
дублях. Руки персонажа нарисованы вытянутыми вперед. Это предполагает
особо сильную спешку. Когда персонаж несется очень быстро, аниматоры
обычно прибегают к этому приему (рис. 7.89).

ГЛАВА 7 ▼ Принципы анимации Циклы

Рис. 7.86

Обратно к

Обратите внимание, насколько сильнее выдается вперед тело, чем в цикле
ходьбы. Такой прием передает ощущение большей скорости, и чем быстрее
бежит персонаж, тем сильнее мы наклоняем его вперед (рис. 7.87).

Рис. 7.87

Сравнивая наброски 1, 2 и 3, мы видим, что персонаж от неспешной рысцы
на наброске 1 переходит к бегу, как в предыдущем примере, на наброске 2, а
затем к еще более быстрому бегу на наброске 3. Мы можем связать их все с по�
мощью одного только наклона тела, не обращая внимания на темп бега.

Чем быстрее бег, тем меньше персонаж двигается вверх и вниз. В цикле очень
быстрого бега движение тела вверх�вниз практически отсутствует (рис. 7.88).

Набросок 1 предполагает широкую вертикальную амплитуду тела, что�то
вроде подпрыгивающего шага. Набросок 2 – бег из нашего первого примера –

Рис. 7.88

Рис. 7.89

Обратно к A1

Руками можно размахивать по�прежнему, но из�за чересчур быстрого цикла
это может только отвлекать. По счастливому совпадению, так еще и проще
анимировать!

Ходьба и бег, на самом деле, являются разновидностями контролируемого
падения. Когда мы движемся вперед, нам нужно вовремя выставить вперед
ноги, иначе мы упадем. При ходьбе нога, на которую переносится вес, обыч�
но располагается почти на той же линии, что и голова персонажа. При беге
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голова сильнее наклонена вперед. Чем быстрее движется персонаж, тем даль�
ше он отклоняется (рис. 7.90).

Перед вами цикл бега по направлению к камере, состоящий из двенадцати
рисунков на дублях. Бег довольно медленный и напоминает трусцу. Можно
изобразить такой бег и на одиночных кадрах, что сделает его быстрее (эквива�
лент цикла из шести рисунков) (рис. 7.91).

На наброске 1 ступня, на которую перенесен вес, поставлена почти прямо
под телом персонажа, что создает ощущение сбалансированности. На наброс�
ке 2 персонаж кажется неустойчивым. Как уже упоминалось, ходьба – это вид
управляемого падения, но управляемого падения вперед. А парень на наброске 2
выглядит так, будто он слишком много выпил!

Движения при беге намного более размашисты, чем при ходьбе, так что и
ступни надо ставить шире. И даже учитывая это, надо подходить к данному воп�
росу со всей тщательностью. Как и в большинстве случаев с рисунками и ани�
мацией, проблемы могут возникнуть там, где их меньше всего ждешь. Рисунок
должен органично вписываться в анимацию.

Циклы способны освободить аниматора от массы лишней работы, но очень
важно, чтобы ваши циклы плавно воспроизводились. В случае с циклами гар�
моничность важна более, чем где�либо еще, поскольку зритель увидит их не�
сколько раз. Сделав цикл, проигрывайте его, пока не убедитесь, что все рабо�
тает, как надо. Любые раздражающие глаз мелочи нужно немедленно
исправлять. Если они раздражают вас, то наверняка будут раздражать и аудито�
рию – или, по крайней мере, отвлекать ее.

Ходьба и бег – важные части любого анимационного фильма, и, если умело
с ними обращаться, они могут оказать значительное влияние на внешний вид
персонажа.

Разделение слоев
Точно так же, как мы отделили губы при анимации диалога, мы можем раз�
делить любые элементы анимации, чтобы сэкономить свое время и усилия
(рис. 7.93).

Рис. 7.90

ГЛАВА 7 ▼ Принципы анимации Разделение слоев

Рис. 7.91

Обратно к A1

Анимация бега по направлению к камере трудна для рисования, поскольку
здесь требуется применение ракурса. Нужно заботиться о правильных дугах рук
и ног, иначе действие будет восприниматься искаженно. Если цикл анимиро�
ван недостаточно плавно, то любое незначительное отклонение станет похо�
же на икоту – ведь при повторении цикла возникает ритм.

При анимации персонажей, бегущих или идущих к камере, обращайте
внимание на то, где вы располагаете ступни относительно тела и головы
(рис. 7.92).

Рис. 7.92
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Модель данного персонажа можно разбить на несколь�
ко отдельных слоев.

Тело, включающее и ноги. Вообще, можно отделить и
ноги, но если персонаж разговаривает и жестикулирует,
стоя на одном месте, в этом нет никакой нужды.

Руки. Руки мы распределим по отдельным слоям – одну
позади тела, другую на переднем плане.

Голова. Ее можно разбить на несколько слоев: глаза, рот
и т.д. (рис. 7.94).

Можно глаза и рот отделить, как показано на рис. 7.95
(все на отдельных слоях). Во Flash глаза, например, могут
иметь собственные субслои (например, свободно двигаю�
щиеся зрачки) – но принцип все равно тот же.

Каждому элементу можно присвоить свой уро�
вень на X�листе, как показано на рис. 7.96.

Правую руку мы поставили на верхний уровень,
поскольку нам может понадобиться провести ею
перед лицом (рис. 7.97).

Если один элемент анимации находится на более
высоком уровне, чем другой, а вам нужно, чтобы он
располагался позади или ниже этого уровня, вам
придется «подогнать» анимацию (рис. 7.98).

Подгонка рисунка означает, что вы отрезаете его
точно по линии, на которой он пересекается с ниж�
ним уровнем. В данном примере нам нужно, чтобы
персонаж поместил руку за спину. Так как его рука и
ладонь скрываются за спиной, нам нужно подогнать
рисунок, чтобы создать впечатление, что рука дей�
ствует позади тела.

ГЛАВА 7 ▼ Принципы анимации Разделение слоев

Рис. 7.93

Рис. 7.94

Мы обычно отделяем глаза так, чтобы иметь возможность анимировать мор�
гание. Простейший способ добиться этого – нарисовать два ключа: один для
открытых и один для закрытых глаз, вставив на дубли один промежуточный
кадр (рис. 7.95).

Рис. 7.95

Рис. 7.96
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Рис. 7.97 Рис. 7.98

Если какой�то элемент анимации, поме�
щенный на X�листе позади другого, нужно
анимировать на переднем плане, то мы мо�
жем просто поменять местами эти слои во
время анимации (рис. 7.99).

Если нужно поместить левую руку перед
туловищем персонажа, мы меняем слои, как
показано на рис. 7.100.

Разделение уровней позволяет анимиро�
вать элементы в разном темпе, независимо
друг от друга. Губы будут двигаться во время Рис. 7.99
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диалога, руки жестикулировать, а вся остальная часть персонажа – оставаться
неподвижной. Можно заставить персонаж изредка моргать, а можно анимиро�
вать всю голову целиком, временно соединяя элементы (рис. 7.101).

C1 – это голова, на которой отдельно располагаются голова и рот. В C5 все
эти элементы соединены на одном уровне. В C11 они снова разделены, как в C1.

Такой метод разделения и последующего соединения уровней и элементов
имеет фундаментальное значение для ограниченной анимации, и неважно, име�
ем ли мы дело со ртом и глазами или с руками и ногами – подход везде будет один.

Анимация мимики и диалогов
В мимике зрителю открывается характер наших персонажей. Даже в ограни�
ченной анимации аудитория должна наладить контакт с персонажем на экра�
не, если мы хотим, чтобы она ощущала какую�то сопричастность к происходя�
щему. Удачное выражение лица или жест скажет о персонаже больше, чем
движения его губ.

Хорошая мимика в анимации является суммой своих частей. Выражение
лица, направление взгляда, поза, жест, общая модель – все должно взаимодей�
ствовать друг с другом, чтобы донести до зрителя нужные эмоции. Ниже мы

перечислим несколько важных моментов, которые надо учитывать при анима�
ции мимики.

Вы всегда должны быть уверены в том, что понимаете назначение сцены,
которую собираетесь анимировать. Вам нужно твердо знать, что заставляет
действовать персонаж так, а не иначе.

Внимательно изучите сценарий, чтобы усвоить общую сюжетную канву и
роль в ней вашего персонажа.

Если это диалог, прослушайте его столько раз, сколько требуется, чтобы
суметь представить сцену в своем воображении.

Сделайте несколько набросков, которые помогут вам распланировать сцену.
Наконец, вы всегда должны четко представлять, что собираетесь анимиро�

вать, прежде чем приступать к работе.

Язык тела и жестов

Как и в реальном мире, язык тела в анимации может быть очень выразитель�
ным (рис. 7.102).

Упрощенный персонаж позволяет нам понять, как вызвать определенные
эмоции без жестикуляции и выражения лица. Когда вы добавите и эти элемен�
ты, они должны сочетаться с персонажем, чья поза и язык тела отражают от�
ношения и выражение лица, проявляющиеся в диалоге (рис. 7.103).

ГЛАВА 7 ▼ Принципы анимации Анимация мимики и диалогов

Рис. 7.100
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Застенчивый Грустный Счастливый

Самоуверенный Агрессивный Любопытный

Застенчивый Грустный Счастливый

Рис. 7.103

Добавив руки к предыдущим рисункам, мы усилили общее выражение. Это
помогает зрителю воспринимать эмоции персонажа, делая его реакцию ярче
выраженной.
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Выражение лица

Настроение и эмоции можно передавать не только мимикой, но и наклоном
головы – вверх или вниз (рис. 7.104).

Глаза еще точнее оттеняют различные эмоции. Даже если их выражение
совсем не меняется.

Выражение лица часто передается именно глазами или сочетанием глаз и
рта. Но легче всего передать, что чувствует персонаж, именно с помощью глаз
(рис. 7.106).

Убедитесь, что глаза смотрят, куда следует. Если глаза персонажа не сфоку�
сированы, то аудитории будет сложнее понять, что происходит на экране. По�
мните, что зрители в первую очередь обращают внимание на глаза.

Особенно важно направление взгляда, когда два персонажа общаются друг с
другом (рис. 7.107).

ГЛАВА 7 ▼ Принципы анимации Анимация мимики и диалогов

Рис. 7.104

Эти разные положения могут использоваться для передачи разных настроений.
В полной анимации персонаж может принимать поочередно несколько из этих
поз. В более ограниченном подходе вам хватит одного�двух ракурсов (рис. 7.105).

Рис. 7.105

Рис. 7.106

Рис. 7.107

Панель 1 – это двойной кадр. Мы определили местоположение двух персо�
нажей, которые общаются друг с другом. Персонаж А разговаривает с Б. Оба
они одного роста (рис. 7.108).

Рис. 7.108

Панель 2 – одиночный кадр разговаривающего персонажа А. Кажется, что
он разговаривает с какой�то точкой выше головы Б (рис. 7.109).
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Переходим к панели 3, где Б смотрит поверх головы А. Персонажи говорят
друг с другом, но никак не связаны визуально. Зрители тоже начнут терять
нить.

В то же время зрительный контакт между персонажами необязателен. Иног�
да лучше, чтобы персонаж смотрел куда�то мимо человека, к которому он обра�
щается. Просто удостоверьтесь, что направление глаз было выбрано сознатель�
но, а не является игрой случая.

!!! Взгляд в сторону или поверх персонажа может означать обдумывание какой;то
мысли и таким образом создавать комический эффект. Люди поступают так и в
жизни – попросите кого;нибудь вспомнить деталь из прошлого и понаблюдайте, как
его глаза смещаются вверх и в сторону. А если спросить о том, как человек себя
чувствовал, он, скорее всего, глянет в сторону и вниз. Знание поведенческой пси;
хологии может очень пригодиться при создании анимации!

Глаза и выражение, которое они передают, должны взаимодействовать с
лицом в целом: глазами, бровями, ртом и в меньшей степени носом (рис. 7.110).

идет не на пользу, но и потому, что они не создают единого выражения лица.
Наброски 2 и 3 кажутся более цельными и связными. Положение губ на наброс�
ке 2 оказывает влияние на глаза и нос. Выражение глаз на набросках 2 и 3 отра�
жает положение губ. Все это помогает понять, о чем думает персонаж.

Диалог

Анимация диалога – нечто больше, чем просто шевеление губами. Даже в огра�
ниченной анимации можно выбрать момент для акцентирования диалога ка�
ким�нибудь движением головы – особенно если речь идет о сильной эмоции
(рис. 7.111).

ГЛАВА 7 ▼ Принципы анимации Анимация мимики и диалогов

Рис. 7.109

Рис. 7.110

Черты лица на наброске 1 кажутся абсолютно не связанными между собой.
И это не только из�за того, что они так сильно разбросаны, что, конечно, тоже

Рис. 7.111

Персонаж говорит «You what?!!!» («Ты – что?!!!»). Пред�
ставьте себе очень яркое выражение. Он говорит «You», за�
тем его лицо гротескно искажается на «wh…» и растягива�
ется по мере «wh…a…t», а потом голова возвращается в
исходную позицию в конце «wh…a…t».

X�лист выглядит так, как на рис. 7.112. Диалог был раз�
бит по кадрам.

!!! Обратите внимание: акценты в диалоге попадают на те же
кадры, что и звук, или на кадр раньше. При анимации диалога
даже разделенные губы приобретают нужную форму за один
кадр или точно в том кадре, где находится голос, и никогда
после, поскольку тогда будет казаться, что анимация запаз;
дывает.

Для анимации диалога мы будем в основном пользовать�
ся концепцией разделенных губ. Периодически акцентируя
сильные и выразительные места в диалоге, мы можем придать нашей анима�
ции новое измерение.

Рис. 7.112
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Синхронизация губ

В ограниченной анимации реалистичная речь производится путем серии по�
ложений губ, где каждое положение выражает группу похожих звуков. Напри�
мер, сжатые губы могут изображать звуки «М», «П» или «Б». Так получается
базовый набор положений губ, наподобие того, который представлен ниже, где
положения обозначены буквами от A до F (рис. 7.113).

!!! И снова – заметьте, что нужная форма губ размещается на кадр
раньше или в одном кадре со звуком.

Анимация диалога ничем не отличается от любой другой.
Здесь действуют те же правила. В некотором смысле даже про�
ще, если у вас есть звуковая дорожка, которая в значительной
мере определяет, что вы будете анимировать. Прослушивайте
ее снова и снова, пока не представите себе анимацию. Когда
вы расположите свою анимацию диалога на X�листе, проиг�
райте ее и посмотрите, как она воспринимается. Потом мож�
но внести всякие мелкие дополнения.

Полезные советы при анимации мимики
Существует несколько вещей, над которыми полезно поду�
мать, когда создаешь мимику своих персонажей – это не пра�
вила, которых следует неукоснительно придерживаться, одна�
ко полезно помнить о них.

Чем меньше, тем лучше! Двадцать изощренных рисунков
ничуть не лучше одного! Хороший рисунок стоит тысячи слов,
а очень хороший способен заменить несколько сотен кадров, не
вызвав ни у кого возражений. Не думайте, что ваши персонажи
обязательно должны болтать руками, чтобы заинтересовать зрителей. Большая
часть скверной мимики, которую вам случается видеть в фильмах или по телеви�
зору, является результатом чрезмерного жестикулирования и злоупотребления
мимикой (рис. 7.116).

ГЛАВА 7 ▼ Принципы анимации Полезные советы при анимации мимики

Рис. 7.113

Звуки
«М», «П», «Б»

Звуки
«Д», «Т», «С» Звуки

«А», «Е»
Звуки
«Ах!»

Звук
«Р»

Звук
«У»

Показанная ниже интерполяция даст вам положения губ A, D и F. Помимо
этого, можно получить звуки «Л» и «В» (рис. 7.114).

Рис. 7.114

A D F Звук
«Л»

Звук
«В»

Формы губ от A до F могут выразить все вышеперечисленные звуки. Губы
«Л» и «В» названы по звукам, точно так же можно добавить и любые другие
формы губ для конкретного звука (рис. 7.115).

Вот так мы используем эти формы губ для анимации строчки из диалога.
Персонаж говорит: «I am very well» («Я в полном порядке»).

Рис. 7.115

Рис. 7.116
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Опасайтесь клише. Выше приведены, без сомнения, наиболее часто встре�
чающиеся в анимации жесты. Это не означает, что вам нельзя их использовать.
Как аниматоры со стажем, мы больше других повинны в том, что пользовались
ими. И если применять их разумно, то они выглядят вполне уместно. Но есть
аниматоры, которые умудряются использовать их все в одной сцене! Мы такое
не одобряем и вам не советуем.

Не воспринимайте все слишком буквально. Пусть настроение передается
диалогом и мастерством ваших рисунков. Зрители сообразят, что происходит,
и без анимированного семафора. Ниже приведен самый типичный пример, но
и на менее уловимом уровне аниматоры частенько грешат тем, что интерпре�
тируют движения чересчур буквально (рис. 7.117).

сдваивания. Сдваиванием называется ситуация, при которой положение одной
руки является зеркальным отражением другой, вместо того чтобы хоть немно�
го отличаться. Это общая проблема многих фильмов, которая придает персо�
нажу неловкий, неестественный вид (рис. 7.119).

ГЛАВА 7 ▼ Принципы анимации Полезные советы при анимации мимики

Рис. 7.117

«Я направляюсь……....………...….туда»

Добивайтесь реализма. Используемые жесты должны подсказываться са�
мой анимируемой сценой – важно, чтобы они отражали то, что говорит или
делает персонаж. Попробуйте сыграть эту сцену сами. Посмотритесь в зеркало
и набросайте жесты (рис. 7.118).

Остерегайтесь сдваивания. Даже если вы усиливаете какой�то жест ради
мультяшного эффекта, он все же должен быть похож на настоящий. Бойтесь

Рис. 7.118

Рис. 7.119

Для данных двух жестов лучше подойдет следующий подход. Нарушьте не�
много позу, чтобы она приняла более естественный вид. Подумайте о ракурсе
и придании рисунку трехмерного вида.

Думайте в трех измерениях. Даже если вы пользуетесь стандартными сим�
волами для конечностей (например, линия с символической кистью руки на
конце), вы, тем не менее, можете варьировать их положение и угол по отноше�
нию к телу. Кроме того, сплющивание графики дает эффект глубины. Глаз зри�
теля всегда пытается воспринимать мир в трех измерениях, вам нужно только
немножко помочь ему в этом.

!!! Если правильно изобразить язык тела и жестов, то интерпретация мимики через
отдельные черты и диалог станет намного проще.

Наброски

В традиционной анимационной студии аниматору редко приходится выпол�
нять последнюю («чистовую») версию анимации. Этим занимается специаль�
ный художник, подчищающий рисунки аниматора.

Причина, по которой аниматор рисует грубо, заключается в необходимос�
ти большей свободы для поиска нужной анимации, а для этого надо отбросить
заботу о мелких деталях. В нашем случае вы – и аниматор, и ассистент, и худож�
ник�доводчик в одном лице, но, несмотря на это, вам по�прежнему важно разде�
лять эти этапы. Работая «на чистовую», вы только ограничиваете свою анима�
цию (рис. 7.120).
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Анимация действия подразумевает подвижность и чувство движения. Эти
грубо набросанные ключи включают все необходимое для передачи действия.
Когда движение будет устраивать аниматора, он сможет заполнить наброски
достаточным количеством деталей, чтобы художник�доводчик мог закончить
процесс. Мы попытаемся работать в похожей манере. Сделаем наброски нашей
анимации (во Flash или на бумаге для последующего сканирования), а затем
закончим их, когда нас устроят все действия.

Использование образцов моделей

Мы уже говорили о применении образцов моделей в главе о художественном
оформлении. Эти листы представляют образец внешнего вида персонажа.
И снова мы не должны стремиться сделать наши рисунки похожими на чьи�
либо другие, но должны быть уверены в их гармоничности.

Внося небольшие изменения в черты нашего персонажа в процессе филь�
ма, очень легко отклониться от первоначальной модели, так что нужно посто�
янно обращаться к образцу, а при просмотре работы – обращать внимание на
изменения в моделях (рис. 7.121).

Первая версия мальчика – это рисунок с образца, а вторая – нет. Иногда,
пока не всмотришься пристально, различия в моделях бывает сложно заметить.
Здесь же они очевидны, поскольку мы сильно отклонились от модели, нарисо�
ванной рядом. Персонажи трансформировались: глаза поставлены шире, нос
увеличился. Вы и не заметите, как начнете анимировать троюродного брата
своего персонажа! Будьте бдительны!

Появление нужного ощущения

Анимация – не наука о космическом кораблестроении, но она все же не так
проста, как можно было бы подумать. Аниматор – это актер. Его работа – это
человеческое (или, по крайней мере, живое) лицо фильма. Именно с ним в
первую очередь контактирует аудитория. Все остальные важные элементы,
составляющие анимационный фильм, нужны, чтобы создать платформу для
анимации, которая передает сюжет. Вы, аниматор, управляете персонажами,
рассказывая свою историю и вызывая у зрителя чувство сопереживания движу�
щимся картинкам.

Что касается вас
Прочитав эту главу, вы получили базовое представление о традиционных тех�
никах анимации. Что вам следует теперь сделать:

Крепко подумать о том, какие из действий персонажей вашего фильма не�
обходимо анимировать. Пользуясь раскадровкой, как руководством, сделайте
для себя побольше заметок по каждой из эмоций персонажа.

Сделайте наброски линий действия для каждого движения или жеста и вос�
пользуйтесь ими для выбора ключевых поз, которые вы будете рисовать.

Решите, какие части анимации лучше получатся в ограни�
ченной технике, а какие просто нужно нарисовать полностью.

Набросайте каждую секцию ани�
мации так, чтобы у вас были все не�
обходимые детали и информация
для ключевых поз и X�листов.

В нескольких последующих главах
мы перенесем эти техники во Flash, так
что приготовьтесь поработать руками!

ГЛАВА 7 ▼ Принципы анимации Что касается вас

Рис. 7. 120

Рис. 7.121

w
w

w
.k

od
ge

s.
ru

http://www.kodges.ru/


253Анимация движения

Увас уже имеются фундаментальные знания о техниках традиционной
анимации, а также понимание того, как взаимодействуют хороший хро�
нометраж и умелая техника, рождая реалистичную анимацию. Те же

принципы работают и применительно ко Flash�анимации, так что давайте вер�
немся к компьютеру. Мы собираемся применить эти принципы во Flash, чтобы
создать гениальную анимацию.

Как и в традиционной анимации, Flash действует на основе ключевых пози�
ций, вызывая иллюзию плавного движения путем искусного размещения проме�
жуточных изображений. Ключевые позы в нашей анимации находятся в ключе�
вых кадрах временной шкалы Flash, а промежуточные изображения, создаваемые в
программе, также известны под именем анимации.

Анимация движения
В главе о проекте мы рассматривали основы анимации движения и преобразо�
вания изображений в символы, где создали анимацию для некоторых рисунков
из нашей раскадровки, чтобы получить аниматик. Познакомимся поближе с
методами анимации во Flash.

Давайте создадим простой пример анимации прямо сейчас – начнем с про�
стенькой анимации прыгающего мяча, где, помимо собственно анимации, мы
применим несколько технических приемов из главы о принципах анимации,
чтобы действие получилось более реалистичным.

Мяч ударяется о землю и отскакивает обратно. Для придания динамизма
действию мы вытянем мяч при падении, потом сплющим его при ударе и снова
растянем, когда он отскочит, прежде чем приобретет исходную форму и, замед�
лившись, пропадет с нашего экрана и из нашей жизни.

Мы сделали грубый набросок этой анимации, которым будем пользоваться
в качестве образца для размещения ключевых позиций (рис. 8.1).

Анимация

во Flash8Глава
Рис. 8.1

Откройте во Flash новый фильм и при помощи инструмента Oval (Овал)
нарисуйте мяч, увеличивая фигуру и удерживая нажатой клавишу Shift, чтобы
у нас получилась идеальная окружность.

Выделив круг, нажмите F8 или выберите Insert ➤ Convert to Symbol (Встав�
ка ➤ Преобразовать в символ) и превратите его в графический символ. Убеди�
тесь, что точка регистрации находится в центре рисунка, поскольку это помо�
жет нам впоследствии, когда мы начнем вращать его. Этого можно добиться,
щелкнув в центральном квадратике на сетке Registration (Регистрация). Вы
увидите, что он стал черным (рис. 8.2).

Рис. 8.2

В кадре 1 поместите символ примерно в той же позиции, что и первая клю�
чевая позиция нашего подпрыгивающего мячика (рис. 8.3).
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Создайте в кадре 3 новый ключевой кадр и переместите мяч в самую ниж�
нюю точку нашего цикла – позицию 3 (рис. 8.4).

!!! Обратите внимание на то, что мы сделали для этого фильма ТВ;рамку; как уже го;
ворилось в главе о проекте, это хорошая привычка – остерегаться обрезов, несмот;
ря на то что мы работаем во Flash.

Наконец, вставьте третий ключевой кадр в кадр 5 и поместите мяч в позицию 5,
в верхнюю точку подскока. Нажмите F5, чтобы вставить новый кадр в кадр 30.

Теперь щелкните по кнопке Onion Skin (Калькирование), которая распола�
гается внизу основной временной шкалы. Это позволит нам увидеть содержи�
мое кадров, находящихся до и после текущего кадра.

Функция Onion Skin (рис. 8.5) является Flash�аналогом па�
нели с подсветкой, которая представляет собой панель для
рисования, где под стеклянной поверхностью располагается
лампа. Традиционные аниматоры пользуются ею для того, что�
бы иметь возможность увидеть рисунки, находящиеся друг по�
верх друга. Это позволит соблюсти правильные пропорции и
удостовериться, что рисунки соответствуют друг другу.

Модели Onion Skin располагаются слева под временной шкалой. Их две: Onion
Skin и Onion Skin Outline (Калькирование контура), представляющая собой

ГЛАВА 8 ▼ Анимация во Flash Анимация движения

Рис. 8.3

Рис. 8.4

Рис. 8.5

Рис. 8.6
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один из вариантов стандартного режима и позволяющая увидеть рисунки в
виде контуров.

Когда вы щелкнете по кнопке Onion Skin, то сразу увидите, что с обеих сто�
рон красного индикатора кадров сверху временной шкалы появится затенен�
ная область. Она обозначает количество кадров, которые будут видны на рабо�
чем поле. В нашем случае отображаются кадры со второго по седьмой. Вы
можете изменять количество отображаемых кадров, расширяя или сужая серую
область (рис. 8.6).

Теперь нам нужно деформировать мяч, чтобы выразить действие.

Анимация вытягивания и сплющивания

Сначала мы сплющим мяч до овальной формы, которую мы видели в третьей
позиции исходного рисунка. Выберите кадр 3 и, выделив изображение, выбе�
рите на панели инструментов Free Transform (Свободное преобразование)
(рис. 8.7).

Перетаскивая маленький квадрат, находящийся чуть левее центра, растяни�
те круг, а затем воспользуйтесь квадратом сверху, чтобы выровнять фигуру.
Если круг выйдет за пределы базовой линии, просто передвиньте его обратно
при помощи инструмента Arrow (рис. 8.8).

Теперь между тремя позициями мы должны создать интерполяцию – проще
всего это можно сделать, выделив один из кадров между каждой парой ключе�
вых кадров и открыв Property Inspector (Инспектор свойств), если он у вас
еще не открыт. В поле с раскрывающимся списком Tween выберите Motion
(рис. 8.9).

ГЛАВА 8 ▼ Анимация во Flash Анимация движения

Рис. 8.7

Перетаскивая любой из квадратиков, окружающих рисунок, в разных на�
правлениях, вы можете менять форму и размер изображения. Другими слова�
ми, вы можете его вытягивать и сплющивать.

Рис. 8.8

Рис. 8.9

Результат весьма близок к нашему исходному наброску (рис. 8.10).

Рис. 8.10
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Преобразование промежуточных изображений
в ключевые кадры

Главная разница между этой анимацией и нашим рисунком заключается в том,
под каким углом располагаются промежуточные кадры. Мы можем изменить
угол, повернув круги в кадрах 2 и 4, но так можно редактировать только ключе�
вые кадры, так что перед тем, как проделать все эти манипуляции, нам нужно
преобразовать эти кадры в ключевые.

Путем такого преобразования мы можем сделать воспроизведение готово�
го фильма более плавным, поскольку для визуализации серии ключевых кадров
требуется меньшая мощность процессора, чем для промежуточных кадров.

Выделите на временной шкале кадр 2 и нажмите F6 или Insert ➤ Keyframe
(Вставка ➤ Ключевой кадр). Повторите ту же операцию для кадра 4, и вы заме�
тите, что первые два промежуточных изображения превратились в ключевые
кадры (рис. 8.11).

быстро выберите инструмент Free Transform (Свободное преобра�
зование), а затем переключите инструмент только на режимы Rotate
и Skew, щелкнув по соответствующим значкам в секции Options па�
нели инструментов. Это предотвратит случайное масштабирование
изображения (рис. 8.12 и 8.13).

Просто нажмите кнопкой мыши на один из квадратов и повер�
ните рисунок.

!!! Очень важно, чтобы круг вращался именно вокруг своей центральной
точки, что будет означать положение точки трансформации, представ;
ленной маленьким кружком в самом центре. Если ее там нет, то можно
ее туда перетащить при помощи инструмента Arrow, а уж затем пово;
рачивать изображение.

Итак, мы анимировали вытягивание и сплющивание прыгающе�
го мяча при помощи лишь одного символа (рис. 8.14).

ГЛАВА 8 ▼ Анимация во Flash Ключевые позиции

Рис. 8.11

Теперь, чтобы придать этим промежуточным рисункам нужный угол, мы мо�
жем воспользоваться другими полезными функциями трансформации: инстру�
ментами Rotate (Поворот) и Skew (Наклон). При помощи горячей клавиши Q

Рис. 8.12

Рис. 8.13

Рис. 8.14

Теперь, когда мы увидели, как растягивать и сплющивать ключевые позиции
и создавать анимацию движения между двумя экземплярами символа, который
вытягивается и сплющивается, давайте изучим подробнее, как пользоваться
этими приемами для создания более сложной анимации.

Ключевые позиции
Ниже представлены три ключевые позиции сцены, в которой персонаж реаги�
рует на что�то, находящееся за экраном. Поза 1 – это первая ключевая поза,
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вторая поза – подготовительная (или гротескная), а последняя, третья, демон�
стрирует реакцию персонажа (рис. 8.15).

2. В первом ключевом кадре слоя rough сделайте эскиз позы. Можно нари�
совать его прямо во Flash, а можно скачать файл Pose_One.gif с сайта
«friends of ED» (www.friendsofED.com) и вставить его во Flash командой
File ➤ Import (Файл ➤ Импортировать).

3. Если вы пользуетесь импортированными GIF�изображениями, вам нуж�
но будет выбрать Modify ➤ Trace Bitmap (Преобразование ➤ Трассиро�
вать растровое изображение), чтобы преобразовать их в векторную гра�
фику. Это позволит вам упростить калькирование (рис. 8.16).

4. Теперь нам нужно создать два новых ключевых кадра для следующих
ключевых позиций, так что вставляйте два пустых ключевых кадра в
кадры 5 и 10: Insert ➤ Blank Keyframe (Вставка ➤ Пустой ключевой
кадр). После этого нарисуйте или импортируйте вторую ключевую позу,
используя функцию Onion Skin для правильного размещения изображе�
ния (рис. 8.17).Рис. 8.15

Мы начнем анимацию нашего мультфильма с создания слоя обреза, как уже
упоминалось в главе о проекте. Это не всегда необходимо, но, вообще, неплохо
начинать все свои новые Flash�проекты именно с этого.

1. Создайте два новых слоя; один назовите rough (набросок), а другой – cut
off (обрез). В слое cut off воспользуйтесь инструментом Rectangle (Пря�
моугольник), чтобы создать ТВ�рамку вокруг рабочего поля.

Рис. 8.16

Рис. 8.17

5. Если пролистать кадры до десятого, где мы нарисовали следующую позу,
вы заметите, что поза 1 больше не видна. Чтобы увидеть все позы, вам
нужно подправить затененную область за индикатором кадров так, что�
бы она включала все рисунки. Для этого перетащите кружок на конце
этой области к кадру 1 (рис. 8.18).

ГЛАВА 8 ▼ Анимация во Flash Ключевые позиции
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Теперь можно нарисовать конечную позу, обладая возможностью видеть все
предыдущие (рис. 8.19).

мы случайно не изменим их содержимое. Затем установите режим конту�
ра для слоя rough. Он включается квадратиком справа от значка замка.

3. Сделав это, вы увидите, как эскиз на рабочем поле превращается в цвет�
ной контур изображения. Теперь вы можете нарисовать готовую, чистую
ключевую позу поверх наброска при помощи любого метода рисования,
который вам нравится.

4. Мы воспользовались инструментом Brush. Вы можете также прибегнуть
к помощи Line или выбрать пункт меню Modify ➤ Smooth (Преобразо�
вание ➤ Сгладить) (рис. 8.21).

ГЛАВА 8 ▼ Анимация во Flash Ключевые позиции

Рис. 8.18

Рис. 8.19

Доводка во Flash

Как только эскизы поз для каждой сцены будут готовы, следующим этапом нуж�
но довести их до готового вида.

1. Нам нужно создать новый слой поверх слоя rough (набросок), на кото�
ром мы будем рисовать начисто, а также создать новый ключевые кадры
для завершающих рисунков (рис. 8.20).

2. Теперь необходимо подправить параметры слоя. Заблокируйте слой
rough и все остальные слои в сцене, чтобы быть уверенным в том, что

Рис. 8.20

Рис. 8.21

Остальные ключевые позы можно закончить по той же схеме.
5. Flash автоматически подбирает цвет контура для каждого слоя; некото�

рые из них – например, желтый или бледно�голубой – трудно увидеть.
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Чтобы поменять цвет контура слоя, щелк�
ните два раза по прямоугольному символу
данного слоя и выберите любой цвет из па�
литры, которая находится во всплывающем
окне Layer Properties (Свойства слоя) ря�
дом с надписью Outline Color (Цвет конту�
ра) (рис. 8.22).

Помните: если вы хотите скрыть слой,
просто щелкните по точке под значком гла�
за рядом с соответствующим слоем. Если вы
работаете со множеством слоев сразу, то
щелкните по самому изображению глаза,
чтобы скрыть их все, а затем отдельно ото�
бразить нужный слой (рис. 8.23).

6. Когда все рисунки будут готовы, удалите слой с набросками, сначала вы�
делив его, а затем щелкнув по значку мусорной корзины.

!!! Не забывайте – если вы сделали что;то не так, вас всегда выручит функция отмены
действия!

7. Преобразуйте подчищенные ключевые позы в отдельные символы, вы�
делив их и нажав F8. Теперь вы готовы начать анимацию.

Хронометраж
Данные позы изображают классическое растягивание и сплющивание: поза 2 –
типичное сплющивание, а поза 3 – классическое вытягивание. Мы хрономет�
рируем их примерно так, как на рис. 8.24.

ГЛАВА 8 ▼ Анимация во Flash Ключевые позиции

Рис. 8.22

Рис. 8.23

Рис. 8.24

В традиционной анимации рисовальщик промежуточных изображений со�
здал бы на основе этих шкал новые рисунки. В данной сцене получилось бы
семь отдельных рисунков. Наша задача во Flash – свести общее число рисунков
к минимуму, используя их повторно при каждой возможности – это уменьшит
размер файла. Например, в нашей сцене со скачущим шаром мы пользуемся для
изображения всего действия лишь одним ключом. В нынешнем примере мы
воспользуемся примерно тем же подходом, растягивая и сплющивая некоторые
из наших ключей, а затем выстраивая между ними анимацию.

Если вы посмотрите на хронометражную шкалу, то увидите, что нам нужно
одно промежуточное изображение между позициями 1 и 2. Можно переделать
первую ключевую позу, слегка сплющив ее.

1. Вставьте новый ключевой кадр первой позы в кадр 4 (сразу перед второй
позой) (рис. 8.25).
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2. Нажмите Q, чтобы выбрать инструмент Free Transform (Свободное пре�
образование), и сплющите этот новый ключевой кадр, изменив его фор�
му и положение, как мы делали это с нашим мячом. И снова функция
Onion Skin поможет вам разместить рисунок правильно (рис. 8.26).

Так как это тот же рисунок, что и поза 1, только немного видоизменен�
ный, то промежуточное изображение создаст впечатление медленного
перехода от позы 1 к позе 2. Может, переход получится не таким плав�
ным, как при полной прорисовке промежуточного изображения, но он
сработает и к тому же позволит сохранить объем файла небольшим
(рис. 8.27).
Теперь нам нужно применить обратный хронометраж. Иными словами,
движение быстро начинается от позы 1 и замедляется по мере прибли�
жения к позе 2.

3. Вставьте новый ключевой кадр на позе 2 и слегка сплющите его, чтобы
создать иллюзию замедления при подготовке к действию (рис. 8.28).

ГЛАВА 8 ▼ Анимация во Flash Ключевые позиции

Рис. 8.25

Рис. 8.26

Рис. 8.27

Рис. 8.28

Для перехода между позами 2 и 3 нам потребуются три промежуточных
изображения, замедляющие подход к последней позе. Чтобы избавиться
от необходимости прорисовывать что�то вручную, мы можем достичь
нужного эффекта, преобразовав позу 3 под смягчение.

4. Измените позу 3 при помощи опций Rotate и Skew инструмента Free
Transform. Изображение поднимется вверх под определенным углом.
Немного повернув ключ, вы сможете поместить рисунок точно туда, куда
вам нужно (рис. 8.29).
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Чтобы воспользоваться этим видом деформации, выделите изображение
с помощью инструмента Arrow. Нажмите Q, чтобы выбрать инструмент
Free Transform, и щелкните по панели инструментов на опциях Rotate
и Skew. Теперь, удерживая один из квадратиков, находящихся посереди�
не линии (а не на углах), измените позицию изображения. Вы можете
переместить точку регистрации вашего рисунка, чтобы поменять точку,
вокруг которой он будет вращаться, чтобы получить более реалистичные
ракурсы.

5. Теперь тащите позу 3 назад, в седьмой кадр, прямо после нашей измененной
второй позы. Затем вставьте новый ключевой кадр в кадр 10, чтобы у нас по�
явилось место для двух промежуточных изображений. Добавьте анимацию
движения с настройками по умолчанию между кадрами 7 и 10 (рис. 8.30).

Переопределение параметров и доработка

Эта сцена анимирована в самом общем виде. Мы можем внести в анимацию еще
несколько мелких штрихов, чтобы добавить реалистичности. Если вниматель�
но посмотреть на позу 2 – подготовку к действию – то видно, что поскольку это
один цельный рисунок, руки и голова двигаются одновременно, и в нашем пер�
вом экземпляре ключа руки расположены выше, чем во втором, куда перехо�
дит действие (рис. 8.32).

ГЛАВА 8 ▼ Анимация во Flash Ключевые позиции

Рис. 8.29

Рис. 8.30

6. Вставьте еще одну анимацию между кадрами 1 и 5, снова сохранив все ус�
тановленные по умолчанию параметры.

Вот так наша готовая сцена выглядит при просмотре с функцией Onion Skin
(рис. 8.31).

Рис. 8.31

Рис. 8.32
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Поскольку действие происходит чрезвычайно быстро, то все это может не
броситься в глаза. Однако в реальности руки бы двигались в противоположном
направлении: голова – вниз, а руки – вверх (рис. 8.33).

с катящимся кругом, мы увидим, что расстояния между промежуточными изоб�
ражениями, находящимися между переходной и конечной позицией, должны со�
кращаться по мере приближения к конечной позиции – иными словами, дей�
ствие должно замедляться до остановки (рис. 8.35).

ГЛАВА 8 ▼ Анимация во Flash Ключевые позиции

Рис. 8.33

Разделив этот рисунок на два элемента – голову и туловище – мы приобрета�
ем возможность манипулировать ими независимо друг от друга для придания
реализма.

Такой способ анимации действия не потребует дополнительных рисун�
ков, но вам придется вырезать изображение головы и вставить его на дру�
гой слой. Теперь результат будет выглядеть намного лучше, особенно если
это медленное движение, в котором нам нужно связать анимацией две пози�
ции (рис. 8.34).

Рис. 8.34

Регулирование темпа

Чтобы реализовать смягчение при подходе к ключевому рисунку или после него
во Flash, мы можем отрегулировать темп промежуточной анимации, замедляя или
ускоряя ее. Если посмотреть на вторую шкалу хронометража нашего примера

Рис. 8.35

На рисунке точно проиллюстрированы наши слова: по мере того как рисун�
ки в анимации приближаются к конечной позиции, они сближаются друг с дру�
гом, что создает впечатление замедления. Во Flash такая анимация известна как
регулирование темпа, и ею можно легко воспользоваться, если к символу уже
применена анимация движения.

В похожем примере мы создали два ключа и связали их анимацией. По умол�
чанию Flash установил равномерную анимацию. А так как наша цель – есте�
ственное движение, стандартная анимация нам не подходит (рис. 8.36).

Рис. 8.36
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!!! Помните: вы можете применять анимацию движения только к символам из вашей
библиотеки и только к одному из символов на одном и том же слое одновременно.

Чтобы дать команду программе создать анимацию по�другому, нам нужно
отрегулировать темп. Регулятор Ease (Темп) находится в инспекторе свойств,
под полем Tween. Используя бегунок, вы можете изменить темп анимации, за�
медляя или ускоряя ее (рис. 8.37).

ГЛАВА 8 ▼ Анимация во Flash Внезапность и смягчение

Рис. 8.37

Регулятор Ease управляет значениями в диапазоне от –100 до 100. Значе�
ние 0 означает, что никаких изменений с анимацией не произойдет. Вот так
круг будет выглядеть при значении Ease, равном 100 Out (Замедление) –
рис. 8.38.

Рис. 8.38

А так – при Ease, равном 100 In (Ускорение) – рис. 8.39.
Вы видите, насколько по�разному Flash может задавать темп для ваших ани�

маций. Помня об этом, мы можем применить параметр замедления, равный 100,

Рис. 8.39

к нашим заключительным ключам в примере с мультяшным человечком, замед�
ляя его темп до остановки (рис. 8.40).

Рис. 8.40

Внезапность и смягчение
Этот подход к хронометражу сцены сделает действие намного резче. Мы вос�
пользуемся ключевыми позами из последнего примера, лишь слегка вытянув и
сплющив их в конечных ключах.

На рисунке ниже мы можем видеть, как концовка действия смягчается к
финальной позе – самой предельной из всех. Термин внезапность и смягчение в
точности выражает смысл данного приема – резкий переход к самому яркому,
предельному ключу, а затем обратное смягчение к менее резкому (рис. 8.41).
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Разделив элементы, как мы уже поступали с подготовкой к действию, вы
можете добавить в этот вид хронометража дополнительные эффекты. В нашем
случае мы разделили глаза и рот и растягивали их по отдельности (рис. 8.42).

доносит смысл. Сам процесс исправлений и дополнений может занять несколь�
ко часов – даже в фильме из нескольких минут – но это важный этап на пути к
созданию хорошей анимации.

!!! Анимация – главная звезда вашего фильма. Она в наибольшей степени определя;
ет, провалится фильм или будет иметь успех. Уделите ей заслуженное внимание.

Циклы
Читая главу о принципах анимации, мы убедились, сколько времени и усилий
способны сэкономить нам циклы. Точно так же и во Flash. Циклы являются
прекрасным способом минимизировать размер файла путем создания анима�
ции и преобразования ее в символ, а затем использования этого символа снова
и снова.

Чтобы понять свойства циклов как символов, создадим простейший цикл во
Flash (рис. 8.43).

ГЛАВА 8 ▼ Анимация во Flash Циклы

Рис. 8.41

Рис. 8.42

Анимация во Flash похожа на любую другую. Это означает, что анимация дол�
жна создавать интересную и правдоподобную мимику и действие, чтобы получи�
лись персонажи, с которыми зрители могли бы себя отождествлять и которым
бы они симпатизировали. Ключ к успеху – вызвать сопереживание, избежать
неправдоподобности и при этом уложиться в минимальное количество рисунков.

И фильм и сцена в анимации – ваше творение. Протестируйте свою работу,
взляните на нее критически и исправляйте, пока не убедитесь, что она правильно

Рис. 8.43

На этом примере мы видим эскиз автомобиля, колеса которого заставим
вращаться в цикле; причем мы можем не только заставить их вращаться, но и
использовать повторно один цикл для каждого колеса. Можете скачать рису�
нок автомобиля car.gif с сайта «friends of ED».
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Символы и слои

Доработаем машину, разделив ее на два отдельных элемента: корпус и заднее
колесо. Создадим для них отдельные слои. Когда они будут готовы, сохраним
их в библиотеке как символы (рис. 8.44).

Измените его размер и поместите его на место пе�
реднего колеса.

Теперь у нас есть два колеса и всего один символ. Вы
должны стремиться к повторному применению симво�
лов, поскольку это действительно помогает понизить
размер файла (рис. 8.45).

Нам нужно заставить колесо крутиться, так что при�
дется добавить несколько эффектов. Поскольку вра�
щаться должны оба колеса, а для обоих колес у нас ис�
пользуется один и тот же символ, то все эффекты
должны применяться к символу, а не к рисункам на ра�
бочем поле. Так что выделите символ в библиотеке и
щелкните по нему два раза, чтобы перейти в режим
редактирования символов (рис. 8.46).

Открыв временную шкалу для символа, вставьте новый слой и создайте эф�
фект. Это по�прежнему статическое изображение, поэтому нам нужно добавить
еще одно изображение на другой кадр, чтобы обозначить движение.

Вставьте пустой ключевой кадр на кадр 2 слоя с эффектом и ключевой кадр
на слой с колесом (рис. 8.47).

Щелкните по кнопке Onion Skin и нарисуйте новое изображение, слегка
отличающееся от предыдущего, в кадре 2 слоя с эффектом. Теперь мы превра�
тили наш символ в очень простой цикл из двух изображений (рис. 8.48).

ГЛАВА 8 ▼ Анимация во Flash Циклы

Рис. 8.44

Создайте новый верхний слой на временной шкале, в библиотеке выделите
символ заднего колеса и перенесите его на рабочее поле в наш новый слой.

Рис. 8.45

Рис. 8.46

Рис. 8.47
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Если вернуться к сцене, эффект должен подействовать на оба колеса.
Если добавить в сцену дополнительные кадры и провести курсором по вре�
менной шкале, вы сможете увидеть цикл движения. Flash будет проигрывать
символ циклически на протяжении всей сцены. Однако нам нужны еще два
колеса.

Дублирование символов

Теперь для того, чтобы получить не�
достающие два колеса, мы прибег�
нем к дублированию символов. По�
скольку они располагаются с другой
стороны, нам нужно избавиться от
колпаков, но если следовать предла�
гаемой ниже инструкции, то для это�
го нам хватит все того же символа.

Откройте библиотеку, выдели�
те символ колеса, потом откройте
меню в правом верхнем углу и вы�
берите Duplicate (Дублировать)
(рис. 8.49).

Программа попросит вас изме�
нить имя символа, но можно оста�
вить и предлагаемое wheel copy.
Решите этот вопрос и нажмите
OK. Теперь новый символ должен
появиться в вашей библиотеке
(рис. 8.50).

Выделите символ и дважды щелкните, чтобы от�
редактировать его. У вас откроется временная шка�
ла символа нового колеса, который мы хотим очи�
стить от колпака. Поэтому вставьте новый слой и
нарисуйте черную фигуру поверх этого колпака
(рис. 8.51).

Когда вы вернетесь к сцене, вставьте новые слои
для новых колес, перетащите из библиотеки на ра�
бочее поле скопированные символы, подправьте их
размер и поместите их на нужное место. Не забы�
вайте, что эти слои должны находиться ниже и ос�
тальных колес, и корпуса автомобиля.

Удаляйте слой с эскизами – и все готово. Все ко�
леса стали частью одного цикла (рис. 8.52).

ГЛАВА 8 ▼ Анимация во Flash Циклы

Рис. 8.48

Рис. 8.49

Рис. 8.51

Рис. 8.52

Рис. 8.50
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Проблема данной сцены заключается в том, что машина едет, оставаясь на
одном месте, и для нашей анимации пришлось бы провести панорамирование
фона через кадр, чтобы создать иллюзию движения.

Движение через сцену

Скажем, нам нужно, чтобы фон оставался на месте, а машина проезжала через
сцену. Тогда все, что от нас требуется, это преобразовать машину целиком (ко�
леса и все остальное) – в один символ.

Сделать это можно двумя способами: скопировать все отдельные слои и за�
тем создать новый символ, а можно скопировать все отдельные слои на один
слой. Для нашего нового символа мы скопируем их на один слой.

Выделите все слои и скопируйте их, на�
жав Ctrl/ +C, а затем выберите пункт ме�
ню Insert ➤ New Symbol (Вставка ➤ Но�
вый символ).

Поскольку весь наш цикл укладывается в
два кадра, нажмите F6, чтобы вставить новый
ключевой кадр, а затем вставьте в него симво�
лы, составляющие автомобиль. Теперь у вас
есть единый символ автомобиля (рис. 8.53).

Вернитесь к сцене, вставьте
новый слой, найдите в библиоте�
ке новый символ и перенесите его
на рабочее поле.

Удалите все остальные слои – у
вас должен остаться только новый
символ машины. Если провести
курсором по временной шкале, ко�
леса будут вращаться, как и преж�
де. Чтобы машина проехала по сце�
не, вставьте новый ключевой кадр
и разместите два рисунка на проти�
воположных концах экрана. Нако�
нец, создайте между ними анима�
цию движения (рис. 8.54).

В нашем случае мы уменьшили
размер автомобиля, чтобы лучше
продемонстрировать, как будет
выглядеть сцена.

Циклы в перспективе

В нашем последнем примере для цикла автомобиля, проезжающего по экрану,
мы создали промежуточные изображения с ключами одинакового размера. Но
можно нарисовать тот же цикл под другим углом, чтобы машина приближалась
к камере издали. Flash будет воспроизводить и строить анимацию для такого
цикла точно таким же образом (рис. 8.55).

ГЛАВА 8 ▼ Анимация во Flash Циклы ходьбы

Рис. 8.53

Рис. 8.54

Рис. 8.55

Это очень простой пример, но суть вы поняли. Создание любого количества
слоев и кадров в виде символов или внутри одного символа с последующим
размещением их на рабочем поле позволит воспроизводить этот символ снова
и снова, вплоть до конца сцены. В нашем примере цикл состоит всего из двух
кадров, но принципы везде будут действовать одинаково – неважно, сколько в
цикле кадров.

Циклы ходьбы
Основы циклов ходьбы и бега мы обсуждали в главе о принципах анимации, а
в разделе о раскадровке упоминали о том, как путем умелого размещения фигу�
ры в кадре избежать необходимости рисовать полный цикл ходьбы.
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Вспомните также и то, что цикл ходьбы должен включать в себя множество
разных рисунков, каждый из которых увеличивает размер файла, так как Flash
нужно подгружать и воспроизводить новое изображение в каждом кадре, из�за
чего медленные компьютеры могут задерживать воспроизведение анимации.

Между тем иногда бывает просто невозможно избежать необходимости ани�
мировать походку, так что давайте разберем, как это делается.

Цикл ходьбы создается во Flash практически так же, как и рассмотренный нами
выше цикл для машины, только несколько сложнее, поскольку он состоит из не�
скольких рисунков, которые должны двигаться с одинаковой скоростью. Лучше
всего сначала рисовать такие циклы на сцене, а затем копировать и вставлять их
как новые символы, что мы и сделали с объединенным символом машины.

Способ анимации походки будет зависеть в основном от того, как вы нари�
совали персонаж, от предполагаемой скорости ходьбы и общего настроения,
но формула «одна нога напротив другой» подойдет и здесь. В главе о принци�
пах анимации приведены несколько примеров ходьбы и бега, с которыми вы
можете сверяться, рисуя свою ходьбу. Для нашего примера мы воспользуемся
походкой с двойным подскоком.

Мы выполнили первый рисунок из нашего цикла и разбили персонаж на
четыре независимых элемента: ноги, туловище и две руки. Тело и голова будут
двигаться вместе, а руками персонаж будет резко размахивать. Так что, кроме
ног, все элементы помещаются в одном символе, который мы можем переме�
щать и для которого можно строить промежуточные изображения (рис. 8.56).

Затем, сверяясь с сеткой, сделайте рисунки разных положений ног. На этой
иллюстрации они следуют друг за другом, но очевидно, что все они находятся
на одном и том же месте, только в разных кадрах (рис. 8.58).

ГЛАВА 8 ▼ Анимация во Flash Циклы ходьбы

Рис. 8.56

Создайте для анимации ног сетку. Для этого мы воспользовались сеткой из
Flash, где для главных ключей в цикле были отведены по две отдельные клетки.
Промежуточные рисунки будут двигаться со скоростью в одну клетку (рис. 8.57).

Рис. 8.57

Рис. 8.58

1 2 3 то же, что в 1 то же, что в 2 то же, что в 3 то же, что в 1

Поскольку мы нарисовали ноги маленькими и только в виде силуэта, для
полного цикла нам хватит трех рисунков. Преобразуйте рисунки 1–3 в симво�
лы для повторного использования, чтобы компьютеру пришлось загрузить их
всего однажды.

Как выглядит временная шкала для этой сцены, показано на рис. 8.59.

Рис. 8.59

На рис. 8.60 показан просмотр с использованием функции Onion Skin.
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Затем создайте ключи рук и туловища, чтобы они совпадали с положением
ног, вставляя ключевые кадры и изменяя рисунок при помощи инструментов
Arrow и Rotate (рис. 8.61).

ГЛАВА 8 ▼ Анимация во Flash Циклы ходьбы

Рис. 8.60

Рис. 8.61

Все это одни и те же символы, изменено только их положение. Можно уси�
лить подскок в походке, вытягивая и сплющивая изображение (рис. 8.62).

Рис. 8.62

Вставьте пустые ключевые кадры для промежуточных изображений ног
(рис. 8.63).

Рис. 8.63

С помощью функции Onion Skin сделайте эти промежуточные изображе�
ния. Так как мы повторно используем большую часть ключевых рисунков для
ног, нам нужно сделать только первые три, а затем скопировать их и вставить
в соответствующие кадры (рис. 8.64).

Рис. 8.64

Чтобы получить промежуточные изображения для тела и рук, воспользуй�
тесь функцией анимации движения, затем передвиньте слой с рукой на заднем
плане под слой с ногами и удалите слой с сеткой (рис. 8.65).

Рис. 8.65
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Вот и наш цикл. Разделив слои и использовав везде по мере возможности
одни и те же символы, мы смогли создать очень простой цикл ходьбы из две�
надцати рисунков и только девяти символов: туловища, двух рук и пяти разных
ног (рис. 8.66).

ГЛАВА 8 ▼ Анимация во Flash Циклы ходьбы

Рис. 8.66

то же, что в 1 кадре

!!! Чтобы сделать походку более интересной, вы всегда можете анимировать второ;
степенные элементы – например, кисточку на феске нашего персонажа: так как это
всего лишь линия, она ненамного увеличит размер файла. Но в нашем примере мы
оставили ее неподвижной.

Вы можете скачать этот цикл ходьбы с сайта www.friendsofed.com.

Зацикливание

Нам по�прежнему нужно преобразовать цикл в символ, который Flash будет вос�
производить циклически. Все изображения в кадре 13 – копии первого кадра.
Они понадобились нам, чтобы мы могли получить промежуточные состояния
для кадра 12, последнего в цикле. А теперь нам нужно избавиться от кадра 13,

Рис. 8.67

поскольку при воспроизведении цикла первый кадр должен следовать сразу за
двенадцатым (рис. 8.67).

Преобразуйте все промежуточные изображения в кадре 12 в ключевые кад�
ры, выделив их и нажав F6. Затем удалите все кадры в тринадцатом кадре, вы�
делив их и нажав Shift+F5.

Если теперь выделить все кадры цикла и скопировать их – Ctrl/ +C – мы
сможем создать новый символ и вставить их туда, как мы делали это в примере
с машиной (рис. 8.68).

Рис. 8.68

Наш цикл ходьбы окажется в библиотеке, и мы сможем воспользоваться им,
когда вздумается.

Панорамирование циклов ходьбы

Если мы сверимся с исходным рисунком, то увидим, что в нашей сетке все ри�
сунки передвигаются на одну клетку, и поэтому нужно убедиться в том, что и
фон будет панорамироваться на одну клетку за кадр, чтобы совпадать по темпу
с шагом персонажа (рис. 8.69).

Рис. 8.69
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289288 ГЛАВА 8 ▼ Анимация во Flash Анимация диалога во Flash

Если проводить персонаж через экран, нам нужно быть уверенными в том,
что и здесь сохраняются нужные интервалы. Персонаж должен продвигаться
на одну клетку за кадр, то есть на 12 клеток за один полный цикл.

Любые циклы – будь то ходьба, бег или любое другое механическое движе�
ние, вроде крутящегося колеса, являются бесценными инструментами Flash�
анимации. Они экономят время, сохраняют объем файла на невысоком уров�
не, а пользоваться ими во Flash даже проще, чем в традиционной анимации.

Циклы, как и все при создании анимации, должны подвергаться тщательной
проверке, чтобы мы могли быть уверены в том, что они воспроизводятся дос�
таточно гладко (рис. 8.70).

Рис. 8.70

!!! Почаще тестируйте свою работу – даже маленькие сбои в цикле будут сильно раз;
дражать при многократном повторении.

Анимация диалога во Flash
Анимация диалога во Flash напоминает аналогичный процесс в традиционной
анимации. Мы пользуемся одними и теми же формами губ и следуем тем же
фундаментальным принципам. Фактически Flash�анимация – это просто набор
технических приемов, которыми вы пользуетесь снова и снова, исходя из сво�
его знания анимации.

Зная, как разделять слои – например,
губы и глаза – вы значительно упрощаете
себе анимацию диалога во Flash, а умение
сохранять отдельные элементы в виде сим�
волов для последующего использования по�
может вам снизить объем файла и объем ра�
боты, которую вам придется проделать
(рис. 8.71).

!!! Чтобы узнать больше об импортировании звука, в том числе и линий диалога, вер;
нитесь к главе «Проект 2: звук и тестирование». Помните, что если вам требуется
точно синхронизировать звук с анимацией, то следует установить в инспекторе
свойств параметр Stream (Потоковый).

На временной шкале мы видим, что звук импортирован и установлен как
потоковый. Губы располагаются на слое под ним. Проведя курсором по времен�
ной шкале, вы сможете услышать звук в каждом кадре, после чего можете выде�
лить и отобразить форму губ, соответствующую конкретным звукам.

Нужная вам форма губ должна попадать либо точно на тот кадр, где раздает�
ся соответствующий звук, либо кадром раньше. Когда анимируете диалог, про�
играйте его и последите за синхронностью. Иногда во Flash приходится про�
длевать кадры для определенной формы губ – может, на два�три кадра, в
зависимости от скорости вашего компьютера (рис. 8.72).

Рис. 8.71

Рис. 8.72

Кадр 1 Кадр 4

Анимацию диалога мы изучим значительно подробней, когда доберемся до
фильма «Мальчик, который кричал: «Волк!».

w
w

w
.k

od
ge

s.
ru

http://www.kodges.ru/


291290 ГЛАВА 8 ▼ Анимация во Flash Спецэффекты во Flash

Спецэффекты во Flash
Анимационные спецэффекты порой кажутся пунктиком, а то и настоящей ма�
нией некоторых Flash�аниматоров. Новый способ рисования воды или револю�
ционный подход к дыму могут считаться достаточным оправданием для филь�
ма. Может быть – иногда, но вам еще необходимо иметь хороший сюжет и
сценарий. Эффекты – дополнение к анимации и должны применяться если не
дозированно, то хотя бы уместно. Ваша аудитория не застынет в немом восхи�
щении, увидев лишь «самый прогрессивный цикл огня из всех существующих».

Ниже мы приводим некоторые основные эффекты во Flash, при помощи
которых можно достичь разных результатов. Как и в случае с большинством
элементов этой программы, возможный потенциал ограничивается лишь вооб�
ражением пользователя.

Alpha�парметры

Рассматриваемые в данном разделе эффекты подразумевают применение
Alpha�параметров. Мы уже кратко упоминали о них в главе о проекте, когда
обсуждали растворения и затемнения сцен раскадровки. Посмотрим теперь,
как можно применить эти эффекты к нашей анимации.

Падающие тени

Такие тени могут использоваться в сценах, где есть сильный источник света –
например, если персонаж стоит возле огня. Сделать такую тень во Flash очень
просто, и для этого есть несколько способов (рис. 8.73).

Рис. 8.73

Первый из них – создать новый слой поверх слоя с персонажем и нарисовать
при помощи инструмента Brush тень в виде черной фигуры (рис. 8.74).

Рис. 8.74

Выделив тень, преобразуйте ее в символ и отрегу�
лируйте значение Alpha�параметра в инспекторе
свойств. Переместив бегунок Alpha, вы сможете при�
вести внешний вид тени в соответствие со сценой
(рис. 8.75).

Другой способ – нарисовать область тени на от�
дельном слое, как и в примере выше, пользуясь
инструментом Brush, но уже с заданным на пане�
ли цвета значением Alpha�параметра.

Выберите в качестве цвета заливки черный и от�
кройте Color Mixer: Window ➤ Color Mixer (Окно ➤
Палитра цвета) (рис. 8.76).

Если поменять здесь при помощи бегунка значе�
ние Alpha�параметра, эти настройки будут примене�
ны ко всему, что вы впоследствии нарисуете кистью
(рис. 8.77).

Рис. 8.75

Рис. 8.76
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293292 ГЛАВА 8 ▼ Анимация во Flash Учитесь на всем

Рис. 8.77

Тени можно рисовать и при помощи инструмента Pencil,
переключив его в режим Smooth (Плавные линии) (рис. 8.78).

Затем рисуйте прямо поверх изображения, включив оп�
цию Snap To Object (Привязка к объекту), чтобы ваша линия
идеально совпала с контуром объекта. Затем можно восполь�
зоваться палитрой цвета, чтобы заполнить область тени цве�
том чуть темнее, чем предыдущий. Наконец, удалите каран�

дашный контур, и у вас получатся замечательные кривые линии, которые не
нужно перерисовывать (такой метод хорошо подходит для тех, кто пользуется
мышью, когда нарисовать плавную кривую довольно затруднительно).

Какой бы метод вы ни выбрали, важно помнить, что тени лучше приме�
нять внутри символа изображения. Тогда при изменении символа (например,
вытягивании и сплющивании) тень автоматически будет изменяться вместе с
ним.

Отбрасывание теней

Такие тени сделают вашу анимацию более при�
влекательной, причем создаются они по ана�
логии с падающими тенями, только на слое под
персонажем. Будете ли вы создавать эти тени
внутри символа с персонажем или на отдель�
ном слое в сцене – зависит от происходящего
в сцене. Иногда такие тени движутся незави�
симо от анимации: например, если персо�
наж подпрыгнет вверх, тень будет двигать�
ся отдельно (рис. 8.79).

Рис. 8.78

Рис. 8.79

Эффекты отдельных элементов

Иногда в нашей анимации требуются эффекты наподобие дыма, воды, огня и
т.п. Помимо общего дизайна и внешнего вида таких элементов, Alpha�парамет�
ры могут усиливать эффект.

Этот эффект – еще один пример применения Alpha�параметров в нашей ани�
мации; такой дым можно сделать и в виде цикла (рис. 8.80).

Рис. 8.80

Учитесь на всем
Создавая анимацию во Flash, вы можете воспользоваться преимуществами тра�
диционной, и в особенности ограниченной анимации. Это бесценный опыт,
накопленный за долгие годы талантливейшими художниками, который, к счас�
тью, мы можем успешно применять во Flash.

Как вы будете адаптировать эти принципы и до какой степени готовы ими
пользоваться, зависит от целей вашего фильма. Очевидно, полная анимация
предельно увеличит размер файла, так что если этот вопрос важен для вас,
придется анимацию ограничить. Но даже с учетом этих ограничений вы може�
те создать интересный и увлекательный фильм.

!!! Говоря об Интернете, нужно помнить, что нечто движущееся уже гораздо интерес;
нее того, что не двигается. И одно то, что у вас нет времени сотворить анимацию
студийного качества, еще не означает, что никто не будет смотреть ваши произве;
дения.

«Использовать преимущества Flash» означает создавать с учетом ограничен�
ных возможностей программы фильмы, которые превосходят эти ограничения.
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Рис. 8.81

Всегда воспринимайте свою анимацию и фильм как единое целое и думайте о
способах, которыми вы можете улучшить фильм с помощью инструментов,
предлагаемых Flash. Вот секрет хорошего Flash�фильма: экономичность, гиб�
кость, изобретательность. Ставьте перед собой реальные цели – и вы добьетесь
потрясающих результатов.

Что касается вас
Пришел ваш черед применять изученные приемы в собственной анимации.
Позвольте дать вам некоторые рекомендации.

Начните с набросков, это придаст вашему рисованию элемент свободы: если
чересчур беспокоиться о законченном виде рисунков, то есть риск, что они

получатся неестественными.
Растягивайте и сплющивайте свою

анимацию там, где нужно, чтобы
придать рисункам гибкость, а
также пользуйтесь внезапнос�
тью и смягчением для более

реалистичного движения.
Тестируйте, хронометрируйте и дораба�

тывайте свою анимацию. Любые погрешнос�
ти – например, в циклах – всплывут в ито�
говой работе. Лучше всего уладить все эти
вопросы незамедлительно, прямо сейчас

(рис. 8.81).
Если вы делаете фильм для Интернета, постарайтесь свести число ключе�

вых рисунков к минимуму, чтобы сэкономить на объеме файла. Также лучше
редактировать ключевые позиции, нежели создавать новые промежуточные
изображения.

Анимационные решения, которые вы примените, будут определяться целя�
ми вашего фильма. Чтобы у вас сложилось более четкое понимание данного
процесса, в следующей главе мы изучим приемы, применяемые нами при со�
здании «Мальчика, который кричал: «Волк!».

ГЛАВА 8 ▼ Анимация во Flash

Итак, мы изучили большую часть этапов кинопроизводства: от сценария
и раскадровки до создания аниматика. Мы рассмотрели принципы
анимации и разобрали, как приспособить их ко Flash. Теперь погля�

дим, что вы поняли, и как мы будем применять усвоенные уроки при создании
нашего короткого фильма.

Когда мы оставили фильм на стадии аниматика, мы уже установили все ос�
новные движения камеры: панорамы, наезды, затемнения и растворения. Мы
приблизительно хронометрировали все эти движения и создали фундамент, на
котором будет строиться наша анимация. Мы также импортировали звуковые
файлы для всех диалогов и разместили их в соответствующих сценах. На пос�
леднем этапе мы проиграли аниматик, чтобы проверить скорость предвари�
тельного варианта нашего фильма.

А теперь давайте посмотрим, как из этого аниматика получить полноцен�
ный фильм. Мы пройдемся последовательно по каждой сцене и обсудим, как
применить полученные навыки в той или иной сцене и раскрыть возможности
изученного материала несколько полнее.

Все FLA�файлы для этого фильма можно скачать с сайта «friends of ED».
Помимо файла с готовым фильмом есть и FLA�файлы для каждой сцены в от�
дельности. По содержанию они идентичны нашему фильму, однако, возможно,
вам будет проще посмотреть их и изучить по отдельности. Мы рассмотрим ани�
мационные решения и технические приемы по каждой сцене.

Анимация фильма

«Мальчик, который

кричал: «Волк!»9Глава
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297296 ГЛАВА 9 ▼ Анимация фильма «Мальчик, который кричал: «Волк!» Сцена 1

Сцена 1
Эта сцена является нашим вводным кадром, где мы приглашаем зрителя в мир
мальчика, который кричал «Волк!», и знакомим с ним самим. Главными дей�
ствиями в этой сцене служат движения нашей камеры; их основная механика
уже задана с помощью панелей раскадровки в главе о проекте, но, как мы уже
упоминали в главе о раскадровке, все фоны будут создаваться на нескольких
слоях, которые затем будут панорамироваться с разной скоростью для прида�
ния сцене большей перспективы. Отсюда и начнем.

Панорамы

Откройте файл bcw.sc01.fla – законченный вариант нашей вводной сцены. Мы
подчистили наброски и создали отдельные слои для большинства различных
элементов.

!!! После того как сделаете готовый рисунок начисто, не забудьте удалить импортиро;
ванные из раскадровки изображения – они будут только занимать пространство и
замедлять фильм.

Если проиграть этот FLA�файл, то можно увидеть, как разные слои движутся
с разной скоростью, – присмотритесь, например, к дереву на переднем плане.

Все слои панорамируются одинаковое количество времени, начиная с 50�го
кадра и заканчивая в 125�м. На каждом слое есть панорама, начинающаяся в кад�
ре 50 и оканчивающаяся в кадре 125, как видно из временной шкалы (рис. 9.1).

Когда эта панорама была сделана в первый раз, все элементы в ней двига�
лись с одной скоростью; мы придали им разные скорости, поменяв конечную
позицию для каждого слоя.

К примеру, ближайшее дерево продвигается по сцене несколько дальше, чем
горы, но в течение того же количества кадров. Посмотрите на стартовую пози�
цию более внимательно и отметьте положение дерева по отношению к горам.
Если затем посмотреть на конечную позицию в кадре 125, то станет заметно,
что расстояние между ними изменилось: дерево «уехало» намного дальше, чем
горы, иными словами, оно двигалось быстрее. То же самое относится и к слою
с небом, только наоборот – он двигался медленнее. Земля и деревня панорами�
ровались с одинаковой скоростью.

Разбив фон на отдельные слои, вы можете попробовать множество разных
вариантов скорости панорамирования, чтобы получить наилучший эффект.

Рис. 9.1

Начало панорамирования

Конечная позиция панорамирования
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Циклы

Вы можете заметить, что если смотреть на временную шкалу, на ней не найдет�
ся отдельных слоев для мальчика и овец, потому что мы совместили их со сло�
ем земли, так как скорость панорамирования у них одна.

Чтобы этого добиться, мы создали символы овцы и мальчика, а затем пере�
тащили их из библиотеки в символ земли, когда он находился в режиме редак�
тирования символов. В символе земли мы разместили их в нужных точках.

Это – временная шкала символа земли. Как вы видите, в этом символе не
просто содержится статичный рисунок – тут находится сразу несколько слоев
овец, и в длину он составляет 22 кадра, поскольку символ овцы является цик�
лом (рис. 9.2).

Чтобы Flash воспроизводил цикл овцы внутри символа земли, в нем должно
содержаться такое же количество кадров, что и в цикле. По сути, символ земли
сам становится циклом.

Это может показаться запутанным, но все, что у нас есть, это цикл овцы внут�
ри символа земли, который сам располагается на главной сцене. Чтобы понять
все это, попробуйте сами посмотреть на элементы в этой сцене во FLA�файле.

Этого же эффекта можно добиться и при помощи символов�клипов, но мы
решили пользоваться графическими символами, чтобы иметь возможность
просматривать наши циклы, пробежавшись по временной шкале. Если бы наш
«жевательный» цикл создавался в символе�клипе, то Flash воспроизводил бы
его лишь в одном кадре символа земли.

Звуковые эффекты

Не надо забывать и о том, что мы уже импортировали и вставили некоторые
звуковые эффекты в эту сцену. Звуковые эффекты в таких вводных кадрах
очень помогают создать атмосферу.

В Инспекторе свойств мы установили звуку поющих птиц параметр Stream,
поскольку используем его лишь однажды, а звук длинный. А вот блеянье овец
переключено в режим Event (Событие), поскольку этот короткий звук будет
повторяться несколько раз.

Неважно, каким способом вы создали свои звуковые эффекты (достали в
бесплатных библиотеках, сидели с диктофоном в поле или издавали звуки са�
мостоятельно), – принципы их размещения будут одинаковы.

Сцена 2
Чтобы просмотреть эту сцену, откройте bcw.sc02.fla. Создавая наш аниматик,
мы уже говорили о создании привязки для этой сцены. Привязка служит лишь

ГЛАВА 9 ▼ Анимация фильма «Мальчик, который кричал: «Волк!» Сцена 2

Рис. 9.2

Некоторые аниматоры пользуются для этих целей не графическими, а сим�
волами�клипами. В некотором смысле это проще, поскольку так вам не нужно
удлинять временную шкалу (символ�клип воспроизводится на собственной суб�
шкале). Но мы обнаружили, что такой метод очень сильно усложняет хроно�
метраж анимации, поскольку приходится помнить в точности, сколько време�
ни длится каждый клип, – а все графические символы видно сразу.

Овца

Здесь приводится временная шкала для символа жующей овцы. На ней есть три
уровня: shadow (тень), body (туловище) и head (голова), которые мы анимиро�
вали и составили из них цикл жевания длиной в 22 кадра – и все при помощи
лишь одного рисунка. Затем мы вставили несколько экземпляров этого цикла
на временную шкалу символа земли (рис. 9.3).
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для того, чтобы убедиться, что положение последнего кадра текущей и перво�
го кадра последующей сцены останутся прежними, что позволит нам избежать
нарушений плавности воспроизведения и «равных» переходов.

Если посмотреть на первый кадр этой сцены, то можно увидеть, что мы
использовали символ мальчика из первой сцены, увеличив его соответственно
масштабам новой сцены. И пусть он отображается на экране на протяжении
всего двух кадров – это все равно поможет зрителю понять переход.

Мы сделали для этой сцены новый фон так, чтобы он приблизительно совпа�
дал с положением фона в сцене 1. Для повторного использования может подой�
ти и тот же самый фон, но при переходе к таким крупным планам лучше всего
сделать новый, линия горизонта которого будет отличаться от прежнего.

Если вы посмотрите на кадры с третьего по шестой, то заметите, что для
анимации мальчика мы применили технику вытягивания и сплющивания. Раз�
делив туловище и голову по соответствующим слоям, мы смогли анимировать
их независимо друг от друга и придать анимации более естественный вид.

Сцена 3
Для этой сцены у нас приготовлен файл bcw.sc03.fla. И в этой сцене мы прибег�
ли к классической технике внезапности и смягчения, применив ее к крестья�
нину слева (рис. 9.4).

Персонаж, пробегающий через сцену, – это ста�
тический рисунок, который мы панорамировали
слева направо при помощи анимации движения.
Чтобы он побежал обратно – справа налево – мы
просто перевернули его, выбрав в меню Modify ➤
Transform ➤ Flip Horizontal (Преобразование ➤
Трансформировать ➤ Перевернуть горизонтально)
(рис. 9.5).

Затем мы слегка увеличили данный персонаж и
поместили его на верхний слой, чтобы он казался
ближе. Есть и более тонкие способы добиться это�
го результата, однако поскольку движение доста�
точно быстрое, а на сцене происходят действия,
которые сильнее бросаются в глаза, наш метод
тоже сойдет.

Сцена 4
В этой сцене демонстрируется, насколько хороший эффект может производить
разделение элементов лица. Откройте файл bcw.sc04.fla и обратите внимание
на то, как глаза и рот настроены на независимое от остальной части головы
действие, что придает анимации хороший вид и очень полезно при анимации
диалога движущегося персонажа.

Если посмотреть на губы мальчика в данной сцене, то можно заметить, что
они движутся отдельно от головы, а для анимации целой сцены нам понадоби�
лись только две формы губ и анимация движения.

Как всегда, заботясь об экономичности и объеме файла, мы повторно ис�
пользовали небо из предыдущих сцен.

В конце сцены мальчик моргает (рис. 9.6).

ГЛАВА 9 ▼ Анимация фильма «Мальчик, который кричал: «Волк!» Сцена 4

Рис. 9.4

Для всех остальных крестьян хватило простого, но эффективного приема: мы
использовали моргания в качестве гротеска, а потом отделили губы, которые
преобразовали в простой цикл из двух рисунков, из которого получился крик.

Рис. 9.5

Рис. 9.6
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Моргание может быть использовано по завершении фразы как замечатель�
ный способ избежать впечатления внезапной окаменелости лица персонажа.

Сцена 5
В процессе производства фильма вам нужно постоянно искать способы повтор�
но использовать символы как можно чаще. Из файла bcw.sc05.fla видно, что
сцена 5 весьма похожа на сцену 3, следовательно, мы использовали там многие
прежние элементы (рис. 9.7).

в кадрах 6–17. Это шатание затрагивает все слои изображения мальчика – его
рот, глаза, голову и тело (рис. 9.8).

ГЛАВА 9 ▼ Анимация фильма «Мальчик, который кричал: «Волк!» Сцена 6

Рис. 9.7

Сцена завершается классическим затемнением до черного цвета. Оно было
создано путем рисования прямоугольника, охватывающего основное рабочее
поле на протяжении интервала с 21�го по 35�й кадры. Как вы можете заметить,
значение Alpha�параметра прямоугольника составляет 0 в кадре 21, а на протя�
жении последующих кадров его прозрачность постепенно понижается.

Сцена 6
Мы затрагивали принципы шатания и их расположения на хронометражной
шкале в главе о принципах анимации. Если посмотреть на сцену 6 (bcw.sc06.fla),
то можно увидеть, что для анимации лица мальчика было применено шатание

Рис. 9.8

Шатание

Давайте быстренько разберемся, как сделать его во Flash.
Создайте два ключевых кадра: один в первом кадре, а другой – в пятом. По�

местите в оба кадра одинаковые символы. Чуть подправьте второе изображе�
ние, вытянув его.

Затем сделайте анимацию движения, установив параметр Ease в положе�
ние 100 Out (рис. 9.9).

Рис. 9.9

Теперь все промежуточные изображения нужно преобразовать в ключевые
кадры. Для этого выделите эти изображения и нажмите F6 (рис. 9.10).
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Если бы мы пронумеровали эти ключевые кадры от 1 до 5, то хронометраж
сцены следовал бы в данный момент порядку 1, 2, 3, 4, 5.

Теперь нам нужно скопировать и вставить их на временную шкалу в ритме
шатания, который мы обсуждали в главе о принципах анимации. Ритм будет
следующим: 1, 2, 3, 2, 3, 4, 3, 4, 5, 4, 5 (рис. 9.11).

Заметьте, что мы задержали гротеск (моргание второго крестьянина), что�
бы не все крестьяне реагировали одновременно – это производит более реали�
стичный групповой эффект.

Замена символов

Эта техника отлично подходит при анимации
диалогов, когда вам нужно создавать разные фор�
мы губ для персонажей, которые используются
повторно. Продублируйте уже существующий
символ губ, а затем отредактируйте его.

Вставьте новый слой поверх уже существую�
щих губ и сделайте на той же позиции новый
рисунок, а затем удалите старый.

Чтобы избежать путаницы, переименуйте
этот новый символ соответственно новой форме
губ. Затем возвращайтесь к сцене, где вам нужно
вставить новые губы, выделите старые губы и,
убедившись, что они подсвечены рамкой на экра�
не, щелкните правой кнопкой мыши (Ctrl�щел�
чок в Mac) и выберите в меню пункт Swap
Symbol (Заменить символ) (рис. 9.12).

Появится новое окно, содержащее список
символов из библиотеки, где вам нужно выбрать
новую форму губ, чтобы Flash заменил старый
рот новым.

Иногда приходится создавать новые слои и копировать символы, которые
вы хотите заменить, в этот новый слой, особенно если заменять символ, к ко�
торому была применена анимация движения.

Такой техникой можно пользоваться для любого количества символов –
глаз, рук и вообще чего угодно.

Сцены 8, 9 и 10
Чтобы изучить эти сцены, просмотрите файлы bcw.sc08.fla, bcw.sc09.fla и
bcw.sc10.fla. И снова в этих сценах применяются символы из предыдущих сцен.
В сцене 8 обратите внимание на то, как используются отдельные элементы – в
нашем случае голова и тело, которые движутся независимо друг от друга, созда�
вая маленький, но забавный штрих в сцене с хихикающим мальчиком.

ГЛАВА 9 ▼ Анимация фильма «Мальчик, который кричал: «Волк!» Сцены 8, 9 и 10

Рис. 9.10

Рис. 9.11

Так что в показанных здесь кадрах с 1�го по 11�й ключевые кадры будут рас�
полагаться именно в таком порядке: 1, 2, 3, 2, 3, 4, 3, 4, 5, 4, 5.

Сцена 7
В сцену 7 (bcw.sc07.fla) вновь перекочевало множество элементов из сцен 3 и 5,
за исключением нескольких новых форм губ. Если сравнить временную шкалу
со шкалой из файла bcw.sc05.fla, вы увидите, что она была заново хронометри�
рована, чтобы совпадать с новым диалогом в сцене 7, но и элементы, и их по�
ложение остались прежними.

Копирование кадров для повторного использования сцены

Вам неплохо было бы попробовать сделать это самим. Если согласны, снова
откройте файл bcw.sc05.fla и нажмите Ctrl/ +Alt+A, чтобы выделить все кад�
ры в сцене 5.

Затем нажмите Ctrl/ +Alt+C, перейдите в сцену 7 и, выделив первый кадр
в сцене, вставьте кадры (Ctrl/ +Alt+V).

Теперь сцена 7 в точности совпадает со сценой 5. Вам еще остается поме�
нять хронометраж персонажей, чтобы он совпадал с диалогом в новой сцене.

Рис. 9.12
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Сцена 9 заимствует элементы из предыдущих сцен, при этом у них меняется
размер и темп, чтобы получился предельно крупный план (рис. 9.13). Сцена 11

Наша заключительная сцена (bcw.sc11.fla) представляет собой комбинацию
сцен 11 и 12 из исходной раскадровки. Для перехода между ними мы примени�
ли растворение.

Проблемы с растворениями
При создании растворений во Flash нужно помнить, что если вы понижаете
значение Alpha�параметра для изображений, состоящих сразу из нескольких
символов, то получить настоящее растворение (два цельных рисунка, пропада�
ющих и проявляющихся) вам не удастся. Flash будет растворять каждый сим�
вол как отдельный рисунок, и во время растворения вы увидите контуры каж�
дого символа (рис. 9.15).

ГЛАВА 9 ▼ Анимация фильма «Мальчик, который кричал: «Волк!» Сцена 11

Рис. 9.13

В сцене 10 снова показана реакция крестьян, и снова здесь используются
элементы из сцен 5 и 7, однако мы поменяли темп анимации и выражение глаз
персонажей.

Для этого мы продублировали имеющиеся глаза, придали им выражение
нескрываемого раздражения и воспользовались функцией Swap Symbol (Заме�
нить символ), чтобы вставить их в сцену (рис. 9.14).

Рис. 9.14

!!! Из этого примера следует, что, изменив лишь выражение глаз, можно абсолютно
поменять восприятие лица так, что будет казаться, будто и форма губ также изме;
нилась, хотя на самом деле этого не произошло. Перед вами способ добиться нуж;
ного эффекта, сэкономив на объеме файла и анимации.

Рис. 9.15

Если вы посмотрите на область, где рубашка накладывается на штаны, то ясно
увидите оба отдельных символа – вот это и составляет проблему, которая, к не�
счастью, имеется во Flash с растворениями. В нашем случае, если посмотреть
фильм, то это будет не так заметно, поскольку в этом месте у нас поверх осталь�
ных расположен цельный одиночный символ, подвергающийся затемнению.
Если тщательно продумать, где и как использовать растворения и затемнения во
Flash, то нет никаких причин их не использовать – как всегда, хорошее планиро�
вание и практика помогут вам решить большую часть проблем с анимацией.

Приемы панорамирования
Еще одно основное движение камеры в данной сцене – это панорамирование
фона. Причем в отличие от первой сцены, где мы проводим камеру по фону,
здесь мы, так сказать, панорамируем фон перед камерой.
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Всегда полезно подумать о том, чтобы разделить фон на отдельные элемен�
ты, дабы попытаться минимизировать число рисунков, которые программе
придется перемещать, поскольку это поможет избежать замедленного и рвано�
го панорамирования.

В нашей сцене фон сделан из статичной серой цветовой карты, а также не�
больших облаков, которые проходят через сцену, создавая впечатление, будто
двигается весь фон (рис. 9.16).

Мы постарались сделать этот фильм по возможности проще и включили в
него большинство основных движений камеры, а также технических приемов
и советов по анимации, которые сочли полезными.

Как мы неоднократно упоминали, здесь нет «правильных» и «неправиль�
ных» способов, но общие принципы необходимо понимать, чтобы суметь най�
ти наиболее эффективные способы реализации своих идей.

Поскольку мы снабдили вас и Flash�файлами для этого фильма, то все, что
нам не удалось охватить в тексте, вы сможете выяснить сами, изучив прилагаю�
щиеся файлы. Лучший способ чему�то научиться – понаблюдать, как это дела�
ют другие. Если вы столкнетесь с какими�то конкретными затруднениями, то
всегда можете обратиться по адресу support@friendsofED.com – мы будем рады
получить от вас весточку.

Но, само собой, мы еще не закончили. Фильм�то мы сделали, и это не может
не радовать, но какой в нем смысл, если никто его не увидит? Если только вы
не намереваетесь пригласить каждого зрителя к себе домой лично (а, зная не�
которых из них, мы вам этого не советуем), вам придется показать фильм миру.
Именно поэтому в следующей главе мы рассмотрим процессы публикации и
выпуска вашего произведения.

Что касается вас
Надеемся, ваш Flash�фильм уже готов, но даже если возникли какие�то сложно�
сти, воспользуйтесь возможностью сравнить свой результат с нашим и посмот�
рите, не найдете ли вы там для себя ничего полезного. Вы сможете мгновенно
узнать то, над чем другие Flash�аниматоры бились неделями и месяцами – под
другими, разумеется, мы подразумеваем себя! Напомним, что к данному момен�
ту у вас должен иметься законченный FLA�файл с филь�
мом, который воспроизводится без без помарок и
содержит все движения камеры, анимацию и
звук, которые вы предусмотрели.

Теперь вы готовы начать серьезно поду�
мывать о выпуске своего фильма – в Интер�
нете или на видеокассете. Вот этим мы и
займемся в следующей главе.

ГЛАВА 9 ▼ Анимация фильма «Мальчик, который кричал: «Волк!» Что касается вас

Рис. 9.16

Советы по наездам камеры

На что еще стоит обратить внимание в этой сцене, так это на наезд. Если по�
смотреть на слой с мальчиком, то можно увидеть, что, поскольку анимация
была создана в виде цикла, нам нужен только один экземпляр данного символа,
который и будет постоянно повторяться.

Когда мы вставим в соответствующие точки ключевые кадры для отъезда и
создадим анимацию движения, Flash будет автоматически проигрывать каждый
кадр цикла одновременно с отъездом. Это очень полезная функция, привыкнув,
вы будете применять ее неоднократно.

Мы выполнили этот отъезд на основе нашего аниматика, в самой общей фор�
ме. Другой способ создать такой отъезд – комбинирование всех слоев в один
символ, с последующим созданием отъезда для этого символа на одном слое.

Пользуясь нашим методом, вы сбережете много времени, но предваритель�
но нужно убедиться, что вся анимация внутри символа работает правильно и
ее длительность соответствует сцене.

Первый просмотр
Теперь, когда вы исследовали каждую сцену нашего фильма в отдельности, от�
кройте весь фильм целиком во Flash (это файл the boy who cried wolf.fla) и про�
верьте его. Думаем, вы согласитесь, что он стал весьма хорош.
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другом формате, нежели стандартный SWF�формат, то вам нужно подумать над
одним из этих вариантов. Выбор во многом будет зависеть от типа программ�
ного обеспечения, которое вы намерены использовать для монтажа или пере�
носа на кассету. Мы рассмотрим способы выпуска вашего фильма на видео в
данной главе ниже.

Подготовка для Интернета
Прежде чем выложить свой фильм в сеть на всеобщее обозрение, осталось
предпринять еще несколько важных шагов. Когда люди просматривают по
Интернету ваш фильм, он начинает воспроизводиться автоматически. К несча�
стью, в отличие от тестового просмотра SWF�файла на вашем компьютере, у
зрителей не будет полного фильма, сохраненного на жестком диске, поэтому
им придется смотреть его по мере загрузки на компьютер. И если скорость
интернет�соединения невысока, то фильм будет останавливаться, пока в ком�
пьютер не загрузятся остальные кадры.

Эта проблема решается путем создания загрузочной сцены для фильма. Эта
сцена может воспроизводиться, пока не будет загружена часть фильма, доста�
точная для плавного воспроизведения, а может ждать, пока не загрузится весь
фильм, чтобы он точно воспроизводился без остановок. Выбор за вами, но
лично мы посоветуем последнее, хотя техника создания такой сцены тут одна
и та же, так что давайте изучим непосредственно сам процесс.

Предзагрузка

Загрузочная сцена, или предзагрузка, предотвратит начало воспроизведения
фильма, пока в компьютер зрителя не будет загружена достаточная для беспе�
ребойного воспроизведения часть.

Но как нам узнать, какой части будет достаточно? Чтобы выяснить это, нам
нужно заглянуть в профайлер пропускной способности. Он покажет, как идет
фильм, то есть насколько быстро он загружается и будет ли останавливаться в
ожидании подгрузки конкретных кадров.

Если сейчас ваш фильм открыт, вам будет проще понять, о чем речь. Если
хотите увидеть те же данные, что и у нас, то откройте the boy who cried wolf.fla
(скачанный с www.friendsofED.com).

Чтобы увидеть профайлер пропускной способности, сначала запустите тест
своего фильма, нажав Ctrl/ +Enter. Потом выберите View ➤ Bandwith Profi�
ler (Профайлер пропускной способности) (рис. 10.1).

Выпуск

и публикация10Глава

Теперь, когда вы закончили работу над фильмом, пришло время снискать
заслуженную славу и почет, выпустив и опубликовав его – в Интернете
или на видео. В данной главе мы рассмотрим некоторые доступные вам

опции и обсудим наилучший способ продемонстрировать ваш шедевр восхи�
щенной публике.

Первое, над чем стоит задуматься: намерены ли вы показывать свой фильм
по Интернету или собираетесь использовать пакет видеомонтажа для публика�
ции видеофильма? К первому варианту прибегает большинство людей, начина�
ющих во Flash�анимации. Это весьма недорогой и легкий путь пробиться во
внешний мир, и, кто знает, может быть, вскоре вы приобретете себе предан�
ных фанатов.

По умолчанию, Flash выпустит ваш фильм в виде SWF�файла, предназначен�
ного для Shockwave Flash. SWF�файлы можно воспроизводить в программе Flash
player; если вы ориентируете свой фильм на искушенную в сетевых делах ауди�
торию и предполагаете, что они регулярно бороздят просторы Интернета, то
логично будет предположить, что у большинства ваших зрителей уже будет ус�
тановлен Flash player 5.

Впрочем, ваши возможности не ограничены одним только SWF�форматом,
фильм можно выпускать и во множестве других различных типах файлов, в
число которых входят: QuickTime MOV, AVI или последовательность графичес�
ких изображений наподобие JPEG или BMP – список может быть продолжен.
Если вы собираетесь публиковать фильм для видео или Интернета, но в каком�то
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Над вашим фильмом появится график. Он показывает каждый кадр фильма
и сколько данных нужно загрузить для данного кадра, прежде чем его можно
будет проиграть. В профайлере также отображается длительность фильма в
секундах, количество кадров и общий размер файла.

Красная линия внизу графика изображает объем файловых данных за кадр,
при загрузке которого фильм будет воспроизводиться бесперебойно. В нашем
случае мы установили скорость загрузки, исходя из наличия у пользователя
модема 28,8 Кбит, то есть на уровне 200 бит.

Здесь вы можете задать свои установки. Выбрав Debug ➤ 56k (4,7 Кб/с) (От�
ладка ➤ 56 Кбит (4,7 Кбит/с)), вы устанавливаете скорость для модема 56 Кбит,

та же процедура подходит и для других значений скорости. Мы предпочитаем
пользоваться установками для модема 28,8 Кбит, поскольку так фильм смогут
посмотреть все, кроме тех, у кого связь чересчур уж медленна (рис. 10.2).

ГЛАВА 10 ▼ Выпуск и публикация Подготовка для Интернета

Рис. 10.1

Рис. 10.2

Если посмотреть на профайлер пропускной способности, то можно увидеть,
что объем файловых данных очень высок в кадре 1 и составляет от 16 до 32 Кб.
Это объясняется тем, что здесь загружаются все символы, используемые в пер�
вой сцене, в том числе и звуки�события. Затем объем значительно падает, по�
скольку Flash повторно использует все те же символы вплоть до конца текущей
сцены, так что до начала новой сцены нет никакой необходимости загружать
новые изображения. Разумеется, в начале новой сцены нас вновь ждет резкое
повышение файлового объема.

Если выделить любой кадр в профайлере пропускной способности, Flash
немедленно перенесет вас туда, так что вы увидите, в чем заключаются пробле�
мы воспроизведения.

Чтобы проверить, как ваш фильм будет показываться в Интернете, выбери�
те в меню View ➤ Show Streaming (Вид ➤ Показать поток).

Вы увидите, что Flash воспроизведет фильм в точности так, как если бы его
смотрели по сети. Заметьте, как он приостанавливается в ожидании загрузки
кадров, а затем продолжает идти. Именно эти проблемы мы будем решать при
помощи загрузочной сцены.

Создание предзагрузки
Вам наверняка приходилось видеть миллионы различных загрузочных сцен –
впечатляющих, забавных, а иногда и просто сумасшедших. Неважно, как они
выглядят, – по сути, все они выполняют одну и ту же функцию. Для начала мы
сделаем очень простую сцену. Наша цель – текст, мигающий во время загрузки
фильма: три кадра его видно, три кадра – нет.
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Самый надежный способ сделать предзагруз�
ку – убедиться, что весь фильм загружен на ком�
пьютер пользователя. Посмотрим, как этого до�
биться.

1. Для загрузочной сцены мы создадим новую
сцену и разместим ее перед сценой 1. Для это�
го перейдите к сцене 1 и выберите в меню
Insert ➤ New Scene (Вставка ➤ Новая сце�
на), назвав новую сцену loading (загрузка).

2. Чтобы поместить ее перед сценой 1, выбе�
рите Window ➤ Scene (Окно ➤ Сцена),
чтобы вызвать окно выбора сцен. Затем
наведите курсор на новую сцену с загруз�
кой, нажмите левую кнопку мыши и помес�
тите ее перед сценой 1, так она окажется в
начале фильма (рис. 10.3).

3. В сцене загрузки вставьте ключевой кадр в
кадре 1 и еще один – в кадре 6. В кадре 1 вы�
берите шрифт по вкусу и наберите loa�
ding (загрузка) посередине рабочей области.

9. Измените параметры так, чтобы они совпадали с теми, что приведены
на рис. 10.6.

ГЛАВА 10 ▼ Выпуск и публикация Подготовка для Интернета

Рис. 10.3

4. Шрифт, которым мы воспользовались, называется Mirisch (мы пользуем�
ся им довольно часто, как можно увидеть на www.funnyazhell.com). Если
пользоваться таким нестандартным шрифтом, это может незначительно
сказаться на размере файла. Если же он станет непозволительно боль�
шим, то лучше выбрать один из трех верхних шрифтов, которые предла�
гаются в раскрывающемся меню. В начале названия каждого из них нахо�
дится символ подчеркивания ( _ ).

5. Вставьте пустой ключевой кадр в кадр 4.
6. Добавьте еще один слой, который предназначается для наших действий,

командующих сцене, что делать. Назовите его action (действие), а дру�
гой наш слой – font (текст).

7. Теперь вставьте ключевой кадр в кадр 6 слоя action (рис. 10.4 и 10.5).
Во�первых, мы хотим, чтобы сцена повторялась снова и снова, пока
фильм загружается. Для этого нам придется вставить в наш фильм дей�
ствие управления фильмом.

8. Выделите кадр 6 слоя action, а затем нажмите F9 или перейдите к Win�
dow ➤ Actions (Окно ➤ Действия), чтобы открыть панель действий вни�
зу экрана. Выберите Actions ➤ Movie Control (Действия ➤ Управление
фильмом) и дважды щелкните по слову goto.

Рис. 10.4 Рис. 10.5

Рис. 10.6

Здесь мы добавляем фрагмент программного кода ActionScript gotoAnd�
Play(1); в кадре 6. Мы сообщили Flash, что в кадре 6 текущей сцены,
нашей сцены загрузки, он должен вернуться в кадр 1 и начать воспроиз�
ведение заново.

!!! Это действие означает, что каждый раз, когда сцена доходит до шестого кадра, она
вернется к первому кадру и будет проигрываться снова и снова в бесконечном цикле.

10.Теперь вернемся обратно к временной шкале и выделим кадр 1. Вы долж�
ны заметить маленькую букву a в окне кадра 6, которая означает, что в
кадр было добавлено нужное действие.
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11.Вернитесь к панели Actions (Действия) и выберите Actions ➤ Conditi�
ons/Loops (Действия ➤ Условия/Циклы), а затем дважды щелкните по
if (рис. 10.7).

Условие, которое нам нужно, звучит так:

Количество загруженных кадров больше, чем количество кадров, указанное
в предзагрузке

К счастью, во Flash есть функция, которая будет вычислять количество
загруженных кадров сама (это _framesLoaded).

12.Введите в условии _framesLoaded > 500 (или любое число по вашему
выбору) (рис. 10.8).

ГЛАВА 10 ▼ Выпуск и публикация Подготовка для Интернета

Рис. 10.7

Вам нужно ввести в окне условие, которое будет определять, загрузилась
ли достаточная часть фильма.
Какое именно число вы введете здесь, зависит от вас. Если ввести точ�
ное количество кадров, составляющих весь фильм (в нашем случае – 534),
то вы добьетесь оптимального быстродействия на любом компьютере,
однако время загрузки увеличится. Наша задача – найти оптимальный ба�
ланс.

!!! Если ваша целевая аудитория, скорее всего, владеет старыми компьютерами, то
надежнее будет ввести полное число кадров – кроме того, так мы избавляемся от
всей этой возни с угадыванием и тестированием, которая нас ждет.

«Оптимальный» баланс будет зависеть от вашего фильма и скорости его
проигрывания, так что вам обычно придется провести несколько тестов,
прежде чем вы его отыщете. Начните с числа, примерно равного поло�
вине от общего количества кадров в фильме.
Если ваш фильм длится 1000 кадров, задайте число 500. Именно так мы и
поступим сейчас.

Рис. 10.8

Теперь мы должны объяснить Flash, что именно нужно делать после того,
как кадр 500 будет загружен. В нашем случае нам нужно, чтобы начал вос�
производиться кадр 1 первой сцены фильма.

13.Так что переходите к Actions ➤ Movie Control (Действия ➤ Управление
фильмом) и щелкайте по goto.

14. Поставьте в поле с раскрывающимся списком Scene (Сцена) сцену 1 (рис. 10.9).
15.Убедитесь, что выделено Go to and Play (Перейти и воспроизвести).

Текст ActionScript в этой панели теперь выглядит так:

if (_framesLoaded > 500) {
gotoAndPlay(“Scene 1”, 1);
}

Если вы решили действовать наверняка и выбрали вариант с загрузкой пол�
ного фильма, то ваша предзагрузка закончена. Остальным придется провести
несколько тестов.
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Тонкая настройка предзагрузки

Как уже упоминалось, мы ввели необходимое для предзагрузки количество кад�
ров лишь приблизительно.

Чтобы проверить и исправить его, нужно протестировать фильм и снова
выбрать View ➤ Show Streaming.

После этого Flash начнет проигрывать загрузочную сцену снова и снова; вы
можете заметить маленькую стрелочку вверху временной шкалы, которая дви�
жется туда�сюда на протяжении сцены. Если взглянуть на верхнюю часть про�
файлера пропускной способности, то вы увидите, что вверху кадра находится
зеленая полоска, движущаяся с ним по временной шкале и показывающая, ка�
кая часть фильма загружена.

Если дождаться, когда она достигнет 500�го кадра, то начнет воспроизво�
диться фильм. Стрелка на временной шкале также станет двигаться в одном
темпе с фильмом. Наблюдая за зеленой полоской и стрелкой, вы сможете уви�
деть расстояние между уже загруженным фильмом и местом, которое проигры�
вается в данный момент. Если загружено недостаточное количество кадров,
стрелка догонит зеленую полоску и фильм остановится. Если загрузить кадров
больше, чем требуется, то зеленая полоска достигнет конца фильма раньше,
чем он сам закончит проигрываться.

Вы можете подправить количество необходимых для загрузки кадров, выде�
лив первый кадр загрузочной сцены, в котором находится действие, и изменив
число в условии.

Как оказалось, для нашего фильма хватило и приблизительно установлен�
ных 500 кадров. Вы можете лично проверить эту версию FLA�файла, если ска�
чаете его с сайта «friends of ED» (он называется boy_preloader.fla).

Кнопки остановки и повтора

Если оставить свой фильм, как есть, то он загрузится, воспроизведется раз и
станет проигрываться бесконечно. Это здорово, но вы можете захотеть доба�
вить в конец фильма кнопку, которая спрашивает, не хочет ли зритель посмот�
реть фильм еще разок.

Обычно в последний кадр фильма вставляют действие stop, чтобы предотв�
ратить его циклическое воспроизведение, а также кнопку повторного воспро�
изведения.

Добавление кнопки повторного воспроизведения

В самом последнем кадре последней сцены вашего фильма вам нужно вставить
небольшой фрагмент программного кода, который останавливает циклическое
проигрывание фильма.

1. Откройте во Flash свой FLA�файл и перейдите к последней сцене (в нашем
случае – сцене 11). Пролистайте временную шкалу до конца (рис. 10.10).

Рис. 10.9

ГЛАВА 10 ▼ Выпуск и публикация Подготовка для Интернета

Рис. 10.10

2. Вставьте еще один слой и назовите его action. Чтобы сохранить прежний
порядок временной шкалы, можете перетащить его на самый верх.

3. Выделите последний кадр и сделайте из него пустой ключевой кадр. От�
кройте панель Actions (Действия), нажав F9.

4. Выберите Actions ➤ Movie Control (Действия ➤ Управление фильмом)
и дважды щелкните по stop.
При этом в кадр будет добавлен текст ActionScript stop();. Это остано�
вит фильм. Но нам нужно знать, как добавить кнопку, которая задает воп�
рос: «Play Again?» («Показать еще раз?»).
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Мы вставим самую простую (как и большая часть того, что мы делали в
данной главе) кнопку, но вы, если хотите, можете заняться возможностя�
ми Flash плотнее.

5. Вставьте вверху временной шкалы еще один слой, назвав его button.
6. Выделите на нем последний кадр и преобразуйте его в пустой ключевой

кадр.
7. При помощи инструмента Text (Текст) напишите подходящее сообщение

(рис. 10.11).

Вы заметите, что временная шкала кнопки отличается от других – пояс�
нять здесь, почему, было бы слишком долго. Если вам захочется узнать
больше, то на книжном рынке существует масса руководств по Flash, на�
пример «Flash MX Express» (ISBN: 1903450950) расскажет вам все, что
требуется знать.

11.Вставьте ключевой кадр в кадр по имени Hit (Нажатие) (рис. 10.14).

ГЛАВА 10 ▼ Выпуск и публикация Подготовка для Интернета

Рис. 10.11

8. Пользуясь инструментом Arrow, выделите текст и преобразуйте его в
символ: Insert ➤ Convert to Symbol… ( Вставка ➤ Преобразовать в сим�
вол…) или F8.

9. Назовите его again («еще раз») и вместо графического символа сделайте
из него кнопку (рис. 10.12).

Рис. 10.12

10.Щелкните дважды по кнопке, чтобы перейти в режим редактирования
символов (рис. 10.13).

Рис. 10.13

Рис. 10.14.

!!! Содержимое кадра Hit определяет область экрана, которую занимает кнопка. Эта
область может быть больше или меньше графического изображения кнопки. На эк;
ране содержимое этой области не отображается.

В случае с текстом лучше сделать область нажатия прямоугольной, что�
бы она охватывала всю надпись. Так и поступим.

12.Нарисуйте прямоугольник с заполнением, охватывающий весь текст в
кадре Hit (рис. 10.15).
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13.Вернитесь к основной сцене, щелкнув по ее названию – Scene 11. Убеди�
тесь, что кнопка все еще нажата, и откройте панель Actions.

14.Выберите в меню пункт Actions ➤ Movie Control (Действия ➤ Управле�
ние фильмом) и дважды щелкните по goto.

15.Нам нужно, чтобы кнопка отправляла зрителя обратно к началу сцены 1,
так что нужно установить параметры, которые показаны на рис. 10.16.

Какие бы опции вы ни установили, остается еще создание финального SWF�
файла и публикация вашего фильма.

Публикация фильма для Интернета
Flash упрощает публикацию фильма для Интернета, позволяя вам опубликовать
фильм либо как SWF�файл, либо как HTML с включенным в него SWF. Это зна�
чит, что вы можете выложить свою HTML�страницу и SWF прямо на Web�сайт,
не мучаясь с html�кодом и программами создания Web�страниц. Но перед пуб�
ликацией нужно еще указать несколько параметров.

По умолчанию, Flash будет публиковать фильм и как SWF�файл, и как HTML�
файл со встроенным SWF – то есть как раз то, что нам нужно.

Выберите пункт меню File ➤ Publish Settings (Файл ➤ Параметры публика�
ции) и щелкните по вкладке Flash (рис. 10.18).

Мы разберем следующие параметры:
Version (Версия): он определяет, какая версия Flash Player понадобится для

просмотра фильма.
На момент написания данной книги самой свежей версией была Flash Play�

er 6, для которой публикуются самые сжатые (небольшие) SWF�файлы. В насто�
ящее время очень большое количество людей все еще обладают лишь Flash
Player 5, но, к счастью, в нашем FLA�файле нет ничего, что не работало бы в
пятой версии или даже в четвертой.

ГЛАВА 10 ▼ Выпуск и публикация Подготовка для Интернета

Рис. 10.15

Рис. 10.16

16.Готово! Протестируйте свой фильм, и после его окончания вы увидите
что�то похожее на рис. 10.17.

FLA�файл с кнопкой (boy_play again.fla) находится в доступных для скачива�
ния файлах с программным кодом.

Рис. 10.17

w
w

w
.k

od
ge

s.
ru

http://www.kodges.ru/


325324

!!! Чтобы ваш фильм смогло посмотреть как можно больше людей, выберите Flash
Player 4.

Load order (Порядок загрузки): этот параметр решает, в каком порядке
Flash будет загружать слои в вашем фильме, но так как мы предусмотрительно
сделали загрузочную сцену, то этот параметр никак не повлияет на фильм, так
что оставим значение, предложенное по умолчанию.

Protect from import (Защита от импортирования): название этой опции
говорит само за себя. Она не дает людям взять ваш SWF�файл и, импортировав
его обратно во Flash, выведать все ваши профессиональные секреты!

Audio Stream/Audio Event (Потоковое аудио/События аудио): эти парамет�
ры будут определять качество публикации звуковых файлов во Flash. Если вы
не задали их отдельно в самом фильме, то здесь можно установить их для всего
фильма сразу.

По умолчанию, Flash будет публиковать звуки в 16 Кбит/с. Повышение бит�
рэйта улучшит качество звука, но заодно увеличит объем файла. Попробовав
различные установки и сравнив объем полученного файла с качеством звука,
вы сможете лучше понять, что для вас важнее.

Все эти параметры будут влиять на то, как Flash будет публиковать SWF�файл.
Flash также опубликует фильм как HTML�файл со встроенным SWF. По сути,

это значит, что его можно просмотреть как Web�страницу в браузере. Выбери�
те вкладку HTML, чтобы увидеть эти установки (рис. 10.19).

Рис. 10.18

ГЛАВА 10 ▼ Выпуск и публикация Выпуск видео

Рис. 10.19

Эти параметры определят, как Flash опубликует вашу Web�страницу. На дан�
ном этапе вполне подойдут и установки по умолчанию, так как большинство из
них связаны с различными параметрами сайта, а это уже совсем другая история.

Теперь, когда мы объяснили Flash, как нужно публиковать фильм, щелкните
по Publish (Публикация).

Flash поместил в одну папку с вашим основным
FLA�файлом SWF� и HTML�файлы. Их названия
дублируют название FLA�файла (рис. 10.20).

Если дважды щелкнуть по значку HTML�файла,
то должен открыться ваш браузер, в котором фильм
будет воспроизводиться так, как его увидят пользо�
ватели Интернета. Теперь, если есть желание, можно подправить HTML�файл –
например, задать ему цвет фона, соответствующий цветовой гамме фильма или
остального сайта.

Когда вас будет устраивать и сам фильм, и способ его публикации, можете
загружать свой сайт в сеть при помощи любых методов и программ.

Выпуск видео
Если вы решили выпускать свой фильм на видео, вам понадобится дополни�
тельное программное обеспечение. Сам Flash не подключается ни к каким

Рис. 10.20
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327326 ГЛАВА 10 ▼ Выпуск и публикация Выпуск видео

видеоустройствам – для управления ими вам понадобятся программы видео�
монтажа. Если у вас новенький компьютер, то на нем уже может быть кое�что
установлено: на компьютерах Mac есть iMovie, а пользователи WindowsXP об�
ладают программой Movie Maker. Вам также будут нужны соединительные про�
вода и, возможно, дополнительное оборудование, если на вашем компьютере
нет нужного порта.

Что бы вы ни выбрали – а выбрать есть из чего, и на любой карман, вам
придется экспортировать фильм из Flash в таком формате, который ваша про�
грамма видеомонтажа сможет импортировать.

Какую бы программу и формат файла вы ни использовали, нужно помнить о
двух вещах:

Интерактивность: это может показаться очевидным, но на видео не может
быть никакой интерактивности. Нам нужно выпускать Flash�фильм без кнопок
и любого программного кода ActionScript. Загрузочная сцена тоже не нужна.

Сжатие: лучше всего экспортировать свой фильм из Flash вообще без како�
го�либо сжатия.

!!! Общее правило для всех переносов данных между компьютерами состоит в том,
что сжатие нужно осуществлять по возможности на самых последних стадиях. Если
сжать фильм при экспортировании из Flash, то на видеопленке его качество уже не
будет столь же высоко.

Не забудьте проследить за размером несжатых видеофайлов – вам понадо�
бится много свободного дискового пространства.

Между процедурами экспорта на PC и Mac существуют небольшие различия,
так что мы кратко на них остановимся. Экспортирование видео – это чрезвы�
чайно сложный процесс, поэтому если вы собираетесь заниматься им постоян�
но, то мы рекомендуем вам воспользоваться советами профессионалов. Суще�
ствует масса книг по разным программам (iMovie, Premiere, Final Cut Pro и After
Effects – про все это в издательстве «friends of ED» найдутся книги), которые
рассматривают эту проблему намного глубже, чем это можем сделать мы. Неко�
торые советы можно попытаться получить на интернет�форумах и сетевых
конференциях – например, можно начать с www.friendsofED.com/forums.

Экспорт фильма на PC

Стандартный формат видеофайлов на PC – это AVI. Его�то мы и рассмотрим.

1. Вам нужно открыть свой фильм во Flash. Если не на чем тренироваться,
откройте the boy who cried wolf.fla.

2. Выберите в меню File ➤ Export Movie (Файл ➤ Экспортировать фильм), и
вы увидите стандартный проводник – окно Export Movie. В раскрывающемся

меню Save as type (Сохранить в формате) выберите Windows AVI (*.avi)
(рис. 10.21).

Рис. 10.21

3. Перейдите в нужную папку и введите в поле File name (Имя файла) на�
звание своего файла. Щелкните по кнопке Save.
Откроется диалоговое окно экспорта AVI�файлов, в котором вам будут
предложены опции, показанные на рис. 10.22.

Рис. 10.22

Вы можете подумать, что если оставить флажок Compress Video (Сжа�
тие видео) неотмеченным, то создаваемый файл будет несжатым – и это
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так, но лучше все�таки получить над этими опциями больший контроль.
Для того чтобы перейти к ним, нужно установить этот флажок.

4. Установите Compress Video, выберите в поле с раскрывающимся спис�
ком Sound Format (Звуковой формат) лучший из предлагаемых вариан�
тов – это 44 KHz 16 Bit Stereo, практически CD�качество.

5. Оставьте все остальные опции как есть и щелкните по OK.

ГЛАВА 10 ▼ Выпуск и публикация Выпуск видео

Рис. 10.23

6. В поле с раскрывающимся списком Compressor (Компрессор) поставьте
Full Frames (Uncompressed) – Полные кадры (Несжатый) и щелкните
по OK (рис. 10.24).

Рис. 10.24

Подождите немножко, и ваш файл будет экспортирован и готов для обра�
ботки вашей видеомонтажной программой.

Экспортирование фильма в Mac

Стандартный видеоформат для Mac – это MOV, файл QuickTime, так что будем
изучать его.

1. Откройте свой фильм во Flash – как всегда, мы воспользуемся the boy who
cried wolf.fla.

2. Выберите пункт меню File ➤ Export Movie (Файл ➤ Экспортировать
фильм) (рис. 10.25).

Рис. 10.25

3. В окне Export Movie есть поле Format (Формат). Нам нужно выбрать из
раскрывающегося списка вполне конкретный тип QuickTime�файлов –
QuickTime Video.

4. Введите название своего MOV�файла в окне Save As и в поле с раскрыва�
ющимся списком Where (Куда) точно укажите, куда должен быть экспор�
тирован файл. Щелкните по кнопке Save.
Откроется диалоговое окно, содержащее опции для экспорта в формат
QuickTime Video (рис. 10.26).

Рис. 10.26
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5. Установите все параметры, как показано на рисунке рис. 10.27.

ГЛАВА 10 ▼ Выпуск и публикация Что касается вас

Рис. 10.27

6. Щелкните по OK, и ваш файл будет экспортирован. После его сохране�
ния вы сможете открыть файл в своем видеоредакторе.

Вот и все, ребята
Мы закончили наш фильм и теперь можем показать его людям. Ждите, когда
на вас посыпятся предложения снять по его мотивам полнометражное кино.

Что касается вас
Создавая свой шедевр, вам нужно подумать о своей целевой аудитории и о том,
как лучше всего донести до них свой фильм. Вам нужно решить несколько про�
блем.

Если вы собираетесь распространять его по Интернету, то нужно помнить о
скоростях модемов и процессоров, а также изготовить соответствующую пред�
загрузку.

Определите, хотите ли вы добавить в фильм кнопку «посмотреть еще раз»
или любые другие элементы интерактивности. Или, может быть, вам захочет�
ся внести кое�какие изменения в HTML�страницу, которую Flash будет экспор�
тировать.

Решите, какую программу видеомонтажа вы намере�
ны использовать, если собираетесь выпускать свой
фильм на видео.

Существует миллиард вопросов, которые стоит об�
думать, прежде чем выносить свой фильм на суд пуб�
лики и магнатов киноиндустрии. Эти решения могут по�
казаться запоздалыми, но они весьма важны – вы же
хотите, чтобы ваше творение было представлено в луч�
шем свете.

Наверное, вас уже переполняют творческие идеи,
но если нет, то, возможно, вам помогут наши заключи�
тельные слова.
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Что касается вас11Глава

Кинопроизводство – будь то художественные фильмы, анимация, двумер�
ная или трехмерная, – предлагает обширное поле для самореализации.
Flash дает индивиду, «маленькому человеку» голос, а Интернет предос�

тавляет уникальную возможность распространить свой фильм.
Эта книга снабдила вас навыками, необходимыми для того, чтобы успешно

справиться с любым анимационным фильмом, за который вы возьметесь. Не
забывайте о том, что, как мы уже не раз говорили, вы сами выстраиваете свой
фильм. Даже самый прогрессивный подход требует дисциплины и знания про�
цесса производства фильмов: прежде чем нарушить правила, надо их знать.

Создание любого фильма начинается с идеи. Вы можете изобрести что�то
совсем оригинальное или перенести ее из другого источника. По�настоящему
оригинальных идей на самом деле немного, однако люди находят вдохновение
повсюду. Разница между чьим�то влиянием и откровенным плагиатом, возмож�
но, заключается лишь в масштабах, а также в том, что лично вы привнесли в
эту концепцию или идею, чтобы сделать ее действительно своей и сказать с ее
помощью то, что действительно хотели сказать.

Если вы ищете вдохновения, то убедитесь, что вас вдохновляют достойные
люди. Понаблюдайте за работами великих аниматоров и выясните, что именно
сделало их фильмы столь успешными (здесь мы не имеем в виду кассовые сбо�
ры). Изучите их способы постановки кадров и движения камеры, как они снима�
ли свои сцены и хронометрировали действие. Можете попытаться подражать
некоторым их кадрам, если думаете, что это будет вам полезно. Изучите работу
великих режиссеров: Хичкок (Hitchcock), Джон Форд (John Ford), Феллини

(Fellini), Скорсезе (Scorcese), Чак Джонс (Chuck Jones). Существует столько ве�
ликих людей, от шедевров которых вдохновение можно черпать бесконечно!

Мы описали в нашей книге набор необходимых стадий, которые ваш фильм
должен пройти, чтобы приобрести цельный и привлекательный вид. Фильм
нужно выстраивать тщательно! Если вам не нравится ваше произведение на
любой из этих стадий – не переходите к следующей, пока не будете довольны.
Возьмите идею или сюжет, который вам понравится, и сделайте из него хоро�
ший сценарий и раскадровку. Если он не покажется интересным даже вам, то
маловероятно, что им заинтересуется кто�либо еще.

Относитесь к своей работе критически, не торопитесь поздравлять себя
слишком быстро. Поставьте для себя высокую планку. Зрители не видят разни�
цы между одноминутным Flash�фильмом и пышным художественным зрелищем
длиною в семь минут. Если люди смотрят фильм, они хотят, чтобы он был ин�
тересным. У них в голове нет переключателя, который менял бы их ожидания
в зависимости от стоимости фильма, который им показывают. Хороший фильм
есть хороший фильм – неважно, анимационный ли он, двумерный, трехмер�
ный, художественный или Flash�фильм. Никогда не нужно считать мультфильм
искусством более низкого жанра.

Flash предоставляет отдельному аниматору уникальные возможности. Вос�
пользуйтесь и выжмите максимум из них. Не бойтесь, дерзайте, но не забывай�
те оттачивать свои навыки и расширять знания. Смотрите фильмы и читайте
книги.

Ниже мы приводим несколько книг по анимации и кинопроизводству, кото�
рые рекомендуем вам прочесть:

➤ «The Illusion Of Life: Disney Animation» Фрэнка Томаса (Frank Thomas) и
Олли Джонстона (Ollie Johnston), ISBN: 0786860707;

➤ «Cartoon Animation» Престона Блэра (Preston Blair), ISBN: 0929261518;
➤ «The Five C’s Of Cinematography» Джозефа В. Маскелли (Joseph V. Mas�

celli), ISBN: 187950541X;
➤ «In The Blink Of An Eye» Уолтера Мерча (Walter Murch), ISBN: 1879505622.

И последний совет.
В киноиндустрии, особенно в Голливуде, наиболее серьезной проблемой в

создании фильма принято считать концовку. Иногда бывает так, что проекты
«раскручиваются», сценарии пишутся, а фильмы даже запускаются в производ�
ство – и при этом ни у кого нет ни малейшего представления о том, чем все за�
кончить. Поэтому перед началом работы над фильмом продумайте концовку.
Если, как и многие создатели фильмов до вас, вы все�таки зашли в тупик, то все�
гда можно воспользоваться избитым приемом (мы уже давненько его не видели):

«…А потом я проснулся!»
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